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Trademarks

Trademarks

List of trademarks

Océ, Océ DirectPress, varioPRINT and Océ PRISMA are registered trademarks of Océ-
Technologies B.V. Océ PRISMAprepare is a trademark of Océ-Technologies B.V.

Canon is a registered trademark of Canon Inc.

Adobe, Adobe Acrobat, Acrobat Reader and PostScript are either registered trademarks or
trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Apple, Mac, Mac OS, Macintosh and Safari are registered trademarks of Apple Computer, Inc.
Transform is a trademark of Bottomline Technologies Inc.

Kodak and SmartBoard are trademarks of Eastman Kodak Company.

Google Chrome is a trademark of Google Inc.

Intel is a trademark or registered trademark of Intel Corporation or its subsidiaries in the United
States and other countries.

PowerPC is a registered trademark of International Business Machines Corporation.
Linux is a registered trademark of Linus Torvalds.

Microsoft, Windows, Windows NT, Windows 98, Windows 2000, Windows XP, Windows Server

2003, Windows Server 2008, Windows Vista, Windows 7, Access, Excel and Internet Explorer are
either registered trademarks or trademarks of Microsoft Corporation in the United States and/or

other countries.

Mozilla Firefox is a registered trademark of the Mozilla Foundation.
PrintShop Mail (PSM) is a registered trademark of Objectif Lune Inc.

Xerox, DigiPath, FreeFlow and FreeFlow Makeready are registered trademarks of Xerox
Corporation.

Products in this publication are referred to by their general trade names. In most, if not all cases,
these designations are claimed as trademarks or registered trademarks of their respective
companies.
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Notes for the reader

Notes for the reader

Introduction

This manual helps you to use the varioPRINT 135 Series. The manual contains a description of
the product and guidelines to use and operate the varioPRINT 135 Series.

Definition
Attention-Getters

Parts of this manual require your special attention. These parts can provide the following:

« Additional general information, for example, information that is useful when you perform a
task.

» Information to prevent personal injuries or property damage.

Symbols used in this manual

The following symbols are used in this manual to explain procedures, restrictions, handling
precautions, and instructions that should be observed for safety.

Indicates a warning concerning operations that may
lead to death or injury to persons if not performed
correctly. To use the machine safely, always pay at-
tention to these warnings.

Overview of the attention-getters

WARNING

CAUTION Indicates a caution concerning operations that may
lead to injury to persons if not performed correctly.
To use the machine safely, always pay attention to

these cautions.

IMPORTANT Indicates operational requirements and restrictions.
Be sure to read these items carefully to operate the
machine correctly and to avoid damaging the ma-

chine or property.

NOTE Indicates a clarification of an operation or contains
additional explanations for a procedure. Reading

these notes is highly recommended.

Indicates an operation that must not be performed.
Read these items carefully and make sure not to
perform the described operations.

S © b b
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Naming Conventions for Accessories (Generic Naming in User Interfaces)

Naming Conventions for Accessories (Generic Naming
in User Interfaces)

Generic Naming of Accessories in User Interfaces

To improve the readability of texts in User Interfaces of control panels and software, the
accessories are generally referred to by their function. The table below shows the naming
conventions for accessories (commercial product names and the generic terminology used in
User Interfaces). Some accessories listed below may not be available in certain markets.

NOTE

In some cases, there is only 1 name for more modules. The reason is that a configuration can

only contain 1 of the available types of modules.

Commercial product name:

Finisher-AF1 and Finisher-AK1
Saddle Finisher-AF2 and Saddle Finisher-AK2

Puncher Unit-BP1/BQ1/BR1 and Puncher Unit-
BT1/BU1/BS1

Professional Puncher-B1
Paper Folding Unit-F1
Document Insertion Unit-F1
High Capacity Stacker-E1

High Capacity Stacker-F1

High Capacity Stacker-G1
Booklet Trimmer-D1
Two-Knife Booklet Trimmer-A1
Perfect Binder-C1

Duplex Color Image Reader Unit-D1
Decurler Unit-A1

NOTE

Conversion table for commercial names versus generic terminology in User Interfaces

In U, printer driver and software referred to

as:

[Stacker/stapler]
[Stacker/stapler]

[Puncher]

[Puncher]
[Folder]
[Inserter]
[Stacker]
[Stacker]
[Stacker]
[Trimmer]
[Trimmer]
[Perfect Binder]
[Scanner]

[Decurler]

High Capacity Stacker-E1 and High Capacity Stacker-F1 cannot be combined.

High Capacity Stacker-E1 and High Capacity Stacker-G1 cannot be combined.
Finisher-AF1/Saddle Finisher-AF2/Puncher Unit-BP1/BQ1/BR1 and Finisher-AK1/Saddle Finisher-
AK2/Puncher Unit-BT1/BU1/BS1 cannot be combined.
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Available User Documentation

Available User Documentation

+ Separate operation guides for the printer and accessories.
+ Separate safety guides for the printer and accessories.

* Quick Reference Cards for basic printer actions.

* Online helps in printer drivers and applications.

Chapter 1 - Preface 13
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Overview of the varioPRINT 135 Series Including Accessories

Overview of the varioPRINT 135 Series Including
Accessories

lHlustration

NOTE

The illustration shows an example of a full varioPRINT 135 Series product line including the
available accessories. Contact your local authorized dealer for more information about the
possible configurations.

[1]1 Full varioPRINT 135 Series product line

Description

NOTE
Whenever a number of sheets is mentioned in the table below, the figure is based on media of
80 g/m2 (20 Ib bond).

The components of a full varioPRINT 135 Series product line

om ™ Gamponsmt———ranion

1 Control panel * Manage your print, copy and scan jobs.
* Make system settings and workflow settings.
» Support for troubleshooting, for example clear paper
jams.

2 External paper module Hold the media required to print your jobs.
(four paper trays), optional = Total capacity: 4,600 sheets, or 7,800 sheets with the op-
tional dual paper trays installed.

3 Internal paper module (four Hold the media required to print your jobs.
paper trays) Total capacity: 4,000 sheets.
4 Printer module Print the jobs. Access to the printer module is required:

e To clear paper jams, and
* To carry out Printer Operation Care (POC) actions.

5 Duplex Color Image Reader « Scan paper originals.
Unit-D1 » Copy paper originals.
* Perform media registrations.

Capacity: A stack of maximum 300 originals.

6 Operator attention light Make the status of the system visible from a distance.
7 Decurler Unit-A1 Fixes paper curl caused by heat etc.
8 Document Insertion Unit-F1 Hold the (pre-printed) cover sheets or insert sheets to

finish your documents.
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rom — Gamponemt ———Rain

9 First High Capacity Stacker- Receive the output.
E1 or High Capacity Stack- = Capacity of High Capacity Stacker-E1:
er-F1 (not illustrated) + Output tray: 1,000 sheets.

» Stack trays (total): 10,000 sheets A4/LTR or 5,000
sheets A3/LGL.

Capacity of High Capacity Stacker-F1:

* Top tray: 200 sheets.

« Stack tray and eject tray (total): 6,000 sheets
A4/LTR/A3/LGL or 355 mm (14.0") in height.

NOTE
High Capacity Stacker-E1 and High Capacity
Stacker-F1 cannot be combined.

10 Second High Capacity Add additional output capacity.
Stacker-E1 or High Capaci-
ty Stacker-F1 (not illustra-

ted)

11 Perfect Binder-C1 Create perfect-bound books.

12 Paper Folding Unit-F1 Fold the output in various ways.

13 Finisher-AF1/Saddle Finish- Staple and stack the output. Optional, the stacker/stapler
er-AF2 or Finisher-AK1/ can be equipped with a Puncher Unit-Bx1 to punch the
Saddle Finisher-AK2 output.

14 Booklet Trimmer-D1 Trim the fore-edge of each booklet.

15 Two-Knife Booklet Trim- Trim the top and bottom of each booklet.
mer-A1
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Printer Only Configuration

Printer Only Configuration

Introduction

Next to the configurations mentioned in section Overview of the varioPRINT 135 Series Including
Accessories on page 16, the varioPRINT 135 Series also has a printer only version. The printer
only version cannot copy and scan.

The printer only configuration is a varioPRINT 135 Series product that doesn't have an ADF.
Instead of the ADF the varioPRINT 135 Series product has a cover. The glass plate and the
corresponding scanner are still present. You can use the glass plate for service purposes and for
media registration. You perform the media registration on a printer only configuration in the
same way as on a configuration with an ADF.

The copy and scan mode are not available on the control panel, which disables the use of the
scanner to carry out copy and scan jobs.

18 Chapter 2 - Main Parts
Canon varioPRINT 135 Series



The Control Panel

The Control Panel

Introduction

The control panel helps you to carry out print jobs, copy jobs and scan jobs. This section
describes the main components of the control panel.

[2] The control panel

The main components of the control panel

The main components of the control panel

I S

1 Sleep button

2 Stop button @

3 Paper tray button =

4 USB port

5 [Schedule] button (optional)
6 [Jobs] button

Put the system into the sleep mode or wake up the
system.

Stop the printing process after a set or as soon as
possible.

Get immediate access to the [Trays] section on the

control panel to do the following (for example):

* Check the content of all paper trays.

* Load a new media type into a paper tray.

+ Change the media type which is available in one
of the paper trays.

* Open the front door of the printer.

Insert a USB drive into the USB port to:
* Print any documents on the USB drive, or
+ Scan paper originals to the USB drive

Access the [Schedule] view to manage the jobs in
the schedule.

Manage and print the jobs in the lists of [Waiting
jobs], [Scheduled jobs] and [Printed jobs], orin a
DocBox (optional).

Canon varioPRINT 135 Series
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The Control Panel

e e

7 [Trays] button Access the [Trays] section on the control panel to
do the following, for example:
* Check the content of all paper trays.
* Load a new media type into a paper tray, or
* Change the media type which is available in one
of the paper trays.

8 [System] button Access the [System] section to do the following, for

example:

* Check the status of the toner, staples and other
supplies.

* Read counters.

» Start maintenance.

« Set up the preferred workflows.

» Change a number of default system settings such
as the language.

* Adjust the brightness and contrast of the LCD
panel.

* Shut down the printer.

* View the content of the media catalogue or add
temporary media to the media catalogue.

9 Dashboard The dashboard displays information about the sys-

tem status such as:

* Information about the current printing process.

* Information about operator intervention that is
required soon.

* Information about errors.

» Information about the status of the toner reser-
voir and staple cartridges.

10 Status LED The status LED displays the status of the system:

* Red LED
The machine has stopped, for example because a
required media type is not available or an error
has occurred. Operator attention is required now.

* Orange LED
The machine will stop soon, for example because
more paper is required. Operator attention is re-
quired soon.
The orange light illuminates when the machine
reaches the warning time. The warning time is a
time you can set to determine when the orange
light must illuminate. You can set the warning
time in the [System] view of the control panel.

* Green LED
The machine is busy printing. The machine can
print longer than the set warning time. Operator
attention is not required.

» LED off
The machine is idle. There are no jobs scheduled
for printing and no operator attention is required.
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The Dashboard

Introduction

The dashboard is the upper part of the control panel. The dashboard is always visible,
irrespective of the current view. The dashboard shows the following.

* The status of the system.

* The status of the supplies.

* The status of the finishers.

* The current process.

* Instructions for the operator.

* The [Resume] button > after you stopped the printer.

lllustration

The following illustration shows the dashboard while the machine is busy. The vertical status bar
is green. No action is required.

The following illustration shows the dashboard while the machine is busy. The vertical status bar
is orange. Next to the status bar, the dashboard displays a message that indicates which action is
required soon.

The Parts of the Dashboard

The dashboard

1

Display the status of the machine, for example [Initializing...], [Printing...] or
[Printing will stop...]. Each status message can have a sub-message with addi-
tional information.

Display the file name of the current job (for document printing) or current stream
(for stream printing). Furthermore, the progress of the current job is displayed.
For document printing, the counter can display the following information.

+ SetXofY

* Sheet X of Y or Sheet X.

X represents the current status of the print job. Y represents the total number of
sets or sheets of a print job.

When the sorting method for a job is set to [By set] the dashboard displays the
set count (Set X of Y).

If the sorting method for a job is set to [By page], or when you print stream jobs,
the dashboard only displays a sheet count.

Canon varioPRINT 135 Series
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3 Display the action that you must do now or soon. The colors of the vertical status
bar at the left-hand side match the colors of the LED on the control panel and the
operator attention light. When the color is orange or red, a message indicates the
required action.

Orange means that action is required soon. How long before an upcoming action
the control panel starts to display the message depends on the defined warning
time.

Red means that action is required now.

4 » Display that maintenance is required soon or immediately
» Display the status of the finishers.
» Display the status of the staple cartridges.
« Display the status of the toner reservoir.

NOTE

The dashboard can only display one message at a time. When there are more messages, the
dashboard displays the first required or most important message. The dashboard indicates that
there are more messages. Touch this message to display all other messages.
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The Paper Modules

Internal Paper Module

NOTE

Whenever a number of sheets is mentioned below, the figure is based on media of 80 g/m2 (20 Ib
bond).

The varioPRINT 135 Series contains four integrated, internal paper trays.
» Two bulk trays with a capacity of 1,500 sheets each.
« Two multi-size trays with a capacity of 500 sheets each.

The bulk trays support A4, LTR and JIS B5 only. When a bulk tray is configured for one of these
media sizes, you can only load media with that size. To switch to another media size, you must
manually adjust the size of the bulk trays before you can load that other media size.

External Paper Module

You can extend the system with an optional external paper module. This paper module contains

four paper trays.

» Two bulk trays with a capacity of 1,700 sheets each (or 3,300 A4/LTR sheets each when the
optional dual paper trays are installed)

» Two standard trays with a capacity of 600 sheets each.

Contact your local authorized dealer for more information about the dual paper trays.
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The Main Parts of the Scanner

The Main Parts of the Scanner

Introduction

Place your originals on the glass plate or into the automatic document feeder (ADF), depending
on the size and type of the original, and the copy modes that you want to use. Both sides of two-
sided originals can be scanned simultaneously. The table below describes the glass plate and the
ADF.

Overview of the feeding possibilities

Componamt————hein

Glass plate Place the originals on the glass plate to copy bound orig-
inals (such as books and magazines), heavyweight or
lightweight originals, and transparencies.

Automatic document feeder (ADF) Place the originals into the ADF when you want to copy
several originals at the same time. The originals are au-
tomatically fed to the glass plate and scanned. Two-si-
ded originals can also be scanned as two-sided docu-
ments.

The ADF has a capacity of 300 sheets (80 g/m2or 20 Ib
bond).

f CAUTION
Do not insert your fingers into the gaps around the originals tray, because your fingers may get

caught.

@ IMPORTANT
Be careful not to drop objects such as paper clips into the gaps because this can cause damage
to the machine.

NOTE
+ If the original document consists of more than 300 sheets (based on 80 g/m2 or 20 Ib bond

media), you must split the original document into smaller partial sets (subsets). Then you
must use the [Combined copy job] function to scan the subsets individually and create one
document containing all the subsets.

» If the glass plate is dirty, the print quality may deteriorate. In this case, clean the feeding belt
and the glass plate.

» Blocking the original output area can result in damaging originals, and printing may not take
place correctly. Therefore, do not place objects into the original output area.
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The Main Parts of the Scanner

lllustration

[3] Main parts of the scanner

Parts and their Function

Main parts of the scanner

T

10

ADF cover

Originals indicator

Originals tray

Auxiliary originals tray

Auxiliary originals receiving tray

Originals output tray

Paper guides

Document feed scanning area

Glass plate

Inner cover

Open this cover to clear a paper jam.

Lights when originals are placed in the
originals tray of the scanner.

Originals placed here are automatically
fed sheet by sheet into the ADF. Place
originals into this tray with the surface
that you want to scan face up.

Pull out this tray when you want to feed
large originals.

The originals output tray receives the
scanned originals. Pull out the auxiliary
tray before you scan large originals.

Receive the scanned originals.

Adjust the paper guides to match the
width of the original.

Scan documents sent from the ADF.

Use the glass plate to scan special origi-
nals such as books, heavyweight origi-
nals, lightweight originals and transpar-
encies.

NOTE

When you use the glass plate to
copy or scan heavyweight origi-
nals, such as books or maga-
zines, do not press down hard
on the ADF.

Open this cover to clean the document
feed scanning area.

Canon varioPRINT 135 Series
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The Operator Attention Light

The Operator Attention Light

Introduction

The operator attention light on top of the printer helps you to monitor the status of the printer
from a distance. The colors of the lights match the printer status that the dashboard displays.

Illustration

[4] The operator attention light

Status Colors

The status colors of the operator attention light

Red

Orange

Green

All lights off

The machine has stopped, for example because a required media
type is not available or an error has occurred.
Operator attention is required now.

The machine will stop soon, for example because more paper is
required.

Operator attention is required soon.

The orange light illuminates when the machine reaches the warn-
ing time. The warning time is a time you can set to determine
when the orange light must illuminate. You can set the warning
time in the [System] section of the operator panel.

By factory default, the warning time is set to 10 minutes. So 10 mi-
nutes before operator attention is required, the orange light will il-
luminate.

The machine is busy printing. The machine can print longer than
the set warning time.
Operator attention is not required.

The machine is idle. There are no jobs scheduled for printing.
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The Stacker/Stapler

The Stacker/Stapler

Introduction

The stacker/stapler (either Finisher-AF1 or Finisher-AK1) can stack and

staple your prints. When

the Saddle Finisher (either Saddle Finisher-AF1 or Saddle Finisher-AK2) is available, you can also
create half-folded, saddle-stitched booklets. Furthermore, an optional Puncher Unit can be

integrated in the stacker/stapler to punch the prints.

NOTE
/@ See the Operation guide of Finisher-AF1/Saddle Finisher-AF2/Puncher Unit-BP1/BQ1/BR1, or
Finisher-AK1/Saddle Finisher-AK2/Puncher Unit-BT1/BU1 for detailed information about the

stacker/stapler.

External View

-
<;
T

gy

[5] The main parts of Saddle Finisher-AK2 and Finisher-AK1

Main parts

w

T

1 Main power switch Put the switch on "I" to turn on the stack-
er/stapler.
2 Top cover Open the top cover to clear a paper jam

inside the unit.

3 Front door Open the front door to replace the staple
cartridge, remove jammed paper, or clear
a staple jam in the stacker/stapler, in the
stapler unit or in the saddle stitch unit.

4 Booklet tray (Saddle Finisher- Receive saddle stitched booklets.
AF2/AK2 only)

5 Auxiliary booklet tray (Saddle Finish- Pull out the auxiliary booklet tray to re-
er-AF2/AK2 only) ceive large size booklets.

Canon varioPRINT 135 Series
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 Cowen R

6 Lower tray Receive finished documents.

7 Upper tray Receive finished documents.

Internal View

2 1
[6] The waste trays
Main parts
 Comonent
1 Puncher waste tray Pull out the puncher waste tray to remove
punch waste.
2 Stapler waste tray Pull out the stapler waste tray to discard

the staple waste.
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Power Buttons and Power Modes

Power Buttons and Power Modes

The Power Buttons

The printer has the following switches and buttons to control the power supply.

uon ——ams —Drin

On/Off button The On/Off button is located on top of the printer. Using
the On/Off button starts up or shuts down the whole sys-
tem, including the PRISMAsync controller.

Sleep button The Sleep button is located at the right-hand side of the
control panel. Using the Sleep button puts the printer in-
to sleep mode or wakes the printer up from the sleep
mode. When you press the Sleep button, the control
panel will be turned off too. The PRISMAsync controller
remains on.

The Sleep button allows you to switch between the
Ready mode and the Sleep mode. This is only possible
when the On/Off button is On and the start-up phase is
completed.

The Power Modes

You can find the energy saving settings in the Settings Editor under [Preferences] -> [System
settings] -> [Energy save modes].

The power modes

Off Off The printer and the controller are completely off. There
is no power consumption. The printer cannot receive or
print any job.

Ready On The printer is ready to print jobs.

Low power mode Off The low power mode is an energy save mode.

To use the low power mode, the [Low power mode tim-
er enabled] setting in the Settings Editor must be set to
[Yes]. When this setting is disabled, the printer skips the
low power mode and goes into the sleep mode or deep
sleep mode after the time set for these modes.

When the printer has been idle for the time defined in
the [Low power mode timer] setting, the printer goes in-
to low power mode automatically.

Possible values: 5 - 30 minutes.

Factory default: 20 minutes.

The printer wakes up when a job arrives in the list of
[Scheduled jobs] or when you touch the control panel
(either the screen or any button).
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Sleep mode Off

Deep sleep mode Off

Once the printer has been idle for the time defined in the

[Sleep mode timer] setting in the Settings Editor, the

printer goes into sleep mode automatically. Compared

to the low power mode, the printer uses less energy.

Possible values: 31 - 240 minutes.

Factory default: 40 minutes.

The printer wakes up when:

* You press the Sleep button [1 on the control panel, or

* A wake-up timer expires, or

* Ajob arrives in the list of [Scheduled jobs], provided
that the [Automatic wake-up enabled] setting in the
Settings Editor is set to [Yes].

Press the Sleep button [7 on the right-hand side of the
control panel to put the printer into the sleep mode man-
ually. The printer goes into the sleep mode after all jobs
are finished.

When the [Deep sleep mode enabled] setting is set to
[Yes], the printer goes into the deep sleep mode.

The deep sleep mode is an alternative to the sleep mode

described above. To use the deep sleep mode, the [Deep

sleep mode enabled] setting in the Settings Editor must

be set to [Yesl].

In the deep sleep mode:

» The printer uses less energy than in sleep mode.

* The printer needs more time to wake up than in sleep
mode.

NOTE

An application in your workflow may require
the printer to wake up more quickly. If the
printer does not wake up quick enough, the
application may give an error. In that case it is
advised to disable the deep sleep mode. Then
the printer will use the sleep mode instead.

Canon varioPRINT 135 Series
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Turn On the System

lHlustration

©

[7]1 The On/Off button

Procedure

NOTE
This procedure applies to a system that is completely off.

1. Put the On/Off button of each connected finishing unit into the "I" position.
2. Press the On/Off button on top of the printer, next to the base of the control panel.
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Shut Down the System

lHlustration

& Workflow
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] jobs jobs
[
Selup
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==
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Shut down system JI
@ Schedule g Jobs ‘ =| Trays ‘ % System

[8] Shut down the system

Procedure

1.  On the control panel, touch [System] -> [Setup] -> [Shut down system].
The control panel displays the message [Are you sure you want to shut down?].
2. Press[Yesl.
A message indicates when the shut down will begin.
When the shut down is complete, the control panel will be off.
3. To shut down the system completely, switch the On/Off button of each connected finishing unit
into the "O" position.
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Restart the System

Introduction

You can restart the system via the Settings Editor (under [Support] -> [Troubleshooting]) or via
the control panel.

Illustration

Shut down sy

@ Are you sure you want to shut down?

‘ Restart ‘ Yes ’ ‘ No ‘

[9] Restart the system

Procedure

1. Touch [System] -> [Setup] -> [Shut down system].
The control panel displays the message [Are you sure you want to shut down?].
2. Press [Restart].
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Access the Settings Editor

Access the Settings Editor

Introduction

The Settings Editor is a web-based application and therefore accessible via an Internet browser.
The Settings Editor enables you to manage settings or to display information in the following
areas.

* [Medial

» [Preferences]

* [Workflow]

+ [Configuration]

« [Support]

* [Transaction printing] (optional)

Before you begin

Make sure you have the following information.

¢ The IP address or host name of the PRISMAsync controller.

* The key operator password to change all settings except for the settings in the [Configuration]
tab.

* The system administrator password to change all settings including the settings in the
[Configuration] tab.

Procedure

1. Open your web browser.

[@ NOTE

When the Settings Editor does not display the correct language, you can change the preferred
language in the Internet options of your Internet browser. The desired language must be first in
the list of languages.

2. Inthe address bar, enter the IP address or host name of the PRISMAsync controller.
http://<printername or IP address>
https://<printername or IP address>
The Settings Editor application appears.

=4 VarioPrint PRISMAsync Controller

Preferences Workflow Configuration

Lk

i

Media catalog
¥ X & dh
Add Import Export Restore
Media Registration
I A4, 80g/m2, Plain Paper, White
T A3, 80g/m?2, Plain Paper, White
T Letter 8.5x11, 75a/m?2, Plain Paper, White
T Tabloid 11x17, 75g/m?, Plain Paper, White
7 Ad tab, Adtab, Tab inclusive, Cyclic(5), 80g/m?, Plain Faper, White
T Letter tab, Lettertab, Tab inclusive, Cyclic(s), 759/m3, Plain Paper, White
7 MBL A4, A4, 200g/m?, Plain Paper, White
7 M&L A3, A3, 200g/m?, Plain Paper, White
I M&L SRA3, SRA3, 50g/ms, Plain Paper, White
I~ M&L SRA3+, (320 x 487,7 mm), 80g/m?, Plain Paper, White

You can now make the required changes.
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Change a Number of Settings in the Settings Editor via
the Control Panel

Introduction

NOTE

The information contained in this section is primarily intended for key operators and system

administrators.

The Settings Editor application on the PRISMAsync controller is a web based application that
allows key operators and system administrators to adapt the system completely to the situation
in an organization and production environment. The Settings Editor allows key operators and
system administrators to manage settings with regard to network configuration, system
preferences, job preferences and media, for example.

For convenience reasons, a subset of frequently used settings is accessible through the control

panel.

Group of settings

[About]

[Software updates]

[Software licenses]

Settings available via the control panel

Available settings Short description

[Serial number]
(read-only)
[Version of printer
software] (read-on-
ly)

[Download auto-
matically]
[Upgrade software
(from USB)]
[Upgrade software
(from server)]
[PRISMAsync
downgrade]
[Install Windows
update]

[Uninstall Windows
update]

[Upload licensel

The [About] section allows you to look up the
serial number and software version of the
printer.

You can upgrade the printer software and the
Microsoft® Windows® software through this
section. You can downgrade patches through
this section. Follow the instructions on the
control panel when you upgrade or down-
grade the software.

When you enable [Download automatically] an
update is downloaded automatically, when
available via ORS. You only have to install the
update.

From release 3.3 onwards, you can select the
setting to keep existing jobs on the system
when you upgrade the software from USB.
From release 3.3 onwards, the jobs on the sys-
tem are not deleted after you upgraded the
software from server.

When you have a new license to activate a
new feature on the printer, you can upload the
license through this section. After uploading
the license, the feature becomes active.

You can only use this section after you inser-
ted an USB drive in an USB port on the control
panel.

Follow the instructions on the control panel
when you upload the license.

Canon varioPRINT 135 Series
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Group of settings Available settings Short description

[Logging] + [Save the data-
dump file]
« [Save the trace file]
» [Print the configura-
tion report]

[Connectivity] * [MAC address]

(read-only)

* [Host name]

* [Link speed and
connection type]

* IPv4 settings

* IPv6 settings

* DNS settings

* WINS settings

« [Test the TCP/IP
connection]

[Remote connection] * [Remote connection
(optional) status] (read-only)
* [Remote connection
enabled]
* [Remote Service
country code]
* [Test Remote con-
nection]

When an error occurs, the help desk of your
printer supplier can ask you to create and send
a datadump file. The datadump file is a .zip file
that contains detailed technical information
about your system. Furthermore, the system
can store trace log files in .zip files. You can
save both .zip files to a network location or to a
USB drive.

The configuration report contains information
about the configuration of your printing sys-
tem, for example information about the sys-
tem configuration, controller configuration or
network settings. You can print the configura-
tion report for backup purposes, for example.
Follow the instructions on the control panel
when you save a file or print a report.

The [Connectivity] section contains the main
settings to integrate the printer into a network.
After you have adapted the network settings,
you can test the connection from here.

Follow the instructions on the control panel
when you adapt the network settings.

The [Remote connection] section (optional)
contains the settings to enable the remote con-
nection and to configure the Remote Service.

NOTE

Only Service can adapt the remote
connection settings. After Service
adapts the remote connection set-
tings, you can test the remote con-
nection with this setting.
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Group of settings Available settings Short description

[System settings] .

Key operator settings

7 | Avout

[Date and time]
[System of meas-
urement]

[Time zonel
[Update finisher
configuration]
[Bulk tray 1 media
sizel

[Bulk tray 2 media
sizel

The [System settings] section contains settings
to change the date and time of the system, or
the system of measurement used. When you
change the system of measurement, all corre-
sponding values on the system will be
changed. For example, when you change [Met-
ric]l into [Imperial], all values will be displayed
in inches.

Furthermore, when a new finisher was added
to your configuration, you can use the [Update
finisher configuration] function to tell the sys-
tem that your configuration was updated. Then
the finisher will be added to the output loca-
tions in the job parameters section, for exam-
ple.

From the [System settings] you can also indi-
cate the media in the bulk trays one and two.

NOTE

A5 and Statement are only valid if
the bulk tray for small format is in-
stalled and configured by the service
technician. If you select A5 or State-
ment and the bulk tray for small for-
mat is not installed, you are not able
to assign media to the bulk tray.

Serial number 14142521

Version of printer software 2233550 Jobs offset

Upgrade software (from USB) Upgrade

e e

Default
[} Software icenses
e
L\ Logging
[> Connectiviy
Close ‘
=)
Il
Jobs | =l Trays ‘ Q System

[10] Change settings via the control panel
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Procedure

NOTE
The key operator PIN or the system administrator password is required to make changes in this
section.

1. On the control panel, touch [System] -> [Setup] -> [Local key operator settings] (under
[Advanced]).

2. Touch the button of the group that contains the setting you want to change or view.

3. Touch the required setting.

4. Look up the required information or make the required changes.

5. When you make a change, touch [OK] to confirm.

6. Press [Closel.
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Introduction to the [Setup] Section

Introduction
The [System] view gives access to system information, the system setup and media information.

This section gives an overview of the [Setup] section in the [System] view.

Overview of the [Setup] Section

—. e — = ==
I I i= | &
Print jobs to Scheduled  Copy jobs to Scheduled Confirm start of job Check first set Next tray after each job  Jobs offset stacked
g jobs Jobs
I
Workflow profie @ Custom
&} Operator panel 3 Advanced
Language @ % English (US) Advanced media settings Default
Warning time @ 10 minutes Intermediate check print @ (N[
Job name truncation @ X000 YYYYYYYYYYY Accounting Perjob
Operator panel settings. © m Local key operator settings. @ &
Shut down system @ JI
@ Schedule [g Jobs ‘ =| Trays ‘ % System

[11] Overview of the [Setup] section

The Items of the [Setup] Section
Description of the [Setup] section

m_

1 Summary of the defined Display the main settings of the current workflow profile.
workflow settings

2 [Workflow profile] Select a workflow profile or manually define the settings
that match your needs.

3 [Languagel Change the language of the system.

4 [Warning timel Define the moment when the system warns you about
an action that is required soon, for example 10 minutes
in advance. The warning is displayed in the dashboard
and indicated through the operator attention light.

5 [Job name truncation] Define the way the system shortens the job name when
the job name is too long to display fully.

Chapter 4 - Adapt Printer Settings to Your Needs 11
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m_

6 [Operator panel settings] Adjust the brightness and contrast of the screen of the
control panel.

7 [Shut down system] Shut down the printer and the controller in a controlled
way.
8 [Advanced media settings] <+ Enable or disable the [Pre-printed mode].

* Enable or disable the [Wax model.
» Set the paper quality factor to [Normal], [Low] or

[Lowerl.
9 [Intermediate check print] Print a test sheet of a running job to check the quality.
10 [Accounting] Define the [Accounting mode] and the [Account ID]. The

[Accounting mode] is only available when the [Identifica-
tion enabled] setting in the Settings Editor on the PRIS-
MAsync controller is set to [Yes].

11 [Local key operator set- Get direct access to a number of important key operator
tings] settings in the Settings Editor on the PRISMAsync con-
troller.
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Work with the Workflow Profiles

Introduction

The machine is used in different printing environments. Each environment requires other settings
to optimize the workflow or to meet your personal workflow preferences. The machine contains a
number of default workflow profiles to help you optimize your workflow. The default workflow
profiles are combinations of frequently used settings for print jobs ([Receivel, [Print] and
[Output]). However, the workflow profiles cannot cover all the possible workflows you may need.
Therefore, you can also define the settings individually (custom workflow).

This section makes recommendations about when to use which workflow profile. Furthermore,
this section describes the settings and the effects of the settings.

(@ NOTE

The [Workflow profile] button in the [Setup] section of the [System] view displays the name of
the selected workflow profile. When you customized the settings of a workflow profile, the
button displays the text [Custom].

1@ NOTE

The [Workflow profile] button in the [Setup] section of the [System] view displays the name of
the selected workflow profile. When you customized the settings of a workflow profile, the
button displays the text [Custom].

The Workflow Profiles

Workflow
Profile :S] Receive ED Print ?¥ Output
Destinaton of print job Confirm start of job Next output tray
Standard
Scheduled jobs on ‘ AL aster cachjob
Job by job Destination of copy job Check first set Offset stacking
=
Scheduled jobs T on Thy Jobs
JICE. —
Destination of DocBox job
Manual planni
anual planning Default
Scheduled jobs
it
Unattended
oK ‘ Cancel ‘
7
S @
Bim | |4 o

[12] The workflow profiles screen

The Use of the Default Workflow Profiles

The following table makes recommendations about when to use which default workflow profile.
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When to use which workflow

[Standard]

[Job by job]

[Check and print]

[Manual planning]

[Unattended]

You need a productive workflow but you still want to have sufficient
control over the jobs.

You want to start the jobs one by one. Each time a job has been prin-
ted, the machine goes on hold. Always touch [Resume] in the dash-
board to start the next job.

You want to check the quality and layout of each first set of a job be-
fore the remaining sets will be printed.

The jobs are sent to the machine in a random order. You can manually
define the most productive order in which the machine will print the
jobs.

You want to continue printing while you are absent, for example after
working hours. Then the machine will print the scheduled jobs, provi-
ded that all the required media, supplies and output locations are avail-
able.

The Default Settings for [Receive]

The default [Receive] settings

Workflow profile

[Receive] settings

[Destination of print [Destination of copy [Destination of Doc-

[Standard]

[Job by job]
[Check and print]
[Manual planning]

[Unattended]

The Default Settings for [Print]

The default [Print] settings
Workflow profile

[Standard]
[Job by job]

[Check and print]
[Manual planning]

[Unattended]

jobl jobl Box job]

[Scheduled jobs] [Scheduled jobs] [Scheduled jobs]
[As in jobl] [Scheduled jobs] [Scheduled jobs]
[Scheduled jobs] [Scheduled jobs] [Scheduled jobs]
[Waiting jobs] [Waiting jobs] [Scheduled jobs]
[As in jobl] [Scheduled jobs] [Scheduled jobs]

[Print] settings

[Confirm start of job] [Check first set]

[Off] [As in jobl
[On] [As in jobl
[Off] [On]
[Off] [As in jobl]
[Off] [Off]
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The Default Settings for [Output]

The default [Output] settings

Workflow profile

[Output] settings

[Next output tray] [Offset stacking]

[Standard]
[Job by job]
[Check and print]

[After each job]
[After each job]
[After each job]

[Sets (as in job)]
[Sets (as in job)]
[Sets (as in job)]

[Manual planning] [After each job] [Sets (as in job)]

[Unattended] [When tray is fulll [Banners]

Values and effects of the settings

The following table describes the effects of the various values of the settings.

Values and effects of the settings

[Destination of [Scheduled jobs] The jobs are immediately sent to the list of [Scheduled
print jobl jobsl.

[Waiting jobs] The jobs are sent to the list of [Waiting jobs]. You can
manually define the order in which the jobs will be prin-

ted.

[As in jobl The jobs are sent to the destination that is defined in the

job ticket or in the copy job.

[Destination of [Scheduled jobs] The jobs are immediately sent to the list of [Scheduled
copy jobl jobsl.

[Waiting jobs] The jobs are sent to the list of [Waiting jobs]. You can
manually define the order in which the jobs will be prin-

ted.

[DocBox] The copy jobs go directly to the [DocBox]. When you
have more than 1 [DocBox] on your system, you can se-
lect the [DocBox] to which the jobs will be sent.

[Destination of [Scheduled jobs] The jobs are immediately sent to the list of [Scheduled
DocBox job] jobsl.

[Waiting jobs] The jobs are sent to the list of [Waiting jobs]. You can

manually define the order in which the jobs will be prin-

ted.
[Confirm start of [On] The machine always stops before the next scheduled
job] job. Touch [Resume] in the dashboard to start each job.
[Off] The machine keeps printing all the jobs. The machine

does not stop before the next scheduled job, unless
there is a reason to stop. For example when a media is
not available.
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[Check first set] [On] The machine goes on hold after the first set of a job is
printed. You can check the quality and layout of the first
set before the machine prints the remaining sets.

[Off] The machine will print the whole job without stopping
after the first set.

[As in job] The machine will print the jobs as indicated in the job
ticket.

[Next output tray] [After each job] Each job is sent to the next available output tray. In this
context, the second stack of the stacker is also defined
as an output tray.

[When tray is full] All the jobs are stacked until an output tray is full. When
an output tray is full, the next jobs are sent to the next
output tray.

[Offset stacking]  [Jobs] Each printed job that is delivered to an output location is
stacked on top of the previous printed job with an offset.
This helps you to identify the various jobs.

[Sets (always)] Each printed set that is delivered to an output location is
stacked on top of the previous set with an offset. This
helps you to identify the various sets.

[Sets (as in job)]  Each printed set is delivered to the output location as de-
fined in the job ticket or copy job. Therefore, the sets can
be stacked in one straight line or with an offset.

[Banners] Each banner page of a job is delivered to the output lo-
cation with an offset. This helps you to identify the sepa-
rate jobs. The jobs themselves are stacked in one
straight line.

[Off] All the printed jobs or sets are stacked in one straight
line. There is no offset between the jobs or sets.
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Change the System Language

lllustration

Bl cestna HH iwieno ‘ = suemi ‘
Dansk ‘ == tagyar ‘ Svenska ‘
B oeutsen = Mederlanas [ S ‘
English (UK) Horsk ‘ [®] Bx= ‘
English (US) | [gd  Polski ‘ @0 ‘
Espafiol ‘ El rortugues

BH  rencas ‘ = T ‘

[13] Overview of the available languages

Procedure

1. On the control panel, touch [System] -> [Setup] -> [Language].

2. Touch the desired language.

3. Press [OK].
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Change the Warning Time

Introduction

When operator interaction is required immediately or soon, the LED on the operator panel and
the operator attention light can warn you. This is a trigger that action is required immediately of
soon., for example load a required media type or empty an output location. You can define how
long in advance the warning message is displayed.

By factory default, the function [Warning in advancel is enabled and set to 10 minutes. Then the
dashboard starts to display the warning 10 minutes before an action becomes inevitable. If you
do not respond to the warning message, the printer will stop. Depending on the urgency of the

warning message, the LED on the operator panel and the operator attention light are orange or
red.

NOTE
You can only change the warning time when the [Warning in advance] function is enabled.

Illustration

Warning time

Warning in advance

] on
- 10 -
K Cai

ncel

ol

[14] Change the warning time

Procedure

1. On the control panel, touch [System] -> [Setup] -> [Warning timel.

2. Touch the - or + button to decrease or increase the warning time in steps of one minute. You can
set a time from 1 - 60 minutes.

3. Press [OKI.
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Disable the Warning Time

Introduction

When operator interaction is required now or soon, the dashboard and the operator attention
light warn you. However, you can disable this warning function.

‘Warning time

Warning in advance

Minutes.

[15] Disable the warning time

Procedure
1. On the control panel, touch [System] -> [Setup] -> [Warning time] (under [Operator panel]).
When the box for [Warning in advance] has a check mark and states [On], the function is enabled.

2. Touch the [Warning in advance] button.
The check mark disappears. The status [On] changes into [Off].

3. Press [OK].
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Truncate the Job Name

Introduction

In the [Jobs] view, the control panel displays all jobs with their job names. If a job name is too
long, the systems truncates the job name. To enable you to identify your jobs in the lists more
easily, you can define how the system truncates the job names. This allows you to keep the
identifying part of the job name. You can truncate the job name either at the beginning or at the
end of the name.

Illustration

Job name t ti

Truncate job name at Begi
e —

nning
Number of characters R . 2
before truncation
K Cancel

0l

[16] Job name truncation

Procedure

1. On the control panel, touch [System] -> [Setup] -> [Job name truncation] (under [Operator
panell).

2. For [Truncate job name at], select [Beginning] or [End].
3. Touch the - or + button to indicate the number of characters before truncation.
4. Press [OK].
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Adjust the Brightness and Contrast of the Control Panel

Introduction

You can adjust the brightness and contrast of your monitor to improve the readability of the

control panel. The required brightness and contrast settings can depend on the lighting in your

room, for example.

[Auto adjust] The screen of the control panel will automatically set the correct

ratio of brightness and contrast.

[Brightness] You can increase or decrease the brightness from level 20 to 100
in steps of one. The higher the value, the higher the brightness.

[Contrast] You can increase or decrease the contrast from level 10 to 100 in

steps of one. The higher the value, the higher the contrast.

lllustration

[17] Adjust brightness and contrast

Procedure
1. On the control panel, touch [System] -> [Setup] -> [Operator panel settings].
2. Touch [Auto adjust] to optimize the brightness and contrast of the screen automatically.
3. Touch [OK] when the brightness and contrast are OK, or continue with the steps below when
these settings are not yet OK.
4. Touch '-' to decrease or '+' to increase the [Brightness].
5. Touch '-' to decrease or '+' to increase the [Contrast].
6. Press [OK].
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Introduction

Introduction

Introduction to the Media Handling

Media Handling

During printing, the printer can draw sheets from any tray that contains the required media for
that sheet in the job. You can open any tray while the system is running to add paper. The tray
opens as soon as possible without causing a paper jam. If the required media is available in other
trays, printing continues. Otherwise, printing stops.

Reload behavior

If you open and close a tray, and the slider position in the tray is consistent with the media type
previously configured for that tray, then the system assumes that the media type has not
changed. Otherwise, the system prompts you to assign a new media type to the tray.

Media assighment through the control panel

The control panel enables you to assign a specific media type to a tray at any time. You can select
the media to be assigned from the media catalogue and from the temporary media types. When
the print jobs require media that are not included in the media catalogue, these media become
temporary media on the system.

Supported media types per paper tray
All paper trays, except the internal bulk trays one and two, can be configured as desired.

The internal bulk trays one and two only support A4, LTR and B5. There is no sensor on these
trays that can detect the configuration. When you open and close these bulk trays, the
assumption is that the size is not changed. To load a different media size, the bulk trays must be
adjusted first.

What is the Media Catalog

The media catalogue is a list of predefined media and media attributes which you can define in
the Settings Editor application on the PRISMAsync controller.

When you use the media catalog, the control panel, the printer drivers and other applications all
display the same list of predefined media. The control panel and the printer driver automatically
retrieve and display the latest version of the media catalog.

What are Temporary Media

You can also use many other media that are not included in the media catalog. These media
become temporary media. You can look up the currently used temporary media in the [Medial
section of the [System] view. Furthermore, you can assign the temporary media to a paper tray.

The temporary media remain available on the system until:
* No more waiting jobs need this media type

* No more scheduled jobs need this media type

* No more printed jobs need this media type

* No more DocBox jobs need this media type

« This media type is no longer available in the paper trays.

When you plan to use these media more often, you can add these temporary media to the media
catalog.
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Introduction to the [Trays] View

Introduction

The [Trays] view has the following functions.

» Display the current content and filling level of the paper trays
* Open the paper trays and assign the media to paper trays

» Change the media that is currently assigned to a paper tray.

The tems of the [Trays] View

=l Trays

1@ 8@ 2@ 30 o

Unassign

Registrati

Not assigned

6 [, totomipes

1 \=‘D 4303, 155 gjm?, Top Coated

@ Pro Silk, White

2 {% A3 [®, 80 g/m3, Plain paper,

2 White
Oce Lila __ Lime Green 3
B 02 [[] 4D, e0gme, - ﬂ 40, 80 g/m?, Plain paper,
Plain paper, Lia Plain paper, W... — White
A4 tab
3 | j 223%297 [, tab indusive, cydic (5), 80
—' g/m?, Plain paper, White 4
= D Plain A4
4 = 4403, 80 g/m2

:l A4[%, B0 gfm?, Plain paper, White

@ Schedule @ Jobs

=l Trays ‘5{3&}. System

[18] Example of a configuration with 1 external paper module

1 Content of the paper trays

[Assign] button
[Unassign] button
[Open] button

[Registration] button

o o~ W N

Arrow buttons

Indicate the current content and filling level of the paper
trays. The [Trays] view displays the parameters of the
media that are currently in the paper trays. The parame-
ters are a combination of icons and texts.

Assign media from the media catalogue.

Unassign media from the paper tray.

Open the selected paper tray to load the media.
Perform a media registration on the selected media.

When your configuration contains more paper modules
than the [Trays] view can display in one screen, you can
touch the arrow buttons to change the part of the ma-
chine displayed.
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The paper tray information

The [Trays] view displays the following textual information for each paper tray.
* The media name, for example 'Normal paper'.

* The media size, for example A4 or LTR.

* The media weight, for example 80 g/m2 or 20 Ib bond.

¢« The media color

» The special characteristics of the media, for example [cyclic] or [punched]. In brackets,
additional information is given about these media, for example the cycle count or the number
of holes for punched media.

The [Trays] view displays the following icons for each paper tray.

The meaning of the icons

o pion

|l

< B

%in

ne o

Do EBEO &

The paper tray is empty.
The paper tray is full.

NOTE
Each line indicates the presence of about 100 sheets.

The paper tray is too full. Remove sheets from the stack.
The plate inside the paper tray is down.
The paper tray is open.

The paper guides inside the paper tray do not match the selected me-
dia size. You must correct the paper guides or the selected media.

The paper tray contains media that are fed over the long edge (1 or
short edge 1. The small icons indicate A4/LTR or A4/LTR-like media.
The large icons indicate A3/Tabloid or A3/Tabloid-like media. When you
defined a color for a media, the icon can have that color.

The paper tray is in use for one or more scheduled jobs.

The paper tray contains tab sheets.

The paper tray contains tab sheets that must be processed as inserts.
The paper tray contains inserts.

The paper tray contains media that are fed over the long edge.

The paper tray contains media that are fed over the short edge.
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Introduction to the [Media] Section

Introduction

This section gives an overview of the [Medial section in the [System] view.

Overview of the [Media] Section

Media catalog Temporary media

Special A4

Ad, 120 gin?, White ‘

@

Registration @
Media Media
i)
‘ D Hormal A4 .
Ad, 80 gi, White

T Red Label A4
[ A4, 80 g/, White

Logo A4
Ad, 80 g/m?, White

Normal Letter
Letter 8.5x11, 80 g/m®, White

Normal A3

A3, 80 g/m*, White |

Custom 20x30
(200 x 300 mm), 80 gim?, White

D 10x7
(177, x 254 mm), 80 gin?, White

AdInsert
A4, insert, 50 gim, White

A4 Tab
A4Tab, tab inclusive, 80 g/n?, White

]

‘ =| Trays

[g Jobs

@ Schedule

[19] Overview of the [Media] section

‘ % System

The Items of the [Media] Section

Description of the [Media] section

T

1 [Registration] button Touch the [Registration] button after selecting a media
from the media catalog to start a registration procedure
for that media.

2 [To catalog] button Touch the [To catalog] button after selecting a tempora-
ry media to add that media to the media catalogue.

3 List of all the media that The list displays the current content of the media cata-

are available in the media  log.
catalog.
4 List of temporary media The list displays the temporary media that are currently

available on the system.
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Media Related Actions

Open a Tray and Load Media Using the Paper Tray Button

Introduction

Besides loading media via the [Load] button in the [Schedule] view, there are two ways to open a
tray and to load and assign media:

1. Through the softkey for the [Trays] view at the bottom of the control panel.

2. Through the paper tray button = at the right-hand side of the control panel.

In both cases, the control panel displays an overview of the printer and the paper trays. Now you
can open a tray, and load and assign media.

This section describes the use of the paper tray button I=.

IMPORTANT

Make sure that you remove the packaging carefully from the paper because glue stains on the
paper can pollute the machine. To prevent pollution, it is advised to remove the first and the last
sheet of a pack of paper. In case of pollution of the machine, you must carry out the drum
cleaning procedure via the Maintenance section on the control panel.

NOTE

You only have to assign the media to a paper tray when you change the media type for that
paper tray. For example, when the paper tray previously contained Normal A4 and you load
Coated A4 now. Then you have to assign Coated A4 to that paper tray.

NOTE
You can order all required supplies from your local authorized dealer.

Procedure

gpOd=

©xo~Ne

Press the paper tray button 1= at the right-hand side of the control panel.

On the control panel, touch the tray in which you want to load the media.

Touch [Open] to open the selected tray.

Load the media into the tray (header up, face up).

When you loaded a different media type than the media previously contained in the selected
paper tray, touch [Assign medial.

Select the correct media type from the media catalogue.

Press [OK].

Press [Donel.

Close the paper tray gently by pushing in the middle of the tray cover.
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Load and Assign Media Using the [Trays] Softkey

Introduction

Besides loading media via the [Load] button in the [Schedule] view, there are two ways to open a
tray and to load and assign media:

1. Through the softkey for the [Trays] view at the bottom of the control panel.

2. Through the tray hardkey |= at the right-hand side of the control panel.

In both cases, the control panel displays an overview of the printer and the paper trays. Now you
can open a tray, and load and assign media.

This section describes the use of the softkey for the [Trays] view.

@ IMPORTANT
Make sure that you remove the packaging carefully from the paper because glue stains on the
paper can pollute the machine. In case of pollution of the machine, you must carry out the drum
cleaning procedure via the Maintenance section on the control panel.

NOTE

/@ You only have to assign the media to a paper tray when you change the media type for that
paper tray. For example, when the paper tray previously contained Normal A4 and you load
Coated A4 now. Then you have to assign Coated A4 to that paper tray.

NOTE
You can order all required supplies at your local authorized dealer.

lHlustration

=l Trays
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[20] Load and assign media using the [Trays] softkey

Procedure

1. On the control panel, touch [Trays].
2. Touch the paper tray where you want to put the media.
3. Press [Openl].
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Load the new media.

Close the paper tray gently by pushing in the middle of the tray cover.

6. Press [Assign].
A list of media from the Media catalogue appears. The list displays all the media in the Media
catalogue that match the position of the paper guides inside the closed paper tray. When the list
is empty, the media catalog does not contain media that match the position of the paper guides.

7. Touch the new media type.

8. Press [OK].

o s
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Add Temporary Media to the Media Catalog

Introduction

When a job is submitted that requires media that are not included in the media catalog, these
media become temporary media. The control panel displays the temporary media in the
following places.

* In the list of [Required media] in the [Schedule] view, when the job is scheduled for printing.
* Inthe list of [Temporary media] in the [Media] tab of the [System] view.

When you plan to use a temporary media more often, you can add the media to the media
catalog.

This section describes how to add temporary media to the media catalog.

Procedure

1. On the control panel, touch [System] -> [Medial.

The names of the temporary media are displayed in the [Temporary media] section.
2. Select the media you want to add to the media catalog.
3. Press[To catalogl.

The media is added to the media catalog.

[@ NOTE

If required, you can edit the attributes of the media in the media catalog, that is part of the
Settings Editor.
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Use the Separation Enhancer

Introduction

&

The separation enhancer improves the separation performance of specific media, such as coated
media. The table below gives recommendations about the use of the separation enhancer.

To prevent the risk of double sheet separations, it is advised to remove the separation enhancer
in all other situations.

The trays three and four both contain a separation enhancer. You can use the separation
enhancer in all the trays.

When to use the separation enhancer

Small formats: A4, LTR, 16K, B5, US Standard > 100 g/m2 (28 Ib Never
bond)
Large formats: (A3, SRA3, A3+, 8K, B4, Legal) = Always > 160 g/m2 (60 Ib cov-
er)
NOTE

Only deviate from the recommendations above when the printer repeatedly stops while the
operator panel displays the error code ORE147x1.

Illustration

[21] The separation enhancer

Install the separation enhancer

1 Touch [System] -> [Maintenance] -> [Start
maintenance] -> [Separation enhancer] ->
[Start].
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2 [Open the tray (tray 3 or 4) and loosen the
separation enhancer.]
[Place the separation enhancer in the sep-
aration unit.]

3 [Lock the separation enhancer.]
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Adjust the Size of the Bulk Tray

Introduction

The bulk trays are designed to contain the media that you frequently use a lot. Therefore, the
paper guides inside the bulk trays are set to a fixed media size.

However, if you want to use a different media size with a bulk tray, you must do the following.
* Reposition the paper guides of the bulk tray manually to match the new media size, and
» Assign the changed media size to the corresponding bulk tray.

Before you begin

1. Touch the paper tray button at the right-hand side of the control panel.
2. On the control panel, touch the bulk tray of which you want to adjust the size.
3. On the control panel, touch [Open] to open the selected bulk tray.

Required tools

Socket wrench

lllustration

[22] Required tools

Adjust the bulk tray

1 [Remove the paper.]
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Sop deien i

2 [Use the socket wrench to loosen the bolt
at the back side.]

3 [Remove the top paper guide.]
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4 [Turn the side paper guide out of the
slots.]
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Sop peion i

5 [Place the side paper guide. Align the 4
pins with the desired slots.]
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6

[Place the top paper guide. Align the 4
pins with the desired slot.]

[Use the socket wrench to tighten the
bolt.]

[Adjust other side]
Repeat the previous steps for the front
side.

Canon varioPRINT 135 Series
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Adjust the Size of the Bulk Tray

9 [Check if all plates are aligned with the
corresponding size marks.]

10 [Close the tray.]

11 In the [Trays] view on the control panel,
assign the new media size to the bulk
tray.
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Adjust the Size of the optional Bulk Tray for small Format

Introduction

The bulk trays are designed to contain the media that you frequently use a lot. Therefore, the
paper guides inside the bulk trays are set to a fixed media size.

When the optional bulk tray for small format is installed, you can adjust the size of the bulk tray to
Ab or Statement.

[@ NOTE

When you want to adjust the size of the bulk tray from A5 or Statement to A4 or Letter, remove

the Ab paper guide plates. Change the media size for the selected bulk tray. Assign the new
media.

Required tools

Socket wrench

Procedure

1. Touch the paper tray button at the right-hand side of the control panel.

2. On the control panel, touch the bulk tray of which you want to adjust the size.

3. On the control panel, touch [Open] to open the selected bulk tray.

4. Place the paper guide plates for small format over the existing paper guide plates.
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Use the socket wrench to tighten the bolts.

Close the tray.

7. Change the media size for the selected bulk tray. [System] -> [Setup] -> [Local key operator
settings] (under [Advanced]) -> [System settings] -> [Bulk tray 1 media size] or [Bulk tray 2 media
size].

8. Inthe [Trays] view on the control panel, assign the new media to the bulk tray.

o o
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Use the JIS B5 Adapter (Option)

When to do

When you place small media with a short edge of 182 mm - 203 mm (7.2" - 8.0") in the bulk trays
of an external paper module, especially JIS B5.

Before you begin

1. Open a bulk tray of an external paper module.
2. Remove the current media from that bulk tray.
3. Place the media.

Required tools

1 JIS B5 adapter

Place and remove the adapter

1 Place the adapter over the
front slider at the right-
hand side.

2 Slide the adapter against
the media.

3 When you place a larger
media type, make sure that
you remove the adapter.

NOTE

Do not store the
adapter inside
the paper tray.
Otherwise, an er-
ror can occur.
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Process Special Media

Process Pre-Printed Media and Use of the [Pre-printed mode]
Setting

Introduction

The system is able to handle pre-printed media without problems if the guidelines regarding pre-
printed media and inks are taken into account. In case media or inks are used that are not listed in
the guidelines, the use of pre-printed media can lead to undesired print quality issues. To prevent
print quality issues, a [Pre-printed mode] function is available on the printer. It is advised to
enable the [Pre-printed mode] when there are problems with processing pre-printed media. The
system will then be cleaned at fixed intervals. It is advised to enable the [Pre-printed mode] only
when you process pre-printed media. Afterwards, the function should be disabled.

NOTE
Contact your local authorized dealer for the latest guidelines.

lllustration

Ady d media settings

Pre-printed mode

Wax mode

% Paper quality

[23] The [Pre-printed mode] setting

Procedure

1.  On the control panel, touch [System] -> [Setup] -> [Advanced media settings] (under [Advanced]).
2. Touch the [Pre-printed mode] button.
3. Press[On].
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Process Pre-Printed Media and Use of the [Pre-printed mode] Setting

@ NOTE
Make sure that you put the [Pre-printed mode] setting back to [Off] when you have finished
using pre-printed media.

4. Press [OKI.

NOTE
[@ The text on the [Advanced media settings] button has changed into [Custom], which indicates
that a default setting in the [Advanced media settings] section has changed.

Result

The pre-printed mode is active. At the right-hand side of the dashboard the following icon is
displayed.
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Process Wax Paper and Use of the [Wax mode] Setting

Introduction
Wax paper and print quality issues

The printer can handle wax paper. Wax paper is a type of paper that is made moisture-proof
through the application of wax. When you use wax paper, the system can become polluted,
which can lead to undesired print quality issues. To solve this, a [Wax mode] function is available
on the printer. It is advised to use the [Wax mode] in case of problems with processing wax
paper. Then the system will be cleaned automatically after printing wax paper. It is advised to
enable the [Wax mode] only when you process wax paper. Afterwards, the function should be
disabled.

The wax modes

The printer has two wax modes that help you to solve print quality issues with wax paper. Each
wax mode consists of two steps:

1. Safe preheating of the system to prevent the deposition of wax.

2. After printing, the printer remains in the stand-by mode to decompose the remaining wax.

Differences between wax mode [1] and [2]

+ Wax mode [2] requires a higher start-up temperature, which increases the start-up time of the
printer.

* Wax mode [2] requires more time for the decomposition of the wax.

Important information about the cleaning process

The more wax paper you print, the longer the printer needs to decompose the wax. For an
optimal performance of the wax mode, do not print more than 50,000 sheets of wax paper. If you
must print more, first let the printer run in stand-by mode to decompose the wax, or carry out
print jobs that do not require wax paper.

After processing wax paper, do not switch off the printer manually or put the printer into the
sleep mode manually. Leave the printer in stand by-mode to allow the cleaning of the wax
components. After maximum 2 hours in the stand-by mode, the printer will switch to the sleep
mode automatically. If these two hours were not enough to decompose all the wax, the machine
remains stand-by after the next job, until all the wax is cleaned.

When to do

» Select wax mode [1] when you have print quality issues with wax paper.
* Only select wax mode [2] when wax mode [1] is not sufficient to solve the print quality issues.
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Illustration

[24] The [Wax mode] setting

@ IMPORTANT
Make sure that you put the [Wax mode] setting back to [Off] when you have finished using wax

paper.

Procedure

1. On the control panel, touch [System] -> [Setup] -> [Advanced media settings] (under [Advanced]).
Touch the [Wax mode] button.

Touch [1] or [2].

Press [OKI.

The text on the [Advanced media settings] button has changed into [Custom]. This indicates that
a default setting in the [Advanced media settings] section has changed.. The control panel does
not display any other reminder that helps you to remember that the [Wax mode] setting is active.

POD
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Deal with Paper Dust and Use of the [Paper quality] Setting

Introduction
Good paper is best run with the highest paper quality factor: [Normal].

Lower grade media such as recycled paper can leave more paper dust in the machine. This can
lead to uneven, dark areas on prints with ghosts (echos) of previous pages. If necessary, you can
improve the print quality by decreasing the value of the [Paper quality] setting to [Low] or
[Lower].

When to do

1. Decrease the [Paper quality] from [Normall to [Low] when the use of lower grade media
causes quality issues.

2. Decrease the [Paper quality] from [Low] to [Lower] when the quality issues are not solved by
using the [Low] mode.

NOTE
When you change a value of the [Paper quality] setting, a restart of the printer is required. The
restart takes 2-3 minutes.

lllustration

d media settings

i | Pre-printed mode

Wax mode

R‘ Paper quality

[25] The [Paper quality] setting

@ IMPORTANT
Make sure that you put the [Paper quality] setting back to [Normal] when you have finished
using fiber-rich media.
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Procedure
1. On the control panel, touch [System] -> [Setup] -> [Advanced media settings] (under [Advanced]).
2. Touch the [Paper quality] button.
3. Touch [Low] or [Lower].
4. Press [OK].

The text on the [Advanced media settings] button has changed into [Custom]. This indicates that
a default setting in the [Advanced media settings] section has changed. The control panel does

not display any other reminder that helps you to remember that the [Paper quality] setting is
active.
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Media Registration

When to Perform a Media Registration

Examples of when to Perform Media Registration

Introduction

Media registration is an indication for how accurately an image is positioned on a sheet of paper.
The position and the form of a printed image can differ slightly from the original image or the
digital image. Possible causes:
* Printer component tolerances.
* Media size tolerances.
Possible causes:
* Inaccuracies during the paper production, or
* The relative humidity or temperature of the environment in which the paper is stored and
used.
* Media type (glossy media, for example).
» Job type (1-sided or 2-sided).
* Feed direction (LEF or SEF)
+ A change of media supplier.
* A new batch of media.

The different properties of media can influence the alignment of images when the media are
printed. This section gives examples of situations when media registration can be required.

NOTE

+ Itis recommended to check the media registration after every 500,000 prints.

» After a software upgrade, you must verify the media registration.

* When you copy the media catalog from one printer to another, you must verify the media
registration because the media registration depends on the printer and on the media.

* The situations described are only examples. There are more situations possible when media
registration must be performed.

Example 1 - Images and Text

When you print images and text on a sheet, the following deviations can occur:

B

The lines on the front and back are not aligned
(front-to-back side registration).
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The image is not in the center of the sheet

(shifted image). B

The image is skewed (skewed image).

The image is tilted (diamond shape image).
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The top of the image is smaller than the bot-
tom of the image, or the other way around
(trapezoid shape image).

B

The image is reduced or shrunk in the feed di-
rection (elongation).

NOTE
Combinations of two or more deviations can occur.

Canon varioPRINT 135 Series
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Example 2 - Forms

When you print text on forms, the text must be printed in the designated area. For example, an
address or a date must be printed at the correct position. Here you see an example where the
printed date is not positioned correctly.

Date: 23-10-2012

Ordered By
Company:
Address:

State/Province:
Zip/Postal Code:

Phone:

Fax:

Contact Name:

Deliver To [ same as Above
Company:
Address:

State/Province:
Zip/Postal Code:
Phone:

Fax:

Contact Name:

0Océ Technologies B.V.
St-Urbanusweg
Venlo, Limburg

Netherlands
5900 MA

Phone: 111-222-3333
Fax: 111-222-4444
www.oce.com

Payment

Q Check payable to

QO Credit Card
O American Express
O Mastercard
Q Visa

Card Number:

Expiration Date:

Cardholder Name:
Data is not secure.

Internal Use Only

Order
Completed:

Ship Date:
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How to Perform a Media Registration

Media Registration Quick Start

Introduction

This section gives a general description on how to perform a media registration. A detailed
description is given in the sections that follow.

Procedure

1. On the control panel, select the media for which you want to perform the media registration.
You can start a media registration from the trays view (touch [Trays] -> [Optimize]), or from
the media catalog (touch [System] -> [Medial). There you can select the required media.

D:|

I = Trays
‘ L4 i &~ P ‘
Assign Unassign ‘Open Optimize
E‘!—?‘& Registration
Curl correction
=
A4[3, 80 gfm?, Not assigned
‘ 3 (= % hot assigned }
4 =l % Not assigned ;
@ Schedule Jobs =l Trays ‘5% System

[26] Perform the media registration via the trays view
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FrontCover Ad
e A3, 80 gfm?, Plain paper, White Ad, 80 g/m?, Plain paper, White
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_.!1:;" 223297, tab inclusive, cyclic (5), 80 g/m?,

= Plain paper, White
Letter tab
911, tabinclusive, cyclic (5), 75 gfm?,
Plain paper, White

@ Schedule Jobs =l Trays ‘%}, System

] LEF registration Media

[[] Temporary media

Registration

k Ad, 80 g/m?, Plain paper, White

A Banner A4 | A

I_] SEF registration

D Letter 8,5x11, 75 g/m?, Plain paper, White Ad, B0 g/m?, Plain paper, White

RearCover A4 |

[27] Perform the media registration via the media catalog

2. Touch [Registration].

3. When you start a media registration from the media catalog, select the feed direction for
which you want to perform the media registration. The media registration can be different for
LEF and SEF.

When you start a media registration from the trays view, the feed direction is already
selected.
If the printer is not warmed up, the media registration starts by warming up the printer.

4. Select [Automatic adjustment] or [Manual adjustment]. It is recommended to start with the
automatic media registration adjustment.

At [Automatic adjustment], touch [Start].
When you select [Manual adjustment], go to step 8.

5. Follow the instructions on the control panel to scan the printed registration sheets.

6. You can verify the result of the automatic registration adjustment on the verification chart.
Touch [Print verification chart] to print the verification chart.

NOTE

Depending on the media type and the media size, the dots, circles and lines on the verification
chart do not have to match perfectly.

7.

If you perceive that the media registration is not optimal, you must perform a manual media
registration adjustment. But after automatic media registration, the media registration is
optimal in almost all cases.

At the [Manual adjustment], touch [Start].

In the manual registration adjustment, you can adjust the registration parameters for the front
side and the back side separately. Only use [Advanced settings] in exceptional cases. Use
[Advanced settings] carefully because these settings influence each other.
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Width () 5

B LEF registration: A4, 80 gjm?, White
i
Actual sheet size
J JJ x

Advanced settings

i X elongation (0.01%) -

X offset (mm)

2 offset (mm)

Assumed default output orientation:
~Face down Describe back side
~Header up
Apply changes/print chart Apply Close
| v

(1) schedule Jobs =l Trays ‘ &y system

A detailed description is given in the sections that follow.

Z@ NOTE

X means an adjustment in the feed direction.
Z means an adjustment perpendicular to the feed direction.

9. You can verify the result of the manual registration adjustment on the verification chart.
Touch [Print verification chart] to print the verification chart.

1@ NOTE

» Depending on the media type and the media size, the dots, circles and lines on the
verification chart do not have to match perfectly.

* You can also perform a manual media registration via the Settings Editor. The manual
media registration via the control panel is preferred because you can print the verification
chart immediately after you changed a setting.
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Order of the Media Registration Actions

Introduction

When the media registration is not optimal, you can take various actions to solve the
misalignment. This section describes the order of the actions you must take.

Media Registration Options

Automatic media registration Control Specific me-  Media registration is not opti-
via the control panel. panel dia mal.

See Media-Specific Registration

on page 91.

Manual media registration. Control Specific me-  Only when the media registra-
Only needed in incidental cases. panel (pre- dia tion is not optimal after you per-
The manual media registration  ferred) formed the automatic media
can be done via the control pan- Settings registration via the control pan-
el (see Via the Control Pane/on  Editor el.

page 96) and via the Settings Or when the media is 1-sided
Editor. media, because the automatic
The manual media registration media registration prints a 2-si-
via the control panel is prefer- ded registration print. Examples
red because you can print the of 1-sided media are tab sheets
verification chart immediately and transparency media with
after you changed a setting. paper backing.

Both procedures have the same

result.

If the printer is not warmed up, the media registration starts by warming up the printer.

After you performed one of the media registration options, you can print a verification chart to
verify the media registration adjustment. See Print the Verification Chart for Media Registration
on page 89.

It can occur that the media registration for a media is correct but the image overlaps some
preprinted parts of the media. You must shift the image for that specific preprinted media (see
Corrections for Preprinted Medija on page 114).

Order of the Actions

Procedure

1. Perform the automatic media registration on the control panel for the media of your current job.
Print the job again or print the verification chart to verify if the media registration is correct now.
If the media registration is not optimal, continue with step 2 below.

2. Perform a manual media registration adjustment via the control panel (preferred) or via the
Settings Editor. Only needed in incidental cases. E.g. media registration is not optimal, media is
1-sided.
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Print the Verification Chart for Media Registration

Introduction

You can print the verification chart on a specific media to verify if the media registration for that
specific media is optimal.

Z@ NOTE

You cannot print the verification chart on media that you can only print 1-sided because the
verification chart is 2-sided. Use your own job to verify if the media registration is optimal.
Examples of 1-sided media are tab sheets and transparency media with paper backing.

Before you begin

Before you print the verification chart, make sure that the printer is warmed up. The printer must
have printed for at least 20 minutes.

O O i e

s50 puz

- o

® o - o .
E I A R I

[28] Front side (circles) and back side (dots) of the verification chart for media registration
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=l Trays
| | |
L & .
Assign | | Open | Optimize
E@ Registration
Curl correction
1 == 2 =
a4, 80 gjmz, Not assigned
3 = % Mot assigned
4 = % Mot assigned
@ Schedule Jobs =| Trays %}. System

[29] Print the verification chart via the trays view

Procedure

1. On the control panel, touch [Trays].

Select the media via the tray that contains the media.

Touch [Optimize] -> [Registration].

You can also select the media via the media catalog.

1. On the control panel, touch [System] -> [Media] to open the media catalog.

2. Select the media from the media catalog for which you want to print the verification chart for
media registration.

3. Touch [Registration].

4. Select the feed direction for which you want to print the verification chart.

5. Touch [Print the verification chart].
The verification chart is printed and you can verify the media registration for the selected media.
The verification chart has an optimal result when the paper path is filled. Therefore three blank
sheets precede the verification chart and two blank sheets are delivered after the verification
chart is printed.
You are not charged for the blank sheets.

PN

Result

You must use the lines in the corners of the verification chart to measure the registration for
manual registration adjustment.
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Option 1 - Automatic Media Registration Adjustment

Media-Specific Registration

When to do
When the media registration for a specific media is not optimal.

You can start a media-specific registration from the trays view or from the media catalog. First,
the steps of the media registration procedure are described in general.

[@ NOTE

+ The media-specific registration overwrites any automatic or manual media-specific
registration performed previously.

* You cannot perform media-specific registration for temporary media. You must add the
temporary media to the media catalogue first.

* You cannot perform an automatic adjustment for media that you can only print 1-sided,
because the adjustment procedure prints 2-sided registration sheets. Examples of 1-sided
media are tab sheets and transparency media with paper backing. For these media, you must
perform a manual media registration.

* Itis recommended to perform the media registration when the list of [Scheduled jobs] is
empty. Otherwise, other jobs can start printing while the media registration takes place.

1@ NOTE

* When the media is larger than the glass plate (larger than 420 mm (16.5") in X direction (feed
direction) and / or larger than 297 mm (11.7") in Z direction (perpendicular to the feed
direction)), you can still perform media specific registration. The information needed for the
automatic adjustment is within the range of the glass plate. You must only enter the actual
sheet size via the manual adjustment for this media. The scanner cannot detect the actual
sheet size and assumes the nominal sheet size.

Actual sheet size

Length (mm) - 297.0 + l

>

1

>
z
E
H
i
i
4
&
g
H

X offeet (mm)

Z offset (mm)

Assumed default output orientation:
~Face dovin Describe back side
~Header up
[ Apply changes/print chart Apply Close }
| ~7

@ Schedule ‘ Jobs =l Trays ‘ % System
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Media-Specific Registration

Media Registration Procedure

The system prints a number of registration sheets.

Scan the printed registration sheets one by one. First the front side, then the back side.

The systems calculates the registration adjustment parameters.

The system sets the calculated parameters as default registration parameters for this specific
media.

POODd=

Start a Media-Specific Registration via the Trays View

1. On the control panel, touch [Trays] to open the trays view.

U:|

= Trays

—
DE, ‘ ] ‘ Y l v .
Assign | Unassion | Open | Optimize @
EE? Registration

Curl correction

D a4l 80gjm2, % Mot assigned

Plain paper, ..

3 % Mot assigned

4, % Mot assigned

@ Schedule Jobs ‘ =| Trays {%}. System

2. Select the media for which you want to perform the media registration.
3. Touch [Optimize] -> [Registration].
When the media is larger than 420 mm (16.5") in X direction (feed direction) you get a
reminder to enter the actual sheet size via the manual adjustment.
4. At [Automatic adjustment], touch [Start].
When a maintenance PIN is defined in the Settings Editor, a numerical keyboard appears.
5. Enter the maintenance PIN to start the wizard.
6. Touch [Next].

Start a Media-Specific Registration from the Media Catalog

1. On the control panel, touch [System] -> [Medial to open the Media Catalog.
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Actions for Media-Specific Registration

[[] Media catalog [[] Temporary media
IE =
Registration
o |1 veF registration Veda
EIEIE
Banner A4
E - Ad, 80 gfm?, Plain paper, White | -
[ SEF registration
= FrontCover Ad
1% 43, 80 g/m?, Plain paper, Whice | A4, 80 gfm?, Plain paper, White |
D RearCover A4
Letter 8.5x11, 75 gfm=, Plain paper, White A4, 60 gfm=, Plain paper, White
Media I:l Tabloid 11x17, 75 gjm?, Plain paper, White
7 Adtab
j‘,r" 203x297, tab inclusive, cyclic (5}, 80 gm?,
.. Plain paper, White
Letter tab
ax1L, tab inclusive, cyelc (S), 75 gjm?,
Plain paper, White
@ Schedule Jobs =l Trays ‘%}. System

2. Select the media for which you want to perform the media registration.

3. Press [Registration].
When the media is larger than 420 mm (16.5") in X direction (feed direction) you get a
reminder to enter the actual sheet size via the manual adjustment.

4. Select the feed direction for which you want to perform the media registration ([LEF
registration] or [SEF registration])

5. At [Automatic adjustment], touch [Start].
When a maintenance PIN is defined in the Settings Editor, a numerical keyboard appears.

6. Enter the maintenance PIN to start the wizard.

7. Press [Next].

Actions for Media-Specific Registration

1 Place the registration sheet with number NOTE
1 face down on the glass plate, and touch Make sure that the registration
[OK] to scan. sheets are placed correctly in

the left-hand upper corner of
the glass plate. Make sure that
the registration sheet on the
glass plate is not curled or has
dog ears. You can use a stack of
paper to reduce the curl.

You must close the ADF / cover
for each scan.

2 Place the registration sheet with number
2 face down on the glass plate, and touch
[OK] to scan.
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Actions for Media-Specific Registration

3 Repeat the steps 1 and 2 with the next
registration sheets.

4 The media registration is completed when
the control panel displays the message
[Remove the registration sheet from the
glass plate.]

Touch [Next].

5 The control panel displays the message NOTE
[Do you want to print the verification The media specific registration
chart?]. When you touch [Yes], the verifi- adjustment overwrites any au-
cation chart is printed. tomatic or manual media specif-
The automatic media registration is com- ic registration performed previ-
pleted. ously.

T B

If the adjustment was successful, this icon
appears behind the media registered in
the media catalog in the Settings Editor.

7 When the following conditions apply, you See Registration Values on page 98.
must enter the actual sheet size via the If you do not enter the actual sheet size,
manual media registration for this media. you will see a large deviation in front-to-
* The media registration is not optimal back side registration.

and

* The sheet is larger than 420 mm (16.5")
in X direction (feed direction) and larg-
er than 297 mm (11.7") in Z direction
(perpendicular to the feed direction).

8 Only if the media registration is not opti-  Print the verification chart to verify if the
mal, continue with the next option. media registration is optimal now.
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Option 2 - Manual Media Registration Adjustment (Only Needed in Incidental Cases)

Option 2 - Manual Media Registration Adjustment (Only Needed in Incidental

Cases)

When to Do

* You already performed the automatic registration adjustment via the control panel (option 1),

but the result is still not optimal, or
* The media is 1-sided media. Examples of 1-sided media are tab sheets and transparency media
with paper backing.

Description

You can do the manual adjustment of the media registration via the control panel and via the
Settings Editor. Both procedures have the same result. The manual adjustment via the control
panel is preferred because you can print the verification chart immediately after you changed a

setting.

Determine the kind of adjustment you need. This depends on the image on the sheet, for example
elongation, image shift or skew.

You can define the following settings:
+ Standard settings for front side and back side
« X elongation
« X offset; in the feed direction
» Z offset; perpendicular to the feed direction

D:|

B LEF registration: A4, 80 gjm2, White
Ty

(3) schedule [y

Actual sheet size
+ Width (mm) = 210.0 + =+
Registration adjustment front side
A
- + Advanced settings D - +
X elongation (0.01%) - 0 +
X offset (mm) - 0.0 +
2 offset (mm) - 0.0 +
Assumed default output orientation:
- Face down Describe back side
- Header up
Apply changes/print chart Apply Close
| N7
[ I
Jobs =l Trays ‘ % System

» Advanced settings for front side and back side. Touch [Advanced settings] to display these

settings.
* Trapezoid
* Diamond
» Skew

Canon varioPRINT 135 Series
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Via the Control Panel

NOTE
It is recommended to perform the media registration when the list of [Scheduled jobs] is empty.
Otherwise, other jobs can start printing while the media registration takes place.

Via the Control Panel

Before you begin

NOTE

« The media-specific registration adjustment overwrites any automatic or manual media
specific registration performed previously.

* You cannot perform media-specific registration for temporary media. You must add the
temporary media to the media catalogue first.

Print the verification chart to verify the media registration.
1. On the control panel, touch [Trays] to open the trays view.

D:|

= Trays
4 2 A v
Assign Unassign Open Optimize
EE; Registration
Curl correction
1 — 2 =
A4, 80 gjm2, Not assigned
3 = Not assigned
=3 o
4, % Not assigned
@ Schedule Jobs =| Trays %}. System

2. Select the media for which you want to perform the media registration.
3. Touch [Optimize] -> [Registration].
When the media is larger than 420 mm (16.5") in X direction (feed direction), you get a
reminder to enter the actual sheet size via the manual adjustment.
4. At [Manual adjustment], touch [Start].
When a maintenance PIN is defined in the Settings Editor, a numerical keyboard appears.
5. Enter the maintenance PIN to start the manual adjustment.
6. Touch [Next].

You can also select the media via the media catalogue, instead of via the trays view.
1. On the control panel, touch [System] -> [Media] to open the media catalog.
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Via the Control Panel

[[] Media catalog [[] Temporary media
Registration
—_— Media
| LEF registration
H‘h‘ 0
Banner A4
E - Ad, 80 gfm?, Plain paper, White -
[ SEF registration
= FrontCover Ad
1% 43, 80 g/m?, Plain paper, Whice | A4, 80 gfm?, Plain paper, White
D RearCover A4
Letter 8.5x11, 75 gfm=, Plain paper, White A4, 60 gfm=, Plain paper, White
Media I:l Tabloid 11x17, 75 gjm?, Plain paper, White
e Adtab
j‘,r" 203x297, tab inclusive, cyclic (5}, 80 gm?,
.. Plain paper, White
Letter tab
ax1L, tab inclusive, cyelc (S), 75 gjm?,
Plain paper, White
@ Schedule Jobs =l Trays ‘%}. System

2. From the media catalog, select the media for which you want to perform the media

registration.
3. Touch [Registration].

When the media is larger than 420 mm (16.5") in X direction (feed direction), you get a
reminder to enter the actual sheet size via the manual adjustment.
4. Select the feed direction for which you want to perform the media registration.

5. At [Manual adjustment], touch [Start].

When a maintenance PIN is defined in the Settings Editor, a numerical keyboard appears.

6. Enter the maintenance PIN to start the manual adjustment.

7. Touch [Next].
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Via the Control Panel

Registration Values

Assumed default output orientation:
- Face down
- Header up

Actual sheet size

Width (mm)

¥ offset (mm)

2 offset (mm)

{ Apply changes/print chart

Describe back side
Apply Close }
H |~

(1) sehedule

‘ Jobs

‘\;Tlays

o=

Upper section (1)

Lower section (2)

The actual sheet size measured in the feed di-
rection. It is recommended to measure several
(6) sheets. Determine the average sheets size
in the feed direction. For LEF, enter the sheet
width.

A

=<

[30] For LEF, enter the sheet width
For SEF, enter the sheet length.

A=
=4
[31] For SEF, enter the sheet length

The actual sheet size is used in the front-to-
back registration. The actual sheet size has im-
pact on the distance between the leading edge
of the sheet and the leading edge of the image.

The required values. Use the verification chart
to determine which value to change. The sec-
tions hereafter describe how to determine the
values you must enter. For most situations you
can correct the media registration with the
standard settings. Only in exceptional cases,
you need the advanced settings.

98
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Elongation

NOTE

You can touch the - and + buttons to change the values. You can also enter the required value
directly. Touch the number to enter a value manually. The numeric keyboard appears. There you
can enter the required value.

1@ NOTE

If you touch [Close] before you apply the changes, the values are not saved.

You must decide whether you want to correct the media registration of the front side or the back
side or both. You can base this decision on the processing of the jobs that have an incorrect
media registration, for example cutting, booklet making or folding. To correct the media
registration of the front side touch [Describe front side]. For the back side, touch [Describe back
sidel.

For 1-sided media you simply have to correct the media registration of the front side. Examples of
1-sided media are tab sheets and transparency media with paper backing. For 1-sided media you
cannot use the verification chart because the verification chart is 2-sided. To perform the media
registration you must use your own image to determine the required values.

1@ NOTE

* In most cases, after automatic media registration you must only adjust the elongation and / or
the image shift.

+ If there are two or more registration problems, you must solve the problems one by one. First
you correct the registration of each side. Then you correct the front-to-back side registration.
For example, if the image is skewed and there is a problem with the front-to-back side
registration, then you must first adjust the skewed image. If the skewing is correct, you must
improve the front-to-back side registration.

L@ NOTE

If you are unable to recognize which kind of media registration deviation you have (see Example

7 - Images and Text on page 81), perform the following actions:

1. Measure the value for the skewed image, diamond shape image and trapezoid image. See
the corresponding sections.

2. Select the deviation with the largest value and correct the deviation. Use the corresponding
manual actions described in this document.

3. Print the verification chart.

4. Ifthe angles in the corners are straight then continue with the next step. If not, repeat step 1 -
3.

5. If needed, correct the image shift and / or elongation. Use the corresponding manual actions
described in this document.

Elongation

When to do

Elongation occurs in the feed direction.
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Media Registration

Job Verification chart

- B B
O O

R

<-- Feed direction

Media Registration

With elongation, the lines at the left-hand side (leading edge) of the verification chart are at the
correct position. The image is elongated / shrunk at the right-hand side (trailing edge) of the
sheet.

Procedure

1.

On the verification chart, determine if the image on the back side has an elongation or the image
on the front side.

Use the X elongation back to adjust the back side.

Use the X elongation front to adjust the front side.

On the verification chart, use an accurate ruler to measure the distance between the lines on the
+ Measure the distance between the vertical lines at the front side and the back side at the top-

For example, hold the verification chart against the light, or measure the distance between the

* Measure the distance between the vertical lines at the front side and the back side at the

Calculate this average value as a percentage of the media size in the feed direction.

2.
front side and the back side at the right-hand side of the sheet.
right corner.
line and the edge of the sheet on the front side and the back side.
bottom-right corner.
« Calculate the average value.
3.
For example: 1 mm is 0.48% of 210 mm (0.04" is 0.48% of 8.27").
4. Enter the value according to the table below.
5. Confirm the changed value.
6.

Print the verification chart again and verify if the media registration is optimal.
If the media registration is not optimal, change the value or use another setting depending on
how the registration looks.

Values for the Media Registration
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Values for the Media Registration

Settings front side What to enter

X elongation (0.01%) The image is elongated or shrunk in incre-
A=+ ments of 0.01%.
% A value > 0 elongates the image by moving the

trailing edge of the image to the right:

* The length of the image in the feed direction
increases.

» The distance between the leading edge of
the sheet and the image on the sheet re-
mains the same.

* The circles on the right-hand side of the ver-
ification chart move to the right (trailing
edge).

A value < 0 shrinks the image by moving the

trailing edge of the image to the left:

» The length of the image in the feed direction
decreases.

» The distance between the leading edge of
the sheet and the image on the sheet re-
mains the same.

* The circles on the right-hand side of the ver-
ification chart move to the left (leading

edge).
Settings back side What to enter
X elongation (0.01%) The image is elongated or shrunk in incre-
+ ments of 0.01%.
A value > 0 elongates the image by moving the

trailing edge of the image to the right:

* The length of the image in the feed direction
increases.

« The distance between the leading edge of
the sheet and the image on the sheet re-
mains the same.

* The dots on the right-hand side of the verifi-
cation chart move to the right (trailing
edge).

A value < 0 shrinks the image by moving the

trailing edge of the image to the left:

» The length of the image in the feed direction
decreases.

« The distance between the leading edge of
the sheet and the image on the sheet re-
mains the same.

* The dots on the right-hand side of the verifi-
cation chart move to the left (leading edge).

Ranges
X elongation (0.01%) -500 to +500
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Shifted Image

NOTE

If the elongation is too great, the image can become larger than the sheet. In this case the image
is printed over the edges of the sheet.

+ Risk of reprinting.

» Risk of system pollution.

Shifted Image

When to do

The image is shifted in the X direction (feed direction) and/or in the Z direction (perpendicular to
the feed direction).

Job Verification chart
O O

- o -

O o -
R B

<-- Feed direction

Media Registration
With an image shift, all corners are shifted in the same direction. We assume that the skew is

correct.

Procedure

1. On the verification chart, determine if the image on the back side is shifted or the image on the
front side.
Change the back side if the image on the back side is shifted.
Change the front side if the image on the front side is shifted.

2. On the verification chart, use an accurate ruler to measure the distance that the image is shifted
in the feed direction (X) and in the direction perpendicular to the feed direction (Z).
* Measure the distance between the top-left corner on the front side and the back side in the

feed direction.

* Measure the distance for all the corners in the feed direction.
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Values for the Media Registration

« Measure the distance for all the corners in the direction perpendicular to the feed direction.
+ Calculate the average value in the feed direction (X) and the average value in the direction
perpendicular to the feed direction (Z).
Enter the values according to the table below.
Confirm the changed values.
5. Print the verification chart again and verify if the media registration is optimal.
If the media registration is not optimal, change the value or use another setting depending on
how the registration looks.

~ W

Values for the Media Registration

Settings front side What to enter

[X offset ({0})] The image is shifted in X direction (feed direc-
A= tion) in mm (inches).
- % + A shift > 0 moves the image to the right-hand

side (trailing edge):

» The distance between the leading edge of
the sheet and the image on the sheet increa-
ses.

» The distance between the trailing edge of
the sheet and the image on the sheet de-
creases.

* The circles on the verification chart move to
the right-hand side (trailing edge).

A shift < 0 moves the image to the left-hand

side (leading edge):

+ The distance between the leading edge of
the sheet and the image on the sheet de-
creases.

» The distance between the trailing edge of
the sheet and the image on the sheet increa-
ses.

» The circles on the verification chart move to
the left-hand side (leading edge).

[Z offset ({0})] The image is shifted in Z direction (perpendic-

ular on the feed direction) in mm (inches).

A shift > 0 moves the image to the top of the

sheet:

+ The distance between the top of the sheet
and the image on the sheet decreases.

» The circles on the verification chart move to
the top of the sheet.

' A@'HHﬁT\ .

A shift < 0 moves the image to the bottom of

the sheet:

» The distance between the top of the sheet
and the image on the sheet increases.

* The circles on the verification chart move to
the bottom of the sheet.
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Values for the Media Registration

Settings back side What to enter

[X offset ({0})] The image is shifted in X direction (feed direc-
tion) in mm (inches).

+ A shift > 0 moves the image to the right-hand
side (trailing edge):

» The distance between the leading edge of
the sheet and the image on the sheet increa-
ses.

* The distance between the trailing edge of
the sheet and the image on the sheet de-
creases.

* The dots on the verification chart move to
the right-hand side (trailing edge).

(il
(i

A shift < 0 moves the image to the left-hand

side (leading edge):

» The distance between the leading edge of
the sheet and the image on the sheet de-
creases.

* The distance between the trailing edge of
the sheet and the image on the sheet increa-
ses.

* The dots on the verification chart move to
the left-hand side (leading edge).

[Z offset ({0})] The image is shifted in Z direction (perpendic-
+ ular on the feed direction) in mm (inches).

A shift > 0 moves the image to the top of the

== sheet:

= » The distance between the top of the sheet
and the image on the sheet decreases.

* The dots on the verification chart move to
the top of the sheet.

B=

A shift < 0 moves the image to the bottom of

the sheet:

* The distance between the top of the sheet
and the image on the sheet increases.

* The dots on the verification chart move to
the bottom of the sheet.

Ranges

[X offset ({0})] -5.0 to +5.0 -0.197 to +0.197
[Z offset ({0})] -2.5to +2.5 -0.098 to +0.098

NOTE

If the shift is too much, the image be printed over the edges of the sheet.
 Risk of reprinting.

* Risk of system pollution.
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Trapezoid Shape Image

Trapezoid Shape Image

When to do

The trapezoid shape is perpendicular to the feed direction.

Job Verification chart
= 5 N
[~ ~]

1+ 90-80-6L02 =

O O -

< b

N
N | 7]
<-- Feed direction

Media Registration

Procedure

1. On the verification chart, determine if the image on the back side has a trapezoid image or the
image on the front side.
If the trapezoid image is on the back side, change the back side.
If the trapezoid image is on the front side, change the front side.
2. On the verification chart, use an accurate ruler to measure the distance between the corners of
the image at the bottom of the sheet and at the top of the sheet.
* Measure the distance between the bottom-left corner and the bottom-right corner. b in the
figure above.
E.g. the distance between the corners is 190.8 mm (7.51").
* Measure the distance between the top-left corner and the top-right corner. a in the figure
above.
E.g. the distance between the corners is 191.3 mm (7.53").
+ Determine the difference between the distance measured at the bottom and the distance
measured at the top. b - a.
In the example the measured difference is -0.5 mm (-0.02").
Enter the measured difference according to the table below.
Confirm the changed value.
5. Print the verification chart again and verify if the media registration is optimal.

Eall
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Values for the Media Registration

If the media registration is not optimal, change the value or use another setting depending on
how the registration looks.

Values for the Media Registration

Settings front side What to enter

[Trapezoid ({0})] The image is adjusted in mm (inches).
- Measured difference > 0:
+ At the bottom of the sheet, the length of the
+ image in the feed direction decreases.
* The distance between the circles at the bot-
tom of the verification chart decreases.

Measured difference < 0:

* At the top of the sheet, the length of the im-
age in the feed direction decreases.

* The distance between the circles at the top
of the verification chart decreases.

[Trapezoid ({0})] The image is adjusted in mm (inches).
_ _ Measured difference > 0:
+ At the bottom of the sheet, the length of the
+ + image in the feed direction decreases.

* The distance between the dots at the bottom
of the verification chart decreases.

Measured difference < 0:

+ At the top of the sheet, the length of the im-
age in the feed direction decreases.

» The distance between the dots at the top of
the verification chart decreases.

Ranges
[Trapezoid ({0})] -2.5t0 +2.5 -0.098 to +0.098

Diamond Shape Image

When to do

The diamond shape is perpendicular to the feed direction. You can measure the diamond shape
via the diagonal of the image.
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Media Registration via the Diagonal of the Image

<-- Feed direction
Media Registration via the Diagonal of the Image

Procedure

1. On the verification chart, determine if the image on the back side has a diamond shape or the
image on the front side.
If the diamond shape is on the back side, change the back side.
If the diamond shape is on the front side, change the front side.
2. On the verification chart, use an accurate ruler to measure the distance between:
* The top-right corner and the bottom-left corner. a in the figure above.
For example, the distance is 336.0 mm (13.23").
* The top-left corner and the bottom-right corner. b in the figure above.
For example, the distance is 335.0 mm (13.19").
3. Determine the difference between the second value measured and the first value measured. b - a.
In the example, the measured difference is -1.0 mm (-0.04").
Enter the measured difference according to the table below.
Confirm the changed values.
6. Print the verification chart again and verify if the media registration is optimal.
If the media registration is not optimal, change the value or use another setting depending on
how the registration looks.

o &
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Values for the Media Registration via the Diagonal of the Image

Values for the Media Registration via the Diagonal of the Image

Settings front side What to enter

Diamond The image is adjusted in mm (inches).
+ Adjustment > 0:

* The diagonal from the top-right corner of
the image to the bottom-left corner of the
image increases.

* The distance between the circle at the top-
right corner and the circle at the bottom-left
corner increases.

* The diagonal from the top-left corner of the
image to the bottom-right corner of the im-
age decreases.

* The distance between the circle at the top-
left corner and the circle at the bottom-right
corner decreases.

Adjustment < 0:

* The diagonal from the top-right corner of
the image to the bottom-left corner of the
image decreases.

* The distance between the circle at the top-
right corner and the circle at the bottom-left
corner decreases.

* The diagonal from the top-left corner of the
image to the bottom-right corner of the im-
age increases.

* The distance between the circle at the top-
left corner and the circle at the bottom-right
corner increases.
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Skewed Image

Settings back side What to enter

Diamond The image is adjusted in mm (inches).
- + Adjustment > 0:
» The diagonal from the top-right corner of
the image to the bottom-left corner of the

image increases.

« The distance between the dot at the top-
right corner and the dot at the bottom-left
corner increases.

* The diagonal from the top-left corner of the
image to the bottom-right corner of the im-
age decreases.

» The distance between the dot at the top-left
corner and the dot at the bottom-right cor-
ner decreases.

Adjustment < 0:

* The diagonal from the top-right corner of
the image to the bottom-left corner of the
image decreases.

» The distance between the dot at the top-
right corner and the dot at the bottom-left
corner decreases.

+ The diagonal from the top-left corner of the
image to the bottom-right corner of the im-
age increases.

» The distance between the circle at the top-
left corner and the circle at the bottom-right
corner increases.

Ranges
Diamond -2.5t0 +2.5 -0.098 to +0.098

Skewed Image

When to do

The image is skewed (rotated) on the front side and/or on the back side.
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Media Registration

Job Verification chart

O -
]

@)
JAY
N

<-- Feed direction

Media Registration

Procedure

1.

o~

On the verification chart, determine if the image on the back side is skewed or the image on the
front side.
If the image on the back side is skewed, change the back side.
If the image on the front side is skewed, change the front side.
On the verification chart, use an accurate ruler to measure the distance between:
» The leading edge of the sheet and the top-left corner. a in the figure above.
For example, the distance is 10.3 mm (0.40").
» The leading edge of the sheet and the bottom-left corner. b in the figure above.
For example, the distance is 9.5 mm (0.37").
Determine the difference between the value measured at the bottom and the value measured at
the top. b - a. This is the skew (rotation).
In the example, the measured skew is -0.8 mm (-0.03").
Enter the value according to the table below.
Confirm the changed value.
Print the verification chart again and verify if the media registration is optimal.
If the media registration is not optimal, change the value or use another setting depending on
how the registration looks.
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Values for the Media Registration

Values for the Media Registration

Settings front side What to enter

Skew The image is rotated in mm (inches).
+ Adjustment > 0:
» The image is rotated clockwise.
= » The distance between the leading edge of
the sheet and the circle at the top-left corner
is increased.

» The distance between the leading edge of
the sheet and the circle at the bottom-left
corner is decreased.

Adjustment < 0:

» The image is rotated counter-clockwise.

» The distance between the leading edge of
the sheet and the circle at the top-left corner
is decreased.

» The distance between the leading edge of
the sheet and the circle at the bottom-left
corner is increased.

Skew The image is rotated in mm (inches).
Adjustment > 0:
» The image is rotated clockwise.
- » The distance between the leading edge of
the sheet and the dot at the top-left corner is
increased.

» The distance between the leading edge of
the sheet and the dot at the bottom-left cor-
ner is decreased.

Adjustment < 0:

* The image is rotated counter-clockwise.

« The distance between the leading edge of
the sheet and the dot at the top-left corner is
decreased.

» The distance between the leading edge of
the sheet and the dot at the bottom-left cor-
ner is increased.

Ranges
Skew -2.51t0 +2.5 -0.098 to +0.098

Front-to-Back Side Registration

Introduction

When the front-to-back side registration is not satisfactory:
+ Correct the front side registration.
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Media Registration

» Correct the back side registration.
Job Verification chart

L lonl AP3W e

* czse

O O
N

Media Registration

Before you begin

To correct the front-to-back side registration, you must first get one side correct and then shift the
other side in such a way that the front-to-back registration is correct.

Procedure

1. If the verification chart displays a trapezoid image, a diamond shape or skew, use the

corresponding manual actions described in this document to correct the registration.

Correct the image shift to adjust the front-to-back side registration.

3. If the image is elongated / shrunk, use the corresponding manual actions described in this
document to correct the registration.

4. Print the verification chart again and verify if the media registration is optimal.
If the media registration is not optimal, change the value or use another setting depending on
how the registration looks.

N
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Via the Settings Editor

Via the Settings Editor

Before you begin

NOTE

It is not preferred to perform the manual media registration via the Settings Editor. The
manual media registration via the control panel is preferred because you can print the

verification chart immediately after you changed a setting.

* The media specific registration adjustment overwrites any automatic or manual media specific

registration performed previously.

Print the verification chart to verify the media registration.

1.
2.
3.

o

Start the Settings Editor application.
Click [Media] to open the media catalog.
Select the media from the media catalog for which you want to perform the media
registration.
Click [Registration].
When you are not logged in, the login screen appears.
Enter the username and password to start the registration.
Select for which feed direction you to perform the media registration.
Enter the required values. The sections related to the manual media registration via the
control panel (see Via the Control Panel on page 96) describe how to determine the values
you must enter. Only the [Corrections for preprinted medial are not available on the control
panel. These settings are described in this section.
For 1-sided media you simply have to correct the media registration of the front side.
Examples of 1-sided media are tab sheets and transparency media with paper backing. For 1-
sided media you cannot use the verification chart because the verification chart is 2-sided. To
perform the media registration you must use your own image to determine the required
values.
Possible settings, as displayed in the Settings Editor:
* Actual sheet size
» Registration front side

» Trapezoid

» Diamond

+ Skew

+ Xelongation (0.01%)

« X offset

« Z offset
* Registration back side

e Trapezoid

+ Diamond

» Skew

+ X elongation (0.01%)

» X offset

» Z offset
» Corrections for preprinted media (see Corrections for Preprinted Media on page 114)

+ [Ximage shift front ({0})]

» [Ximage shift back ({0})]

* [Z image shift front ({0})]

* [Z image shift back ({0})]
When the media registration is ready, the £ icon appears behind the media registered.
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Corrections for Preprinted Media

NOTE

* In most cases, after automatic media registration you must only adjust the elongation and / or
the image shift.

+ If there are two or more registration problems, you must solve the problems one by one. First
you correct the registration of each side. Then you correct the front-to-back side registration.
For example, if the image is skewed and there is a problem with the front-to-back side
registration, then you must first adjust the skewed image. If the skewing is correct, you must
improve the front-to-back side registration.

NOTE

If you are unable to recognize which kind of media registration deviation you have (see Example

7-Images and Text on page 81), perform the following actions:

1. Measure the value for the skewed image, diamond shape image and trapezoid image. See
the corresponding sections.

2. Select the deviation with the largest value and correct the deviation. Use the corresponding
manual actions described in this document.

3. Print the verification chart.

4. Ifthe angles in the corners are straight then continue with the next step. If not, repeat step 1 -
3.

5. If needed, correct the image shift and / or elongation. Use the corresponding manual actions
described in this document.

Corrections for Preprinted Media

Introduction

When you use preprinted media, there is a possibility that the image is not at the correct position,
even when the media registration is correct. For example, it is possible that a preprinted line
along an edge of the media covers part of the printed image. In that case you can perform an
image shift for all the jobs that are printed on this media.

Procedure

Print a representative job on the preprinted media.

Measure the distance that the image must shift for the front side and the back side.

In the section [Corrections for preprinted media] enter the values according to the table below.
Click [OK].

Print the job again and check if the image is printed at the correct position.

Settings front side What to enter

[X image shift front ({0})] The image is shifted in X direction (feed direc-
tion) in steps of 0.1 mm (0.001 inches).

Ll S

Values

[Z image shift front ({0})] The image is shifted in Z direction (perpendic-
ular to the feed direction) in steps of 0.1 mm
(0.001 inches).

Settings back side What to enter

[X image shift back ({0})] The image is shifted in X direction (feed direc-
tion) in steps of 0.1 mm (0.001 inches).
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Values

[Z image shift back ({0})] The image is shifted in Z direction (perpendic-
ular to the feed direction) in steps of 0.1 mm
(0.001 inches).

Ranges
[X image shift front ({0})] -500 to +500 -1969 to +1969
[X image shift back ({0})] -500 to +500 -1969 to +1969
[Z image shift front ({0})] -500 to +500 -1969 to +1969
[Z image shift back ({0})] -500 to +500 -1969 to +1969
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Media registration: Troubleshooting

Media registration: Troubleshooting
Introduction

When you perform media registration some issues can occur. This section gives an overview of
known issues and what to do.

Registration of Preprinted Media Fails

Issue
The registration of preprinted media fails.

Cause
When the registration sheet contains more information than expected, the scanner has difficulties
to perform the measurements.

Solution

* Perform a manual media registration on the preprinted media.

* Perform an automatic media registration on the same media without the preprinted
information.

» Perform an automatic media registration on a media similar to the preprinted media. The
similar media must not contain any preprinted information.
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Automatic Media Registration of Long Sheets is not satisfactory

Automatic Media Registration of Long Sheets is not satisfactory

Issue
The result of an automatic media registration on sheets longer than 420 mm (16.5") is not
satisfactory.

Cause
The automatic media registration cannot handle sheets longer than 420 mm (16.5"). The
automatic media registration assumes the nominal sheet length of the media.

Solution

Measure the actual sheet length and enter this value via the manual media registration.

Actual sheet size

Length (mm)

X offeet (mm)

Z offset (mm)

Assumed default output orientation:
~Face down Describe back side
~Header up

Apply changes/print chart Apply Close

Chapter 5 - Media Handling 117
Canon varioPRINT 135 Series



Shifted Image after Paper Path Registration (Only if POC is Applicable)

Shifted Image after Paper Path Registration (Only if POC is Applicable)

Issue

After you performed the paper path registration the image can be shifted in X direction (feed
direction). This offset occurs mainly when you use A4 or Letter for the paper path registration.

Cause

Possible causes:

+ The bulk media has media registration settings from a previous media registration setting.

+ The sheet length of the bulk media differs from the nominal sheet length for this media.

* The paper path registration for A3/Ledger was performed before the paper path registration for
Ad/Letter.

» The printer is not sufficiently warmed-up. The mentioned offset in X direction (feed direction) is
related to the temperature of the environment and how much the printer is warmed up.

Solution

Perform one or more of the following actions depending on the possible cause:

+ Set the media specific registration settings of the bulk media to 0. Perform the paper path
registration again.

* Enter the actual measured sheet length of the bulk media via the manual media registration
adjustment.

» First perform the paper path registration for A4/Letter and after that perform the paper path
registration for A3/ledger.

« Make sure that the printer is warmed up. The printer must have printed for at least 20 minutes.
Perform the paper path registration again.

* Perform a manual media registration adjustment for the bulk media.
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Media Registration: Frequently Asked Questions

Media Registration: Frequently Asked Questions

Introduction

In this section you find answers to some frequently asked questions regarding media registration.

What should you do after a software
update?

What should you do after you copied
the media catalog?

How do you perform a media regis-
tration for temporary media?

How do you perform a media regis-
tration of 1-sided media? Examples
of 1-sided media are tab sheets and
transparency media with paper back-
ing.

After a service technician upgraded the software you
must verify the media registration. You can print the ver-
ification chart to verify if the media registration is opti-
mal (see Print the Verification Chart for Media Registra-
tion on page 89).

When you copy the media catalogue from one printer to
another printer you must verify the media registration.
You can print the verification chart to verify if the media
registration is optimal (see Print the Verification Chart
for Media Registration on page 89). The media registra-
tion depends on the printer and on the media.

You cannot perform media specific registration for tem-
porary media. First add the temporary media to the me-
dia catalog. Next, perform the media registration for the
selected media.

You must perform a manual media registration. You
cannot perform the automatic adjustment for media that
you can only print 1-sided, because the adjustment pro-
cedure prints 2-sided registration sheets.

You cannot print the verification chart for 1-sided media
because the verification chart is 2-sided. Use your own
job to determine the required values and to verify the
media registration.

Canon varioPRINT 135 Series

Chapter 5 - Media Handling 119



Media Registration: Frequently Asked Questions
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The Print Function

The Print Function

Where to Define Print Job Settings

Introduction

Where to Define Print Job Settings

Print jobs can vary from straightforward jobs with only a few settings to complex jobs with
extended settings. Therefore, there are several possibilities to define the settings for your print
jobs. For straightforward jobs, the use of the printer driver can be fine. If you often print recurring
jobs with identical, complex settings, the use of automated workflows or hotfolders can be the
best way to print your jobs. This section gives an overview of various possibilities.

Z@ NOTE

It is strongly recommended to define the settings for a print job in only one place, for example in
a printer driver or in an automated workflow, but not in both. Otherwise, undesired output
results can occur because settings can become mixed.

Define the job settings

hom S ipion

PDL settings

Job ticket

Hotfolder

Automated workflow

The job will be printed using either

» the PDL default settings as defined in the Settings Editor, or

» the PDL settings that were defined in a job itself, as interpreted
by the PDL.

The job will be printed using the settings that were defined in the
printer driver.

When you frequently print jobs with identical settings, you can use
the template function of the printer driver. Templates contain pre-
defined job settings. You can also create your own custom tem-
plates.

Hotfolders are primarily aimed at recurring print workflows. In
these workflows, identical PDFs or other printable files with identi-
cal settings are printed on a regular basis. The advantage of a hot-
folder is that you do not have to open a file and check the settings
before printing.

Operators can see hotfolders as a folder on their workstation
where they can simply drag & drop files.

A hotfolder option is the default ticket (‘default_ticket.jdf') in a hot-
folder, which defines the settings for the print jobs. The files will
be printed according to settings of the hotfolder default ticket in
that hotfolder.

Automated workflows are LPR print queues that you can program-
med to perform a range of operations. Automated workflows are
primarily aimed at recurring print jobs with identical settings that
must be printed the same way as before. The advantage of auto-
mated workflows is that you do not have to open a file and check
the settings before printing.
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Where to Define Print Job Settings

o i

Control panel

After a print job has arrived on the PRISMAsync controller, the
print job becomes visible on the control panel. There you can
change a number of job settings or combine print jobs, for exam-
ple. It is best to change the print job settings in the list of [Waiting
jobs] or in the optional [DocBox]. With the optional [Page pro-
gramming] function, you can insert pages and define the media
and finishing settings for the page ranges in a job.

NOTE
You can only make changes to jobs that are currently
not being printed.

Canon varioPRINT 135 Series
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Print a Job Using the Printer Driver

Print a Job Using the Printer Driver

Main Features of the Printer Driver

Fenure —bspion

Settings You can define a large number of settings for layout, paper, finish-
ing and image.

Templates When you want to use a number of printer driver settings more
than one time, you can create a template. A template is a set of
default settings that describe a print job. You do not need to
change each individual setting. Simply select a template that
matches your desires.

Secure printing You can add a PIN to your job to prevent unauthorized printing of
your job.

How to Get the Latest Printer Driver

* Via the Settings Editor on the PRISMAsync controller, under [Support] -> [Software] ->
[Download printer driver].
* From the web site of the printer manufacturer.

NOTE
The online helps of the printer drivers contain detailed information about all functions of the
printer drivers.

Procedure

From the 'File' menu of your application, click 'Print'.

Select the varioPRINT 135 Series in the 'Printer’ area of the 'Print' dialog box.
Click 'Properties'.

Define the required settings.

Click 'OK."

L ol o
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Print a Job Using PRISMAprepare (Option)

Print a Job Using PRISMAprepare (Option)

Introduction

PRISMAprepare (optional) is a software application that enables you to prepare your print jobs on
page level. You can preview the result per page.

This procedure describes the most important steps for the preparation of print jobs.

NOTE
See the online help of PRISMAprepare for all the details.

Procedure

1. Prepare the document.

PRISMAprepare i | CEX
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[32] Lay out preparation with PRISMAprepare

2. Use the media catalog to define the media.
With PRISMAprepare you can export the media catalog to PRISMAsync controllers.
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Print a Job Using PRISMAprepare (Option)
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[33] The media catalog in PRISMAprepare

3. Define the required finishing options.

H
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Print a File from a USB Drive

Print a File from a USB Drive

Introduction

You can print documents (*.pdf, *.ps, *.prn, *.xps files) on a USB drive.

lllustration

USB\...t Trimmer-D1

=
= 2 folders, 2 files, 0 selected.

¢ , kL
’a‘ Back Save Select

Name

@ CcoMMON

]

Print

Date

v

D ILLUST

| p

'..EJ BOOK1.paf

02-02-2011
11:04:33

1

D BOOK1.ps

02-02-2011
11:03:55

@ Schedule & Jobs

=| Trays

%, System

[34] Example of a folder structure on the USB drive
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Print a File from a USB Drive

[35] Save a file to a different location

Procedure
1. Insert the USB drive into the USB port t the left-hand side of the control panel.
2. On the control panel, touch [Jobs] -> [USBI.
3. Touch > to browse through the directories on the USB drive.
4. Touch the file or files you want to print, or touch [Select] to select multiple files.
5. Touch [Print] to send the file to the list of [Scheduled jobs] immediately, or
6. Touch [Save] to save a copy of the file to another location on your printer such as the list of

[Waiting jobs] or a DocBox. Then you can edit the file first and print the file from the other
location
The locations you can select depend on your system configuration.

7. Remove the USB drive from the control panel when the USB LED on the control panel is off.
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Stop the Printer

Stop the Printer

Introduction

The printer can stop in two ways.
* Manually

Use the Stop button @ or the [Stop after job] button to stop the printer.
* Automatically

Define a corresponding setting in the workflow profiles.

Stop the Printer Manually

Manual stop

After a set Press the Stop « The printer stops when the currently printed set of the
button @ one active print job @ is completed.
time * The dashboard displays the [Resume] button > with a
vertical green bar, and the message [Stopping after
set...].

* When the set is completed, the vertical green bar
changes into red and the message [On hold] appears.
* Touch the [Resume] button > to continue printing.

NOTE

It depends on the set size and the moment you
press the Stop button ® when the printer will
stop. For example, when you have a large set
of 1,000 pages and you press the Stop button
@ after the first page, the printing will continue
for a couple of minutes.

As soon as possi- Press the Stop » The printer stops when the printer buffer is empty (as
ble button @ two soon as possible).
times * The dashboard displays the [Resume] button with a

vertical red bar, and the message [Stopping as soon
as possible...].

* When the printer buffer is empty, the message [On
hold] appears.

* Touch the [Resume] button > to continue printing.

NOTE

The buffer can contain up to 50 pages. Be-
cause the printer stops when the buffer is
empty, it is possible that the last printed set is
not complete.
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Stop the Printer

After a job Touch the [Stop ¢ In[Jobs]->[Queues] -> [Scheduled jobs] you must se-
after job] button lect the job after which the printer must stop. Then
touch the [Stop after job] button.
* A horizontal, red and white stop bar indicates that the
stop-after-job function is active.
* The printer stops when the last job before the stop bar
is completed.
* Touch the [Resume] button > to continue printing.

NOTE

The [Stop after job] button is not available
when the [Confirm start of job] setting in the
active [Workflow profile] is set to [On]. Then
the printer stops automatically after each job.

NOTE
When you print streaming jobs # or jobs that consist of 1 large set, you must press the Stop

button @ two times to stop the printer as soon as possible.

Automatic stop

wnn

» The [Check first set] setting in a [Workflow The printer stops each time the first set of a

profile] is [On], and print job is completed. You can check the first
» The [Check first set] setting is also enabled  set before you continue the print job.

in the job.
The [Confirm start of job] setting in a [Work- The printer stops each time at the start of a
flow profile] is [On]. new job. You must start each job manually.
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Delete Print Jobs

Delete Print Jobs

Locations where You Can Delete Print Jobs

You can delete jobs from the following locations.

» List of [Printed jobs] (if this function is enabled in the Settings Editor).
 List of [Scheduled jobs].

» List of [Waiting jobs].

* [DocBox] (optional).

NOTE
You can only delete the active print job & in the list of [Scheduled jobs] when the printer is on
hold. If necessary, press the Stop button @ two times to put the printer on hold.

Select the Jobs You Want to Delete

The table below describes your options to select one or more jobs.

Select one or more jobs that you want to delete

One or more separate jobs <+ Select the desired location described above.
* Touch the jobs one by one.

All jobs + Select the desired location.
* Touch [Select] -> [Alll.

[Jobs with available media] ¢ Select the desired location.
* Touch [Select] -> [Jobs with available medial].

[Jobs with label] » Select the desired location.
* Touch [Select] -> [Jobs with labell.

[Printed jobs] in the [Doc- » Select the [DocBox].
Box] e Touch [Select] -> [Printed jobs].

New jobs in the [DocBox] » Select the [DocBox].
* Touch [Select] -> [New jobs].

NOTE

For the list of [Printed jobs], you can indicate in the Settings Editor that the list must be cleaned
automatically at specified times. The factory default is one day. Furthermore, in the Settings
Editor you can manually clean up the jobs in the lists of [Printed jobs], [Scheduled jobs],
[Waiting jobs] and the [DocBox].

Procedure

1.

g

Go to one of the following locations.
* On the control panel, touch [Jobs] -> [Queues]
If collapsed, first touch - to expand the list of [Scheduled jobs] or [Waiting jobs].
* Touch [Jobs] -> [Printed jobs]
Select the jobs you want to delete.
Press [Deletel.
A message appears.
When you are sure that you want to delete the selected job(s), touch [Yes].
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Print Your Jobs Using the Control Panel

Print Your Jobs Using the Control Panel

Description of the Print Job Settings that You Can Change on the
Control Panel

Introduction

Usually, the settings for a print job is defined in PDLs, applications, printer drivers, automated
workflows, or hotfolder default tickets. However, when a job has arrived on the PRISMAsync
controller, you can change a number of job settings for all jobs that are currently not being
printed. This section gives an overview of the print job settings that you can change on the
control panel.

With the [Properties] button you view and partly change the job settings of the jobs in the
following queues.
» [Waiting jobs]
* [Scheduled jobs]
You cannot change the settings of an active job.
* [Printed jobs] (view settings only)

You can partly define the following settings for the jobs in the list of [Waiting jobs] and the list of
[Scheduled jobsl.

* The characteristics of the output

» Generic settings that apply to the whole job.

[T* Properties
Original (1) |[30b (3)
I
User: oceadmin | | Mumber of sets Job name Separator sheets
= Pages: 62 :
Submitted: Nov 28, 2013 11:48:39 AM 1 Mceiotcich o0t il
Duration: 0:01 Print range
Label: input (Default)
MixColourJob,pdf All

Output ‘2)

1- or 2-sided Binding edge Media Cover
3 =3 31
% E::] D ﬁ; A4E_I. 100 g/m?, TopColar,
2-sided Portrait left off it
A4 off \_
Layout | Zoom Align Shift B |
o =l i —_—
{ ] St = I
\)% v i'/ - i ——
Normal 100% Center Front: 0, 0, 0 |
Back: 0, 0,0 | |
Print delivery Margin erase Adjust image | Color /Black & white

1 < 9

Stacker/stapler lowe... Default Mixed values

Binding Folding Trimming Punching
3 B 2
A BX L
Method: None Folding: None None Punching: Mone

0K ‘ Cancel |

Page
@ programming
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Description of the Print Job Settings that You Can Change on the Control Panel

fmbor e bmpion

1

[1- or 2-sided]

[Originall

[Output]

[Jobs]

Preview

Action buttons

The [Originall pane shows the settings you can de-
fine for the paper originals

The [Output] pane shows the generic settings you
can define for the whole job

The [Jobs] pane shows the settings you can define
for the job

The preview displays the settings you defined for
the output.

The action buttons indicate the actions you can car-
ry out.

With the optional [Page programming] function,
you can insert pages and define the media and fin-
ishing settings for the page ranges in a job.

Soing s omaien

[1- or 2-sided]

i

=
&,
o
@

o

[2-sided]

The output contains an image on one side.

The output contains an image on both sides.

Canon varioPRINT 135 Series
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Description of the Print Job Settings that You Can Change on the Control Panel

[Binding edgel

Soing ——awes —Dmein

[Binding edgel = * The original has a vertical format (height >
|:::| width).
+ The binding edge is at the left-hand side.
[Portrait left] « When you turn a sheet over the binding

edge, the image or text on the back of the
sheet is in readable form.

[—l * The original has a vertical format (height >
[j width).

* The binding edge is at the top.
[Portrait top] « When you turn a sheet over the binding
edge, the image or text on the back of the
sheet is in readable form.

* The original has a horizontal format (width >
[ &3 height).

« The binding edge of the original is at the
[Landscape left] left-hand side.
* When you turn a sheet over the binding
edge, the image or text on the back of the
sheet is in readable form.

| * The original has a horizontal format (width >
"l height).
* The binding edge of the original is at the
[Landscape top] top.

* When you turn a sheet over the binding
edge, the image or text on the back side of
the sheet is in readable form.

[Medial

Soing oo Dmein

Names of the media in Here you can select the media for the job. The
the media catalogue list displays all the media that are available in

the media catalog including the temporary me-
[Media] dia. The media catalog is a list of media that
you can define in the Settings Editor.

NOTE

You can only change to media with
the same size, for example, from A4
blue to A4 green.
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Description of the Print Job Settings that You Can Change on the Control Panel

[Cover]

Soing ———Naws —owapin

[Coverl] mﬁ]

[Front]
[Medial

[Print sides]

[Back]
[Medial]

[Print sides]

Touch the button to toggle between [On] and
[Off]l. When [Front] is [On] then the [Media]
setting below [Front] becomes enabled.

When [Front] is [On], you can select a media
from the media catalog to use as front cover.

When [Front] is [On], you can indicate which
side of the front cover must be printed. You
can select.

» [Both sides]

* [Front side]

» [Back side]

* [Nonel

Touch the button to toggle between [On] and
[Offl. When [Back] is [On] then the [Media] set-
ting below [Back] becomes enabled.

When [Back] is [On], you can select a media
from the media catalogue to use as back cover.

When [Back] is [On], you can indicate which
side of the back cover must be printed. You
can select:

» [Both sides]

* [Front side]

» [Back side]

* [Nonel
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Description of the Print Job Settings that You Can Change on the Control Panel

[Layout]
[Layout] B= The printer prints the pages with no special
§ layout settings.
[Normal]
p- The printer prints the pages in booklet order.
E = The pages 1 and 4 are printed on the front side
of a sheet. The pages 2 and 3 are printed on
[Booklet] the back side of a sheet.
B5; The printer prints the same image 2, 4, 6, 9 or
E_l 16 times on 1 side of a sheet. By default, the
— system keeps the size of the originals. If neces-
[Same up] sary, use the Zoom function to reduce or en-
large the size of the images.
B The machine prints 2, 4, 6, 9 or 16 consecutive
=1 . .
=5 images on 1 side of a sheet. By default, the
— _ system keeps the size of the originals. If neces-
[Multiple up] sary, use the Zoom function to reduce or en-
large the size of the images.
[Same-up flipped] The printer prints the same image on 1 side of
a sheet. The images are rotated compared to
each other. By default, the system keeps the
size of the originals. If necessary, use the
Zoom function to reduce or enlarge the size of
the images.
[Zoom]

[Zoom] [Fit to pagel When [Fit to page] is [On], the image is resized
so it fits onto the page.
When [Fit to page] is [Off], the original size of
the image is maintained.

[Percent] Use the + and - buttons to reduce or enlarge
the size of the image (from 25% to 400%). The
preview pane immediately shows the results
of your action.
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[Align]

Soing ———Naws —owain

[Align] ‘K

[Top left]

ﬁ}

[Top center]

A

[Top right]

&

[Center left]

i
AR

[Center]

<

[Center right]

54

[Bottom left]

¥

[Bottom center]

|

[Bottom right]

An image on a sheet may be smaller than the
media size of the output, for example because
you scaled the image to 70% of its original
size. The [Align] setting allows you to indicate
the position of the image on the sheet. [Top
left] moves the image to the upper left corner
of the sheet.

[Top center] moves the image to the center at
the top of the sheet.

[Top right] moves the image to the upper right
corner of the sheet.

[Center left] moves the image to center of the
left side of the sheet.

[Center] moves the image to the center of the
sheet.

[Center right] moves the image to the center of
the right side of the sheet.

[Bottom left] moves the image to the lower left
corner of the sheet.

[Bottom center] moves the image to the center
of the bottom side of the sheet.

[Bottom right] moves the image to the lower
right corner of the sheet.

Canon varioPRINT 135 Series
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[Shift]

Soing s owain

[Shift] [Margin shift]

[Image shift]

Use this setting to increase or decrease the
margin. By default, the values of the front side
and the back side are interlocked. This means
that the values for the front side and the back
side remain identical.

Widening the margin can be useful if you want
to staple or punch the output, for example.
Narrowing the margin can be useful if you do
not need additional space for stapling or
punching the output, for example.

By default, the front side and the back side are
linked i. Then the image on both sides will be
shifted the same amount. Touch i to terminate
the link and shift each side individually.

Use this setting to shift the image horizontally
or vertically. By default, the values of the front
side and the back side are interlocked. This
means that the values for the front side and
the back side remain identical.

By default, the front side and the back side are
linked . Then the image on both sides will be
shifted the same amount. Touch i to terminate
the link and shift each side individually.
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[Print delivery]

Soing s owaien

[Print delivery] 1 [Output location] Select the output location for the job. Depend-
ing on the settings for your copy job, the ma-
chine automatically suggests the preferred
output location for your job. However, you can
manually overrule this suggestion.

» [Stacker/stapler upper trayl
Deliver the prints at the upper tray of the
stacker/stapler.

 [Stacker/stapler lower tray]
Deliver the prints at the lower tray of the
stacker/stapler.

» [Stacker/stapler booklet tray]
Deliver the prints at the booklet tray of the
stacker/stapler.

» [Folder main tray]
Deliver the folded prints to the tray at the
bottom of the folder.

[Sort]
1j1j1
[By pagel
The output is sorted by page.
[
123
[By set]
The output is sorted by set.

[Offset stacking] This setting is only available when the [Offset
stacking] setting is set to [Sets (as in job)] in
the workflow profile.

"

_=

—

p— =
[Each set]
Each set delivered to an output location will
have a small shift on top of the previous set.
This makes it easier to recognize individual
sets.

=

==

=

[—
[Off]
All the sets or jobs that get to an output loca-
tion are stacked in a straight stack.

[Advanced settings] It may only be necessary to change the ad-

vanced settings when an offline finisher pro-
cesses sheets in a non-standard way. Please
refer to the finisher manuals for more informa-
tion.
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Soimg s o

[Print delivery] 2

[Sheet order]

[Sheet orientation]

=

123
[Face upl
Deliver the prints face up, first sheet on top.

W
N
-

[Face up reverse]
Deliver the prints face up, last sheet on top.

=

12

[Face down]
Deliver the prints face down, first sheet on top.

321

[Face down reverse]
Deliver the prints face down, last sheet on top.

=

1+

[Header up LEF]
Deliver the prints with the header on top side
and in portrait position (vertical).

D

[Header up SEF]
Deliver the prints with the header on top side
and in landscape position (horizontal).

¥

[Header down LEF]
Deliver the prints with the header at the bot-
tom side and in portrait position (vertical).

&

[Header down SEF]

Deliver the prints with the header at the bot-
tom side and in landscape position (horizon-
tal).
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Soivg s omaien

[Print delivery] 3 [Print order] « [Front/back]
Default value. The front page on the front,
the back page on the back.
» [Back/front]
Puts the front page on the back and the back
page on the front.

[Rotation] - [0 degrees]
« [180 degrees]
Rotates the prints 180 degrees.

[Print quality]

[Print quality] 1 [Brightness] (default When your prints are too dark or too light,
0) changing the brightness can correct this prob-
lem.

-1 to -3 creates darker prints.
+1 to +3 creates lighter prints.

[Contrast] (default 0)  When the difference between light and dark
areas of a print is not big enough, you can
change the contrast to correct this problem.
Example: When a blue text is displayed ras-
tered, you can increase the contrast to make
the text more black and sharper.

[Advanced settings] The advanced settings are intended for special
print jobs, such as printing bar codes or print-
ing a color image on a B/W printer.

[Fattening] (default The fattening function can increase the reada-
[Off]) bility of texts with small fonts (< 6 points, 6/72
inch).

However, when you print special data such as
bar codes, fattening can make bar codes diffi-
cult to read. Therefore, you can turn the fatten-
ing function off when you print such special

data.
[Minimum line width] The minimum line width function is required
(default [On]) to keep thin lines visible. The lines in PS/PDF
jobs always keep a minimum width of 1/600
inch.

However, when you print special data such as
CAD drawings, smaller lines may be required.
Therefore, you can turn the minimum line
width function off. Then even thinner lines will
be printed.
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Soimg s omaien

[Print quality] 2 [RIP resolution] (de- The RIP resolution can improve the readability
fault [600x2400] dpi) of fine details. When you print very thin, slan-
ted lines, for example in Chinese characters,
1200x1200 gives the best result. 600x2400 is
best suited for mainly horizontal and vertical
objects.

[RIP raster] (default The default raster is [LINE_200LPI]. This is best

[LINE_200LPI]) suited for over 95% of all prints. In special ca-
ses, for example moiré patterns from scanned
images, you can try to improve the print result
with the [DOT_200LPI] raster or even the
[DOT_125LPI] raster. However, then you may
loose some fine details.
The raster screen for PS/PDF jobs is
[LINE_200LPI]. All raster screens are compati-
ble with resolutions of 600x2400 dpi and
1200x1200 dpi.

[Color profile] (default You can use color profiles when you print col-
[Normal]) or images on a B&W printer. The selected col-
or profile determines how a color image is re-
produced in black and white.
» [Enhanced] is a color profile developed by
Océ that converts CMYK or RGB data into
different gray values in a contrast-balanced
way. When you select [Enhanced], the im-
ages will become lighter, softer and less
contrast-rich.
* [Normal] is a color profile developed by
Adobe® that converts color data into gray
values. When you select [Normal], the im-
ages will become darker and more contrast-
rich.

NOTE

You can also use your own color
profiles. Make the required settings
in the Settings Editor.
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Description of the Print Job Settings that You Can Change on the Control Panel

[Binding]

Soing Ve omaien

[Binding]

[Folding]

[None]

(2=
[1 staple]

=
(&=

[2 staples]

[Saddle stitching]

Here you can define the required number of sta-

ples. Furthermore you can define where you want

the staples with the [Location] option.
The available locations for one staple:
o [Top left]

* [Top right]

» [Bottom left]

+ [Bottom right]

The available locations for two staples:
« [Left edgel

* [Top edgel

« [Bottom edge]

* [Right edgel

Check the preview for the result of the selection.

This option is only available when you have a folding unit connected.

Canon varioPRINT 135 Series
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Description of the Print Job Settings that You Can Change on the Control Panel

[Folding] F
'~

[None]
Required output location for Z-folded A4R, Let-
terR and Legal:
* Folder output tray, or
* Any output tray of the stacker/stapler.
[Z-fold] NOTE

Z-folded A3, B4 and Tabloid 11" x 17"
sheets must be sent to the stacker/
stapler.

Required output location for Z-folded A3, B4
and Tabloid 11" x 17": Any output tray of the
stacker/stapler.

[Z-fold large sheets
only]

Required output location: Folder output tray

[Tri-fold in]

Required output location: Folder output tray

[Tri-fold out]

Required output location: Folder output tray

[Parallel fold]

[Print method] Use the [Print method] option to define on
which side to print:
* [Print inside]
 [Print outside]

Check the preview for the result of the selec-
tion.

[Trimming]

This option is only available when you have a trimming unit connected.
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Soing s Dmeion

[Trimming] [Nonel No trimming of the document.
-1 b You can indicate the amount of trimming at
. the long edge and short edge (from 2.0 mm to
' 20.0 mm /0.08" - 0.80")
[Trim size]
You can indicate the size of the resulting docu-

ment after trimming. You can either touch
[Size] to select a default media size or manual-
[Finishing sizel ly define the width and length of the docu-
ment. When you define a non-standard media
size, the [Size] box displays [Custom].

[Punching]

This option is only available when you have a punching unit connected.

Soing ————Nawsomapin

[Punching] ,—| Here you can select the required number and

: the location of the punch holes.
i Location:

[None] . [Left]
- * [Topl

 [Right]

— * [Bottom]

[2 holes]

[3 holes]

LA A Rl

[4 holes]

*44 e

[Die set dependent]
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[Number of sets]

Soing ——awes —Dmepin

[Number of sets] [Check first set] When the [Check first set] setting is enabled,
the printer stops after the first set of a job has
been printed. You can check the quality of the

output.
NOTE
This setting is only available when in
the workflow profile [Check first set]
is set to [As in job].
[Number of sets] You can indicate how many copies of the job

you need. You can enter a value from 1 -
65,000. The default value is 1.

Job Name
Soting Vs Despion
[Job namel To identify your job more easily, you can change

the name of the job. When you touch the [Job
name] button a keyboard appears. Then you can
change the name of the job.

[Page range]

Soing ———awes —Dmeion

[Page rangel [All] When [All] is selected, all pages of the job will
be printed.
[Page rangel When [Page range] is selected, use the [From]

and [To] fields to indicate the first and last pa-
ges you want printed.

[Separator sheets]

[Separator sheets] [On] When the [Separator sheets] setting is ena-
bled, a separate sheet is inserted automatically
before each set of a job to create a clear dis-
tinction between two sets. Separator sheets
are always empty. In the Settings Editor, select
a media from the media catalog use as separa-
tor sheets. You can also indicate the feed di-
rection of the separator sheets (long-edge feed
or short-edge feed).

[Off] No separator sheet will be inserted before
each set.
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Schedule a Waiting Job for Printing

Introduction

The selected workflow determines the destination of jobs. When jobs go to the list of [Waiting
jobs], you must manually send the jobs to the print queue (list of [Scheduled jobs]). This enables
you to keep full control of all jobs that must be printed.

Procedure

1.  On the control panel, touch [Jobs] -> [Queues].

2. If collapsed, first touch -|/to expand the desired list of [Waiting jobs].

3. Touch the job(s) you want to print, or use the [Select] button to make a selection.
To undo the multiple selection and only select one job, you must touch and hold that job for two
seconds.

4. Press [Print].
The job is moved to the bottom of the list of [Scheduled jobs].
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Print an Urgent Job Immediately

Introduction

When a job must be printed urgently, you can give that print job priority over all other print jobs.
The [Print now] button allows you to print a job immediately. When you use the [Print now]
button, the active print job @ will be paused as soon as the current set is ready.

To print a job as soon as possible but not immediately, you can use the [To top] function.

Locations of the [Print now] Button

&

The [Print now] button is available at the following locations.
« List of [Scheduled jobs].
* DocBox (optional).

NOTE

To give priority to a job in the list of [Waiting jobs], you must first touch [Print] to send the job to
the list of [Scheduled jobs]. There you can select the job and touch [Print now].

To give priority to a job in the list of [Printed jobs], you must first reprint the job. The job is sent
to the list of [Waiting jobs]. From there, you must send the job to the list of [Scheduled jobs].
There you can select the job and touch [Print now].

Procedure
1. On the control panel, touch [Jobs] -> [Queues].
2. If collapsed, first touch - to expand the list of [Scheduled jobs].
3. Touch the job which you want to print immediately.
4. Press [Print nowl].

The urgent job appears at the top of the list of [Scheduled jobs].
The active print job @ is paused as soon as the current set is ready and becomes second in the
list.
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Give Priority to a Print Job

Introduction

When you want to print a job as soon as possible, but not necessarily immediately, you must use
the [To top] function. The [To top] function moves the selected job to the second position in the

list of [Scheduled jobs], below the active print job &. The job will be printed when the active print
job @ is ready.

Procedure

1.  On the control panel, touch [Jobs] -> [Queues].

2. If collapsed, first touch - to expand the list of [Scheduled jobs].
3. Touch the job to which you want to give priority.

4. Press [To topl.
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Print a Scheduled Job Later

Introduction

&
&

The machine prints the jobs that are present in the list of [Scheduled jobs] jobs.

However, you can decide to print a job later, for example because:
* The required media are out of stock, or
* You first want to make a proof.

Then you must move the job back to the list of [Waiting jobs].
NOTE

To select the active print job & you must first press the Stop button @ 2x to stop the job.

NOTE
To select the active print job & you must first press the Stop button @ two times to stop the job.

Procedure
1. On the control panel, touch [Jobs] -> [Queues].
. If collapsed, first touch - to expand the list of [Scheduled jobs].
3. Touch the job or jobs you want to print later or use the [Select] button to make a selection.
To undo the multiple selection and only select one job, you must touch and hold that job for two
seconds.
4. Press [Movel.

The job is moved to the list of [Waiting jobs].
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Reprint a Job

Introduction

NOTE
The following description is only applicable when the setting [Printed jobs] in the Settings Editor
is enabled.

Print jobs that have been completed are moved from the list of [Scheduled jobs] list to the list of
[Printed jobs]. The [Printed jobs] list helps you to reprint jobs quicker and easier.

The List of Printed Jobs

Procedure

When you want to reprint a job, the selected job is always copied to the list of [Waiting jobs]
first.

You cannot change the job settings in the list of [Printed jobs]. This is only possible in the list
of [Waiting jobs].

You cannot reprint streaming jobs.

The list of [Printed jobs] does not store proof prints, system jobs and jobs that were stopped or
deleted.

When you shut down the printer all jobs remain present in the list of [Printed jobs].

The list of [Printed jobs] can only store jobs. To prevent the disk of your system from becoming
full, jobs must be deleted manually or automatically on a regular basis. In the Settings Editor,
you can indicate the cleaning period, then the clean-up is carried out at midnight or at the next
start-up (in general the next morning).

If E-shredding is enabled, the jobs will be shredded after removal from the list of [Printed jobs].

1. On the control panel, touch [Jobs] -> [Printed jobs].

2. Touch the job(s) you want to reprint or use the [Select] button to make a selection.
To undo the multiple selection and only select one job, you must touch and hold that job for two
seconds.

Noops®w

Press [Copy].

Touch [Queues] -> [Waiting jobs].

Touch the job you want to reprint.

Touch [Properties] if you want to change the settings, for example the number of sets.
Press [Print].
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Select more than One Job for Printing

Introduction

The table below describes the possibilities to select more than one job for printing.

Select more jobs

Select two or more jobs
manually

[Select] button - [All]

[Select] button - [Jobs with
available medial

[Select] button - [Jobs with
label]

Procedure

Touch the jobs you want to print one by one.

All jobs in the list of [Waiting jobs] are printed. The order in the list
of [Waiting jobs] determines the print order. However, in the list of
[Scheduled jobs] you can give priority to a job.

All jobs for which the required media are currently available in the
paper trays, will be printed. This improves the productivity, be-
cause you must not change the required media during printing.
You may only need to add more of the currently available media

types.

A label is a name or tag that helps you to identify certain jobs on
the control panel. When a job is sent to the printer, the person
who submits the job can add a label to that job. The label can be
any name that helps to identify certain jobs. The label can be de-
fined in the printer driver, in a job ticket or via an automated work-
flow. When the label in the printer driver is identical to a defined
automated workflow, then the print job will be printed with the
settings of this automated workflow. For example, the label ‘Cus-
tomer XYZ' can be added to jobs. Then you can select and print all
the jobs for 'Customer XYZ' at once.

1. On the control panel, touch [Jobs] -> [Queues].
If collapsed, first touch - to expand the list of [Waiting jobs], or go to a DocBox.

3. Touch the jobs you want to print one by one, or make a selection using the [Select] button.
The selected jobs are highlighted.

4. Press [Print].
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Bundle Jobs in the List of [Waiting jobs]

Introduction

The bundle function allows you to combine two or more jobs into one new job. For example, this
can be convenient when the participants of a meeting need several documents in a specific order.
Often, the required documents are sent from several workplaces to the printer in advance.
Normally, this means that you must print the documents first and sort or staple them later. By
using the bundle function you can determine the order of the documents before printing and
print all documents in the correct order in only 1 print job.

Important Information About the Bundle Function

You can only bundle print jobs that are currently in the list of [Waiting jobs].

You can change a number of settings for the bundled job via the [Properties] window.

By default, the number of sets for a bundled job is one. So before printing, you must first
indicate the required number of sets.

When you stop a job after a set, the printing stops after one copy of the complete bundle.

The jobs in a bundle are accounted separately under the account ID of the original jobs.

All the jobs in the bundle must have the same output location. Otherwise, the control panel
displays a warning message. To continue, you must first split the bundled job, then change the
individual job settings and finally bundle the jobs again.

Main Actions on the Bundle Function

The table below describes the main actions you can carry out with regard to the bundle function.

Main bundle functions

[Bundlel

[Split]

Change job settings

When you touch [Bundle] after selecting two or more jobs, a new
job is created that contains the original jobs. The new job is added
to the bottom of the list of [Waiting jobs]. The original jobs are re-
moved from the list. The new job gets a new name that is based
on the name of the first job in the bundle.

When you touch [Split] after selecting a bundled job, the job is
split into the original, separate jobs. The bundled job is removed.
The separate jobs are added to the bottom of the list of [Waiting
jobsl. You can use the [Split] function to correct mismatched set-
tings, for example.

The [Properties] window gives access to a pane where you can do
the following.

* Change a number of job settings.

+ Change the order of the jobs in the bundle.

[Delete] Delete the job.
[Ticket] Print the job ticket of the job.
[Proof] Print one copy of the job first to check if the result meets your ex-
pectations.
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Illustration

[} Create bundle

ﬁ Bundle name

User
Pages
Submitted
Duration

Label

& :Nu operator note

Operator

=i Number of bundles

Operator

2

Apr 19, 2012 2:28:02PM
0:01

Job order

B chedfistset

Separator sheets

Bl check first set

RN

Media

Submitted
Apr 19, 2012
22318PM

Apr 19, 2012
2:23:18PM

Sheets | Media

A
2 D A4, 80 gm?, Plain paper, White

[36] The [Create bundle] window

Procedure

On the control panel, touch [Jobs] -> [Queues] -> [Waiting jobs].
2.

Touch the jobs you want to combine, or use an option from the [Select] menu to select multiple
jobs at once.

3. Press[Bundlel].

o~

Chapter 6 - Carry Out Print Jobs

A [Create bundle] window appears that allows you to make some changes.
If necessary, use the [Up] and [Down] buttons to change the job order.

If necessary, change the generic job settings, such as [Number of bundles].
6. Press[OKI.
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Print a Job Ticket

Introduction

Job tickets are used to transfer settings from an application to the printer. It can be convenient to
print a job ticket before printing a job, to get an overview of the main job characteristics.

Job tickets can contain the following information, for example.
* Job name.

« Job owner.

* Job destination.

» Job settings such as the number of sets.

* Required media.

Where to Find the [Ticket] Button

The [Ticket] button is available at the following sections of the control panel.
* [Scheduled jobsl.

* [Waiting jobs].

 [Printed jobs] (if enabled in the Settings Editor).

* [DocBox] (in the drop-down list -).

Procedure
1. On the control panel, touch [Jobs].
2. Select one of the locations mentioned above.
3. Touch one or more jobs of which you want to print the job ticket.
4. Press [Ticket].

The job is sent to the bottom of the list of [Scheduled jobs]. The job may not be immediately
visible in the list of [Scheduled jobs]. You can recognize the job by the prefix @_ in front of the
job name.
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Make a Proof

Introduction

You can make a proof to check whether the quality and the layout of the output meet your
expectations. When you use the [Proof] function, the machine prints one copy of the job. You can
only make a proof for a job in the list of [Waiting jobs] or in the [DocBox] (optional).

When you make a proof, the printed set is not subtracted from the defined total number of sets
for a job. For example, if you need 10 sets the printer will still print 10 sets after you made the
proof. This is different from the checking of the first set.

Locations of the [Proof] Button

The [Proof] button is available at the following locations.
 List of [Waiting jobs].
* [DocBox] (optional).

NOTE
To make a proof of a job in the list of [Printed jobs], you must first touch [Copy] to copy the job
to the list of [Waiting jobs]. There you can select the job and touch [Proof].

Procedure

1.
2,
3.
&

4,

On the control panel, touch [Jobs].
Select one of the locations mentioned above.
Touch the job of which you want to print a proof.

NOTE
You can select multiple jobs.

Press [Proofl.

A copy of the job goes to the bottom of the list of [Scheduled jobs]. The original job remains in
the list of [Waiting jobs] or in the [DocBoxl.

You can recognize a proof by the magnifying glass on the job icon &.
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Use the Schedule (Option)

Introduction to the [Schedule] View

Introduction

The [Schedule] is your daily planning board for print jobs. The [Schedule] helps you to keep the
machine running.

This section shows and describes the main parts of the [Schedule].

1@ NOTE

The descriptions of the colors of the bars and the indication of the required amount of sheets are
only valid for document printing. For streaming jobs 4, all the bars remain grey until the paper
trays are empty or the output locations are full. Then the machine stops and the bars become
red. Furthermore, the media toolbar does not indicate the required amount of sheets.

[@ NOTE

The descriptions of the colors of the bars and the indication of the required amount of sheets are
only valid for document printing. For streaming jobs 4, all the bars remain grey until the paper
trays are empty or the output locations are full. Then the machine stops and the bars become
red. Furthermore, the media toolbar does not indicate the required amount of sheets.

lllustration

@[ = Jj&~ ® @

Required media

Normal A4
% 2s[d, 120 gime, Wnite

5 minutes

15 minutes

@

30 minutes

1 hour

2 hours

4 hours

8 hours

Required output locations

T stackerstapler upper tray

@ Schedule @ Jobs I=| Trays % System

[37] The [Schedule] view
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Introduction to the [Schedule] View

1. The Jobs Pane

The jobs pane shows the jobs on a timeline. The width of the job corresponds to the (remaining)
print time. A vertical line separates the jobs. The vertical line moves to the left as the printing of a
job progresses.

An icon and the job name represent a job. The icon indicates the state of the job, for example
printing .

Furthermore, the i icon indicates the stop moments of the machine. For example, when the
setting [Confirm start of job] in the workflow profiles (see list of references below) is set to [On] or
when you use the [Stop after job] function.

2. The [Required media] Pane

The [Required media] pane displays the media that are required for each scheduled job. For each
required media, the media properties are displayed (see list of references below). The bars show
the availability of the media. The bars can have the following colors.

The colors of the bars

Green The required media is available.

Orange The media is required in the future, but not available then. For example
because the paper trays do not contain sufficient sheets of the required
media.

Yellow The system cannot determine the exact number of sheets that is availa-

ble in the paper trays.

Red The media is required now, but not available. The job can only start
when you load the required media.

When you print small jobs, the bars for these jobs may not be completely visible. To prevent that
you do not see the status of these small jobs, the operator panel can show the following images.

[@ NOTE

When you set the zoom control (5) to a shorter time-scale, in most cases the operator panel will
display bars for these small jobs.

The possible display of small jobs

‘ Green. The required media is available.

| Orange. The media is required in the future, but not available then. For
example because the paper trays do not contain sufficient sheets of the
required media.

E Red. The media is required now, but not available. The job can only
start when you load the required media.

3. The Media Toolbar

The media toolbar displays the following information for the media that is selected in the
[Required medial pane. Furthermore, the media type toolbar contains the [Load] button to load
and assign the required media.
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The icons in the media toolbar

I =

E The list of [Required medial shows the required media for the sched-
uled jobs. When the paper module indicator is completely grey, this
means that not one of the required media is available in the paper
trays.

The list of [Required medial shows the required media for the sched-
uled jobs. When a paper tray is highlighted in green, the highlighted
paper tray contains a media that is required by one of the scheduled
jobs.

E The list of [Required medial shows the required media for the sched-
uled jobs. When a paper tray is highlighted in blue, the highlighted pa-
per tray contains the media that is also highlighted in blue in the list of
[Required medial.

4. The Output Locations Pane

The output locations pane displays the output locations that are required for the scheduled jobs.
The bars show the availability of the output locations. The bars can have the following colors.

The colors of the bars

Green The output location is required and available.

Orange The output location is required in the future, but not available then. For
example, because the output location will be full soon.

Red The output location is required now, but not available. For example, be-
cause the output location is full.

Gray The output location is required, but availability is unknown.

5. The Zoom Control

The zoom control enables you to adjust the time scale visible in the [Schedule]. When you touch
the zoom button, a drop-down list appears. Then you can select the desired time scale (five
minutes - eight hours).
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Load Media via the [Schedule] View

Introduction

&

When the [Schedule] view is available on your printer, you can load and assign the required
media directly in the [Schedule] section.

NOTE

When you load a different media size, you must also set the paper guides inside the paper tray
to the correct dimensions. You cannot change the media size for the internal bulk trays one and
two. These are preset to a fixed media size. To switch to another media size for the bulk trays,
these trays must be adapted manually first.

Illustration

(@ Schedule 00 ‘10 20 ‘30 40 ‘50 100 110 120 130 140 160 200
Required media

Special A4
% a4, 120 gime, white

Required output locations

] stackeristapler upper tray

@ Schedule Jobs =] Trays % System

[38] Load the media

Procedure
1. On the control panel, touch the button for the media you want to load, for example Special A4.
2. Press[Loadl.
The [Trays] view appears.
3. On the screen, touch the paper tray where you want to load the media.
4. Touch [OK] to open the paper tray.
5. Load the media into the paper tray.

The system assumes you loaded the selected media type, in this example Special A4. The system
will automatically assign Special A4 to that paper tray.

NOTE
You can always change the assigned media type later by touching the [Assign] button.

Gently close the paper tray.
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Change the Print Job Settings on the Control Panel

Change the [Output] Settings

Change Two-Sided into One-Sided and Vice Versa

Introduction

Jobs for which [1-sided] or [2-sided] printing was defined, will be printed on either one side or
both sides of a sheet. If required, you can change this setting.

NOTE
You cannot change this setting for the active print job .

Procedure

1.

oo wN

On the control panel, touch [Jobs] -> [Queues] -> [Scheduled jobs] or [Waiting jobs], or select a
DocBox.

Touch the job you want to change.

Touch [Properties], or double-tap the job to open the [Properties] window.

Touch the [1- or 2-sided] button.

Touch the desired value.

Press [OK].
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Change the Binding Edge

Introduction

The binding edge determines whether the binding position is along the long edge or the short
edge of the media. The binding edge is usually set via the printer driver, for example. However,
you can view and change the binding edge via the operator panel. The binding edge has a
relation with the direction of the margin shift, orientation and staple position.

When the binding edge is changed for two-sided printing, the image orientation is automatically
adjusted to get the correct layout. The orientation of the image on the back side of the page will
be changed too.

NOTE
You cannot change this setting for the active print job @&.

Procedure

1.

o0k~ wN

On the control panel, touch [Jobs] -> [Queues] -> [Scheduled jobs] or [Waiting jobs], or select a
DocBox.

Touch the job you want to change.

Touch [Properties], or double-tap the job to open the [Properties] window.

Touch the [Binding edgel button.

Touch the desired value.

Press [OKI.
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Select Another Media for a Job

Introduction

If you want to print a job on other media than originally defined for that job, you can select a
different media via the operator panel. Requirements regarding the new media:

* The media must be available in the media catalog.

* The media must have the same size as the original media.

NOTE
You cannot change this setting for the active print job .

Procedure

1.  On the control panel, touch [Jobs] -> [Queues] -> [Scheduled jobs] or [Waiting jobs], or select a
DocBox.

2. Touch the job you want to change.

3. Touch [Properties], or double-tap the job to open the [Properties] window.

4. Inthe preview pane at the right-hand side, touch the media you want to change.
When more than one media was defined for a job, the preview pane displays a separate button
for each media.

5. From the list, select the new media.

6. Press[OKI.
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Change the Settings for Covers

Introduction

When front covers or back covers are required, the settings are usually set in the printer driver,
for example. However, you can view and change the settings for the covers via the control panel.

You can change the following settings for both the front cover and the back cover separately.
» Enable or disable the use of a cover.

+ Select the desired media from the media catalog.

« Indicate whether the cover must be left empty, printed one-sided, or printed two-sided.

NOTE
You cannot change this setting for the active print job .

Procedure

1. On the control panel, touch [Jobs] -> [Queues] -> [Scheduled jobs] or [Waiting jobs], or select a
DocBox.

Touch the job you want to change.

Touch [Properties], or double-tap the job to open the [Properties] window.
Touch the [Cover] button.

Make the required changes.

Press [OKI.

I
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Shift the Image Roughly to Create Binding Space

Introduction

If you want to create space for staples or punch holes, for example, you can use the [Align]
function. The preview in the right-hand pane of the control panel displays the consequences of
your changes.

The [Align] function allows a rough image shift. You can select one of the following settings:

[Align] values

When you select: Then the image is moved to:

[Top left] The upper left corner of the sheet.
[Top center] The upper center of the sheet.
[Top right] The upper right corner of the sheet.
[Center left] The left-hand side of the sheet, over the center line.
[Center] The middle of the sheet.
[Center right] The right-hand side of the sheet, over the center line.
[Bottom left] The lower left corner of the sheet.
[Bottom center] The lower center of the sheet.
[Bottom right] The lower right corner of the sheet.
NOTE

You cannot change this setting for the active print job .

Procedure

1.

oo LN

On the control panel, touch [Jobs] -> [Queues] -> [Scheduled jobs] or [Waiting jobs], or select a
DocBox.

Touch the job you want to change.

Touch [Properties], or double-tap the job to open the [Properties] window.

Touch the [Align] button.

Make the required changes.

Press [OK].
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Shift the Image Precisely to Create Binding Space or Correct the Layout

Introduction

If you want to create space for staples or punch holes, for example, you can use the [Align]
function. However, when the [Align] function is not precise enough, you can use the [Margin
shift] and [Image shift] functions. These functions allow you to shift the image more precisely.
The preview in the right-hand pane of the control panel displays the consequences of your
changes. If you shift the margin too much, you may loose part of the image.

The [Shift] function has two options.

» [Margin shift] allows you to increase or decrease the margin horizontally to create more
binding space, for example. With [Margin shift], you can shift an image relative to the binding
edge.

* [Image shift] allows you to move the image horizontally and vertically. This gives you more
freedom in moving the image exactly to the desired position.

By default, the values of the front side and the back side are linked. To define different values for
each side, touch &. The changes you make are valid for the whole document, not only for the
current page.

NOTE
You cannot change this setting for the active print job &.

Procedure

1.

gewN

On the control panel, touch [Jobs] -> [Queues] -> [Scheduled jobs] or [Waiting jobs], or select a
DocBox.

Touch the job you want to change.

Touch [Properties], or double-tap the job to open the [Properties] window.

Touch the [Shift] button.

Make the required changes.

NOTE

You can touch the - and + buttons to change the values. You can also enter the required value
directly. Touch the number to enter a value manually. The numeric keyboard appears. There you
can enter the required value.

Press [OK].
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Change the Print Delivery Settings

Introduction

Usually the print delivery settings have been defined in the printer driver. This section describes
how to change some settings on the control panel.

Overview of the Print Delivery Settings

[Output location]

[Sort]

[Offset stacking]

[Advanced settings]

NOTE

Change the output location for the job. The list shows all the out-
put locations that are available for your system.

Make sure there is a match between the selected output location
and the job requirements. For example, when a job requires sta-
ples, you must select an output location that allows stapling.

Change the sorting method of the prints. You can select sort [By
page] or [By set].

[40] Sort by set

Stack the prints with an offset.
This setting is only available when the [Offset stacking] setting of
the active [Workflow profile] is set to [Sets (as in job)].

Finishing equipment often requires that the printed sheets are de-
livered in a certain order. For finishers that are integrated in your
printing system, the required settings are adapted automatically.
However, sometimes it can be necessary to change a number of
settings manually, for example when you want to finish the prints
using offline finishers. If required, you can change the [Sheet or-
der], [Sheet orientation], [Print order] and [Rotation].

You cannot change this setting for the active print job .

Procedure

1.  On the control panel, touch [Jobs] -> [Queues] -> [Scheduled jobs] or [Waiting jobs], or select a

DocBox.

o wN

Press [OKI.

Touch the job you want to change.

Touch [Properties], or double-tap the job to open the [Properties] window.
Touch the [Print delivery] button.

Make the required changes.

Canon varioPRINT 135 Series
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Change the Stacking Method per Job

Change the Stacking Method per Job

Introduction

The [Offset stacking] function creates a visible distinction between sets or jobs in an output
location. The active workflow profile or the active automated workflow determines the default
type of offset stacking.

You can only change the type of [Offset stacking] per job when the [Offset stacking] setting of the
active [Workflow profile] is set to [Sets (as in job)].

NOTE
You cannot change this setting for the active print job .

Procedure

NOTE
Remember that you can only change the stacking method per job when the active [Workflow
profile] is set to [Sets (as in job)].

-—

On the control panel, touch [Jobs] -> [Queues] -> [Scheduled jobs] or [Waiting jobs], or select a
DocBox.

Touch the job you want to change.

Touch [Properties], or double-tap the job to open the [Properties] window.

Touch the [Print delivery] button.

Touch the [Offset stacking] button to toggle between [On] and [Off].

Press [OKI.

oo~ wLN
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Change the Print Quality Settings

Introduction

The print quality settings help you to optimize the quality of your prints. You can use the
following applications to change the print quality settings.

* Printer drivers.

* Job submission applications such as PRISMAprepare.

* The control panel of your printer.

* The Settings Editor on the PRISMAsync controller.

In the printer driver, in PRISMAprepare and on the control panel, you can change the settings per
job. In the Settings Editor, you can change the settings for all upcoming jobs.

The tables below describe both the basic and advanced print quality settings you can change
through the control panel.

Basic Settings

Basic print quality settings

[Brightness] (default 0) When your prints are too dark or too light, changing the bright-
ness can correct this problem.
-1 to -3 creates darker prints.
+1 to +3 creates lighter prints.

[Contrast] (default 0) When the difference between light and dark areas of a print is not
big enough, you can change the contrast to correct this problem.
Example: When a blue text is displayed rastered, you can increase
the contrast to make the text more black and sharper.

NOTE

Each of the 35 combinations of contrast and brightness settings corresponds to a specific
transfer curve (i.e. transfer.ps file). In the Settings Editor, you can change the default settings for
contrast and brightness adjustments for jobs that do not ask for any brightness or contrast
adjustment.

Advanced Settings

Advanced print quality settings

[Fattening] (default [Off]) The fattening function can increase the readability of texts with
small fonts (< 6 points, 6/72 inch).
However, when you print special data such as bar codes, fattening
can make bar codes difficult to read. Therefore, you can turn the
fattening function off when you print such special data.

[Minimum line width] (de- = The minimum line width function is required to keep thin lines
fault [On]) visible. The lines in PS/PDF jobs always keep a minimum width of
1/600 inch.
However, when you print special data such as CAD drawings,
smaller lines may be required. Therefore, you can turn the mini-
mum line width function off. Then even thinner lines will be prin-
ted.

Chapter 6 - Carry Out Print Jobs 169
Canon varioPRINT 135 Series



Change the Print Quality Settings

Advanced settings

[RIP resolution] (default
[600x2400] dpi)

[RIP raster] (default
[LINE_200LPI1)

[Color profile] (default
[Normal])

NOTE

Procedure

1.

oakr~wN

The RIP resolution can improve the readability of fine details.
When you print very thin, slanted lines, for example in Chinese
characters, 1200x1200 gives the best result. 600x2400 is best suit-
ed for mainly horizontal and vertical objects.

The default raster is [LINE_200LPI]. This is best suited for over 95%
of all prints. In special cases, for example moiré patterns from
scanned images, you can try to improve the print result with the
[DOT_200LPI] raster or even the [DOT_125LPI] raster. However,
then you may loose some fine details.

The raster screen for PS/PDF jobs is [LINE_200LPI]. All raster
screens are compatible with resolutions of 600x2400 dpi and
1200x1200 dpi.

You can use color profiles when you print color images on a B&W
printer. The selected color profile determines how a color image is
reproduced in black and white.

* [Enhanced] is a color profile developed by Océ that converts
CMYK or RGB data into different gray values in a contrast-bal-
anced way. When you select [Enhanced], the images will be-
come lighter, softer and less contrast-rich.

* [Normall is a color profile developed by Adobe® that converts
color data into gray values. When you select [Normal], the im-
ages will become darker and more contrast-rich.

NOTE
You can also use your own color profiles. Make the re-
quired settings in the Settings Editor.

You cannot change this setting for the active print job @.

On the control panel, touch [Jobs] -> [Queues] -> [Scheduled jobs] or [Waiting jobs], or select a

DocBox.

Press [Print quality].
Make the required changes.
Press [OKI.

Touch the job you want to change.
Touch [Properties], or double-tap the job to open the [Properties] window.
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Change the Finishing Method

Introduction

The required finishing method is usually set in the printer driver. However, you can change the
finishing method on the control panel.

Depending on the configuration of your system you can change the following finishing methods,
for example.

* Number of staples.

* Number of punch holes.

* The location of the staples or punch holes.

NOTE
You cannot change this setting for the active print job @.

Procedure

1.

12l

On the control panel, touch [Jobs] -> [Queues] -> [Scheduled jobs] or [Waiting jobs], or go to a
DocBox.

Touch the job you want to change.

Touch [Properties], or double-tap the job to open the [Properties] window.

Touch the [Binding] button.

Make the required changes.

Press [OK].
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Define the Finishing for Print Jobs

Introduction

The required finishing method is usually set in the printer driver. However, you can change the
finishing method on the control panel.

Depending on the configuration of your system you can change the following finishing methods,
for example.

* Number of staples.

* Number of punch holes.

« The location of the staples or punch holes.

* Folding method.

e Trimming method.

NOTE
You cannot change this setting for the active print job @.

Procedure

1. On the control panel, touch [Jobs] -> [Queues] -> [Scheduled jobs] or [Waiting jobs], or select a
DocBox.

Touch the job you want to change.

Touch [Properties], or double-tap the job to open the [Properties] window.

Touch the [Binding], [Folding] or [Trimming] button.

Make the required settings.

Press [OKI.

o0k~ wN
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Change the [Job] Settings

Change the Number of Sets

Introduction

Follow the procedure below to change the number of sets for a job that is present in the list of
[Waiting jobs] or [Scheduled jobs], or in a DocBox.

NOTE
You cannot change this setting for the active print job .

Procedure

1.  On the control panel, touch [Jobs] -> [Queues] -> [Scheduled jobs] or [Waiting jobs], or select a
DocBox.

Touch the job you want to change.

Touch [Properties], or double-tap the job to open the [Properties] window.

Touch the [Number of sets] button.

Enter the desired number of sets (between 1 and 65,000).

If necessary, touch the arrow button <- to correct the previous entry, or touch [Cancel] to close
the numerical keyboard without saving the changes.

6. Press [OK].

arwbN
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Check the First Set

Introduction

When you have a large print job and you want to check whether the job is printed correctly, it is
advised to check the first set before printing all other sets. When a job is sent to the printer, the
submitter can indicate in the job submission application that the first set must be checked.
However, the workflow profile that is selected on the control panel determines how the printer
handles these requests.

Depending on the selected workflow profile, the [Check first set] setting can have the following
values:

+ [On]

+ [Off]

* [Asinjob]

When you use the [Check first set] function, the printed set is subtracted from the indicated total
number of sets for a job. For example, when you need 10 sets, the printer will print the first set
and then stop. When you continue the job, the nine remaining sets are printed. This is different
from printing a proof.

Methods to check the first set

You can use one of the following methods to indicate that you want to check the first set.

* Use a workflow profile where [Check first set] is enabled. Then the printer stops after the first
set.

* Enable the function [Check first set] in the [Properties] window for a specific job only. However,
you can only change the [Check first set] setting there when a workflow profile is selected
where the [Check first set] setting is [As in job].

NOTE
You cannot change this setting for the active print job @.

Procedure

1. On the control panel, touch [Jobs] -> [Queues] -> [Scheduled jobs] or [Waiting jobs], or select a
DocBox.

2. Touch the job you want to change.

3. Touch [Properties], or double-tap the job to open the [Properties] window.

4. Touch the [Number of sets] button.

5. Touch [Check first set] when the button states [Off].
The text changes from [Off] to [On]. A check mark indicates that the checking of the first set is
enabled.

6. Press [OKI.
The [Number of sets] button has a check mark.

7. Press [OKI.
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Change the Page Range You Want to Print

Introduction

Usually, in the printer driver is defined whether all pages or only a range of pages must be
printed. However, you can also change this setting through the control panel.

NOTE
You cannot change this setting for the active print job .

Procedure

1.  On the control panel, touch [Jobs] -> [Queues] -> [Scheduled jobs] or [Waiting jobs], or select a
DocBox.
Touch the job you want to change.
Touch [Properties], or double-tap the job to open the [Properties] window.
Touch the [Page range] button.
Touch [Method] -> [Pages].
Touch the [From] button.
Enter the number of the first page you want to print.
7. Touch the [To] button.
Enter the number of the last page you want to print.
8. Press [OK].

oo wLN
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Change the Use of Separator Sheets

Introduction

Separator sheets are empty sheets that are automatically inserted before each new set or job to
separate two sets or jobs. In the Settings Editor you can define the media that must be used as
separator sheets. The use of separator sheets can be enabled via the automated workflows in the
Settings Editor. However, you can change this setting trough the control panel.

NOTE
You cannot change this setting for the active print job .

Procedure

1.

gpwN

On the control panel, touch [Jobs] -> [Queues] -> [Scheduled jobs] or [Waiting jobs], or select a
DocBox.

Touch the job you want to change.

Touch [Properties], or double-tap the job to open the [Properties] window.

Touch the [Separator sheets] button to toggle between [On] and [Off].

Press [OKI.
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Change the Print Job Settings on Page Level

Introduction

You can change settings of a job on page level via the [Page programming] in the job properties.

Procedure

1.

o0 WwN

On the control panel, touch [Jobs] -> [Queues] -> [Scheduled jobs] or [Waiting jobs], or select a
DocBox.

Touch the job you want to change.

Touch [Properties], or double-tap the job to open the [Properties] window.

If you want to carry out extended page programming, touch [Page programming].

Change the required settings.

Press [OK].
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Automated Workflows

Introduction to Automated Workflows

Definition

The Settings Editor enables you to set up separate automated workflows. Automated workflows
are print queues that you can program to perform a range of operations. Automated workflows
are mostly used for legacy applications where jobs are printed automatically and certain settings
must be set automatically. Every automated workflow represents a different virtual printer with
its own specific attributes. The table below describes the attributes you can define.

The selection of automated workflows is handled when the job is sent over LPR via the name of
the automated workflow of the job ticket. Once the job is sent to a specified automated workflow
on the printer, you cannot move the job to another workflow. The control panel does not display
the various automated workflows. However, jobs can get a label that you can use as a selection
criterion for further processing and production.

The use of automated workflows has for example the following advantages.

* The print workflow is automated even more, which improves the productivity.

+ The programming of individual jobs is eliminated, which optimizes the job throughput.

* You can more easily distinguish, prioritize and produce jobs in different automated workflows
with different properties using less operator involvement.

* You can easily assign legacy applications without job tickets to specific job profiles.

NOTE
Z@ You can define whether or not the settings of a job ticket overrule the settings of an automated
workflow in the Settings Editor.

Attributes

NOTE
It is not mandatory to define all the settings. When you put a check mark in front of a setting,
that setting and its values become enabled.

nwite———bmpion

[Queue name] You can enter a distinguishing name for the automated workflow
(maximum 25 characters). This name is also used as a label on the
control panel. This helps the operator to identify certain jobs on
the control panel. In this way, the operator can identify from which
LPR queue or workflow the job has arrived. Different LPR queues
can have the same label if the operator chooses to do so. In that
case, the operator cannot distinguish from which specific queue a
job has arrived. The LPR queue name is not displayed on the con-

trol panel.
[Description] You can enter a description of maximum 200 characters.
[Overrule the job ticket] When this settings is enabled, then the settings of the automated

workflow will be used.
When this setting is disabled, then the settings of the job ticket will
be used.

[Number of copies] You can indicate how many copies of a job must be printed.
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nwite———bsmpion

[Sort]

[Medial
[Fit to medial]

[Print sides]

[Orientation]

[Rotate 180 degrees]
[Tumble]

[Impositioning]

[Impositioning sizel

[Front or booklet cover]

[Front cover print on]
[Back cover]
[Back cover print on]

[Perfect binding]

[Offset stacking]

[Staples]

[Output location]

[Sheet order]

[Feed edge]

You can indicate whether the jobs must be sorted [By Set] or [By
Pagel.

You can enter the media that must be used.

You can indicate whether every page must be scaled to the media
size.

You can indicate whether the jobs must be printed one-sided or
two-sided.

You can indicate whether the prints must be [Portrait] or [Land-
scapel.

You can indicate that the prints must be rotated 180 degrees.

You can indicate the orientation of page images on opposite sides
of a sheet.

When [Tumble] is set to [Yes], the two pages are oriented in such
a way that the binding is at the top or bottom. The image is rota-
ted 180 degrees on alternate pages. Both sides of the page are
printed. However, the position of the image is reversed (from top
to bottom) on every other page.

When [Tumble] is set to [No], the binding is at the left or right. The
images are not rotated on alternate pages.

NOTE
[Tumble] is only possible when the setting [Print sides]
is set to [2-sided].

You can indicate how the prints must look, for example [2-up] or
[Same 2-upl.

You can indicate the size of booklet jobs.

You can indicate which media must be used for the front covers or
booklet covers.

You can indicate which sides of the front cover must be printed.
You can indicate which media must be used for the back covers.
You can indicate which sides of the back cover must be printed.

You can indicate where the binding must be done, for example
[Left binding] or [Right binding]

You can indicate whether each next job or set must be stacked
with an offset compared to the previous job or set.

You can indicate where the prints must be stapled, for example
[Top left] or [Top right].

You can indicate where the jobs are sent, for example to the stack-
er.

You can indicate the order in which the sheets will be delivered,
for example [Face down - Normal order].

You can indicate whether the sheets will be fed [Long edge] or
[Short edgel.

Canon varioPRINT 135 Series
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nwite——bmipion

[Header up/down]

[Offset stacking]

[Value for N sets]
[Punches]

[Folding]

[Fold to]

[Trim]

[Trim / target width]
[Trim / target height]
[Contrast]

[Brightness adjustment]

[Resolution]

[Halftoning]

[Fattening]

[Minimum line width]

[Enhanced color rendering]

[Job destination]

[DocBox name]

[Printing workflow]

[PDL type]

[Separator sheets]

[Account ID]

[Cost center]

[Custom]

You can indicate whether the header of the sheets must be [Head-
er-up] or [Header-down].

You can indicate whether the prints must be delivered to the out-
put location with or without a small shift.

You can indicate the number of sets that will be shifted together.
You can indicate how many punch holes are required.

You can indicate the required folding method.

You can indicate the size in which the media must be folded.
You can indicate how the media must be trimmed.

You can indicate the width that must be trimmed.

You can indicate the height that must be trimmed.

You can indicate the contrast of the print.

You can indicate whether the print must be darker or lighter.

You can indicate whether the job must be printed on [1200 x 1200
dpi] or [600 x 2400 dpi].

You can indicate whether the job must be printed [Line 200 LPI],
[Dot 200 LPI] or [Dot 125 LPI].

You can indicate whether [Fattening] must be on or off.

You can indicate whether the minimum line width must be main-
tained, or thinner lines can be printed.

You can indicate whether the [Enhanced color rendering] must be
on or off.

You can indicate the list to which the job must be sent. For the var-
ioPRINT 135 Series, you can select [Waiting jobs], [Scheduled
jobs] or [DocBox jobs] (optional).

You can indicate the name of the DocBox to which the jobs must
be sent.

You can indicate the type of workflow for the jobs. You can select
[Receive, then print while RIP is in progress] or [Streaming].

You can indicate whether PostScript®, PCL, PDF or XPS must be
used as page description language.

[A separator sheet is an empty sheet that is inserted before a set.
If 'As in job' is selected, the addition of a separator sheet to the job
is as defined in the job. If the job does not specify separator sheet,
no separator sheet is added to the job.]

You can indicate the number of the customer that will be used for
accounting purposes.

You can indicate [Cost center can be a maximum of 40 characters
long.]

[Custom can be a maximum of 255 characters long.]
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Add an Automated Workflow

Add an Automated Workflow

Introduction
The Settings Editor contains one factory default automated workflow. You can add your own

specific automated workflows to improve your productivity.

NOTE
It is not compulsory to define all the settings. When you put a check mark in front of a setting,
that setting and its values become enabled.

lllustration

Add an automated workflow
General

P —
Pt / Description |

Override the fob ticket r
Automated workllow Copies
¥ 2 X @ ™ Wumber of copies
erire
quee nome oesc] O sot
Media
T Media
7 Fit to media
tayout
™ print sides

I~ rientation
I Rotate 180 degrees
I Tunble
I Impositioning
I Baaklot size

Special Pages
™ Front or booklat cover

™ Rear cover print on

I Perfect binding
flnishing

I staples

£ it factnatton Coreree— C
b Lot e

[41] Add an automated workflow

Procedure

1. Select [Workflow] -> [Automated workflows].
2. Click the [Add] button.
A pop-up window displays the attributes you can specify for the new workflow.

3. Tick the checkboxes of the attributes you want to define.
4. Specify or select the values of the attributes.
5. Click [OKkI.
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Edit an Automated Workflow

Introduction
You can change the attributes of an existing automated workflow.
NOTE

It is not compulsory to define all the settings. When you put a check mark in front of a setting,
that setting and its values become enabled.

Procedure

-—

Select [Workflow] -> [Automated workflows].

Tick the checkbox of the workflow you want to edit.

3. Click the [Edit] button.

A pop-up window displays the attributes you can specify for your workflow.
Change the attributes.

5. Click [Ok].

L

E
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Delete an Automated Workflow

Introduction
When you no longer need a certain automated workflow, you can delete that workflow.

NOTE
You cannot delete the factory default automated workflow.

Procedure

1. Select [Workflow] -> [Automated workflows].

Tick the checkbox of the workflow you want to delete.
Click the [Delete] button.

Click [Ok].

Eall N
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Restore the Factory Default Workflow

Introduction

You can restore the factory default automated workflow. This has the following consequences.
* All the automated workflows you added will be removed
» All the changes in the default workflow will be lost.

Procedure

1. Select [Workflow] -> [Automated workflows].
2. Click the [Restore] button.
The factory default automated workflow is restored.
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Hotfolders

Introduction to Hotfolders

Introduction

Technically, a hotfolder is a mapped network drive on a workstation that is linked to a shared
folder on the PRISMAsync controller.

For an operator, a hotfolder is a folder on a workstation where printable files can be dropped for
printing.

Hotfolders are primarily aimed at recurring PDF workflows. In these workflows identical PDFs, or
other printable files, with identical settings are printed on a regular basis. Hotfolders should not
be used in combination with print job tickets.

The Job Settings for Hotfolders

The settings of a hotfolder can be defined by:
* A hotfolder default ticket in the hotfolder itself, or
* The automated workflow to which the hotfolder is linked.

It is advisable to use the hotfolder functionality in combination with the hotfolder default ticket.

However, if you want to use the settings of the automated workflow where the hotfolder is linked
to, it is advised not to place a hotfolder default ticket in the hotfolder, to prevent mixing up
settings. Furthermore, you must make sure that the [Overrule the job ticket] setting in that
automated workflow is enabled (tick the checkbox).

Before You Can Use a Hotfolder

To be able to use the hotfolder function, the following steps must be carried out first:

* In the Settings Editor, the system administrator must activate the hotfolder function.

* Inthe Settings Editor, the system administrator must create a hotfolder and link the hotfolder
to an automated workflow.

» On a workstation, the key operator must create a shared network drive that is linked to the
hotfolder.

* On the desktop of that workstation, the key operator can create a shortcut to the hotfolder, if
desired.
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Activate the Hotfolder Function

Introduction

The information in this section is intended for system administrators.

1@ NOTE

By factory default, the hotfolder function is disabled. To use the hotfolder function, the system
administrator must activate this function once. After the system administrator activated the
hotfolder function, up to 10 hotfolders can be defined.

Z@ NOTE

For this procedure, the System administrator password is required.

Procedure

Open the web browser and enter the host name or IP address of your PRISMAsync controller.
Select [Workflow] -> [Hotfolders].
Click [Configure].
At [Enabled], select [Yes] to activate the hotfolder function.
Enter a unique [User name] and [Password].
Make sure that you filled in the user name and password before you continue with the next step.
6. Click [OK] to confirm the activation of the hotfolder function.
A confirmation window opens.
7. Click [OK] to restart the controller now.

grObd=
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Create a Hotfolder

Introduction

The information in this section is intended for system administrator.

Before you begin

The hotfolder function must be activated. Otherwise, the system administrator must activate the
hotfolder function first.

Procedure

NOTE
This procedure requires the system administrator password for the Settings Editor.

Open your web browser and enter the host name or IP address of your PRISMAsync controller.
Select [Workflow] -> [Hotfolders].

Click [Add].

Give the hotfolder a logical name.

A logical name helps you to recognize the type of jobs you want to process using this hotfolder.
Select the automated workflow to which you want to link the hotfolder.

6. Click [OK].

PN~

o
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Create a Shared Network Folder on a Workstation

Introduction

&

The information in this section is intended for key operators.

Before creating a shared network folder on a workstation, the following actions must be carried
out first:

* Enable the hotfolder function.

* Create an automated workflow (optional).

» Create a hotfolder.

NOTE
This procedure describes the creation of a shared network folder on a workstation with a

Microsoft® Windows® XP operating system. Depending on the operating system of your
workstation, the procedure can be different.

Illustration

Map Network Drive x|

Windows can help you connect to a shared network folder
and assign a drive letter to the connection so that you can
access the folder using My Computer.,

Specify the drive letter for the connection and the folder
that you want to connect to:

Drive: Y: =

Folder: |\\12.34.56.78\Bc0klet| ¥

Browse...
Example: \\server'share
[ Reconnect at logon

Connect using a different user name.

Sign up for online storage or connect to a
network server.

ck I Finish I Cancel

[42] Create a shared network drive

Procedure
1. Open Microsoft® Explorer.
2. Click Tools -> Map Network Drive...
3. Select a drive letter for the shared network folder.
4. Enter the name of the shared network folder, for example \12.34.56.78\Booklet, or click the

'‘Browse' button to navigate to the required location.

NOTE
Instead of 12.34.56.78 you must enter the host name or IP address of the PRISMAsync controller.
Booklet is the name you gave to the hotfolder when you created the automated workflow.

Click 'Finish'.

A log in screen will appear.

Enter the user name and the password that were defined when the hotfolder function was
enabled in the Settings Editor.

Click 'OK."

The hotfolder is now ready for use.

If desired, you can create a shortcut to the shared network folder on the desktop of the
workstation.
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Create a Hotfolder Default Ticket (‘default_ticket.jdf’)

Introduction

&

Hotfolders are primarily aimed at recurring PDF workflows. In these workflows identical PDFs, or
other printable files, with identical settings are printed on a regular basis. A hotfolder default
ticket ('default_ticket.jdf') in the hotfolder determines the settings for the print jobs. The name of
the hotfolder default ticket must not be changed, otherwise it will not be used in the hotfolder.

NOTE

If you want to use the hotfolder default ticket, make sure that the [Overrule the job ticket] setting
of the automated workflow in which the hotfolder was created, is disabled (no check mark in the
checkbox). Otherwise, the settings of the automated workflow overrule the settings of the
hotfolder default ticket.

Procedure

ONoOOE~WN =

NOTE

This procedure is an example of the procedure on a Microsoft® Windows® XP operating system.
For other operating systems, the procedure can vary.

Click Start - Settings - Printers and Faxes.

Right-click the printer driver of your printer and select Printing Preferences.
Define the required settings.

Click the [Save] icon in the Templates bar.

Enter a name for the template.

Click [OK].

Right-click the template you just created and select 'Save as ticket'.

Browse to the shared network folder and click [Savel.

The template is saved as a hotfolder default ticket.

Do not change the name of the hotfolder default ticket (‘default_ticket.jdf').
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Send a job to another printer

You can send jobs with their settings to another PRISMAsync printer from the following
locations:

 List of scheduled jobs
+ List of waiting jobs

* A DocBox

» List of printed jobs

Z@ NOTE

When one or more settings or finishing options for the job are not available on the selected
remote printer, a warning icon is displayed in the job on the remote printer. The job on the
remote printer indicates that there are contradictions you must resolve.

NOTE
The list of remote printers must be available and configured in the Settings Editor.

Procedure

1. Touch [Jobs].
Go to the location of the jobs.

3. Select the jobs you want to send to another printer, or use an option from the [Select] menu to
select multiple jobs together.

4. Select [Copy to] from the button bar or from the drop-down menu.

Select a printer from the list or use [Other printer] to manually enter a printer name.
6. Touch [OK].

o
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Transaction Printing (Option)

Introduction to the [Transaction] Section

Introduction

NOTE
Transaction printing requires a license. The [System] view on the control panel displays the

[Transaction] section only when transaction printing is licensed.

Transaction printing enables you to print typical transactional documents like invoices, salary
slips or other variable data streams. Before you can start transaction jobs, you must first activate
the transaction mode via the control panel. The [Transaction] section contains the settings that
you need to use transaction printing. There you can also shift the image in case of a
misalignment.

The following information is described below.
* An overview of the items in the [Transaction] section on the control panel.
* The sequence of steps you must perform to print your transaction jobs.

Overview of the [Transaction] Section

‘M Ready 0

i Connection " Print protocol
( 2 ) || nem Status ( 3 )
P sy D off
PDL protocal IPDS
EE‘% Active transaction setup Default
Transaction online B o
I
'i_l (¥ Image shift Q\
B Image shift in feed direction of side 1 [mm] ‘ 0.0 *
53
(1t ]3 Image shift in cross-feed direction of side 1 [mm] 0.0 ¥
Transaction
Q Image shift in feed direction of side 2 [mm] ‘ = 0.0 3
Image shift in cross-feed direction of side 2 [mm] . 0.0 &
Schedule Jobs =/| Trays % System

[43] Overview of the [Transaction] section
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The Items of the [Transaction] Section

Description of the [Transaction] section

1 Dashboard

2 [Connection]

3 [Print protocol]
4 [Image shift]

Sequence of Steps to Print Transaction Jobs

The dashboard displays the following information for
transaction printing.

* The connection status

* The IP address of the host that sends the jobs

* The name of the active transaction job

* The progress of the active transaction job

The [Connection] section gives access to the following

functions.

e Turn the transaction printing mode on or off

« Select the setup for the transaction jobs
You can define setups in the Settings Editor ([Transac-
tion printing] -> [Setups]).

» Put the printer online or offline. The printer must be
online for the host to be able to connect to the printer.

Display the active printer description language (read-on-
ly).

You can change the active PDL in the Settings Editor
([Transaction printing] -> [Settings] -> [Requested active
PDL]).

When the requested active PDL is changed, the new PDL
becomes effective when you put the printer online.

Display and change the active image shift settings, for
example when the images on the front and back of a
sheet are not aligned correctly.

The following table describes the sequence of steps for transaction printing. Make sure that the
list of [Scheduled jobs] is empty before you begin.

Switch the printer in-
to the transaction
printing mode.

2 Select the active set-
up that you need.

Via the control panel: [System] ->
[Transaction] -> [Transaction print-
ing mode] -> [On].

* Viathe control panel: [System] -
> [Transaction] -> [Active trans-
action setup], or

« Via the Settings Editor: [Trans-
action printing] -> [Setups], or

* By the host via the data stream
(when the printer is online and
connected).
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Change the active
PDL when currently
the wrong PDL is ac-
tive. This is only pos-
sible when you have
licenses for more
than one PDL.

4 Load the required
media into the paper
trays.

5 Put the printer on-
line.

6

7

8 Print the transaction
print jobs.

9 Put the printer off

line when the trans-
action print jobs are
ready.

10 Switch the printer
back to the docu-
ment printing mode.

Connect to the printer.

Submit the transaction
print jobs.

Via the Settings Editor: [Transac-
tion printing] -> [Setups] -> [Re-
quested active PDL].

Only required when the active set-
up has set the tray mode to tray to
tray.

¢ Viathe control panel: [System] -
> [Transaction] -> [Transaction
online] -> [On], or

» Via the Settings Editor: [Trans-
action printing] -> [Settings] ->
[Switch the printer online or off-
linel.

You must perform all the regular
activities, for example load the
media, empty the output locations,
add the supplies and solve errors.

¢ Viathe control panel: [System] -
> [Transaction] -> [Transaction
online] -> [Off], or

» Via the Settings Editor: [Trans-
action printing] -> [Settings] ->
[Switch the printer online or off-
linel.

* Viathe control panel: [System] -
> [Transaction] -> [Transaction
printing mode] -> [Offl.

Canon varioPRINT 135 Series
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Activate Transaction Printing

Before you begin

Make sure that the list of [Scheduled jobs] is empty.

Procedure

1. On the control panel, touch [System] -> [Transaction] -> [Transaction printing mode].
The text on the button changes from [Off] to [On].

2. If required, touch [Active transaction setup] and select the desired setup.
The attributes of the transaction setup are defined in the Settings Editor on the PRISMAsync
controller.

3. Load the required media into the paper trays if the setup selects the tray-to-tray mode.

4. Touch [Transaction online] to put the printer online.
The text on the button changes from [Off] to [On].

5. On the host or mainframe, connect to the printer and start the job.

NOTE
You can also select a setup and put the printer online via the [Transaction printing] section in the
Settings Editor.
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Deactivate Transaction Printing

Deactivate Transaction Printing

Before you begin

Make sure that the list of [Scheduled jobs] is empty.

Procedure

1.

On the control panel, touch [System] -> [Transaction] -> [Transaction online] to put the printer
offline.

The text on the button changes from [On] to [Off].

Note that you can only switch the [Transaction online] function to offline when

» The transaction print jobs are ready.

+ The printer contains no more print data.

» The printer has stopped because all the jobs are ready, not because an error has occurred.

When you switch [Transaction online] to offline, the connection to the host is disconnected
automatically.

Press [Transaction printing mode].

The text on the button changes from [On] to [Off].

NOTE
You can also put the printer offline via the [Transaction printing] section in the Settings Editor.
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Shift the image in the Transaction Printing Mode

Introduction

&

When a misalignment occurs, you can shift the image to correct the problem. You can shift the
image on the front side and back side horizontally and vertically. Examples of possible
misalignments:

* A name or address is not placed correctly in the right area.

» Lines on the front side and back side of a sheet are not aligned correctly.

To keep the shift settings for future use, you must specify the shift settings in the setup via the
Settings Editor. Each time that the setup is loaded, the shift settings included in the setup will
become the active shift settings.

NOTE

Only use the image shift function if you want to shift the image of the whole job. The image shift
applies to all the media in all the paper trays.

Procedure

1.

On the control panel, touch [System] -> [Transaction].

2. Touch the - or + buttons to shift the image on the front side or back side of the sheet.
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Transaction Setups

Create a New Transaction Setup

Introduction

For transaction printing, transaction setups are required. Transaction setups contain specific
settings for specific transaction jobs. You can create setups in the Settings Editor.

1@ NOTE

This section describes how to create a transaction setup from scratch. If you want to create a
transaction setup that is very similar to an existing setup, you can also create a copy and make
changes afterwards. In this case you must select the setup and click [Copy].

Procedure

1. Go to [Transaction printing] -> [Setups].

Click the [Add] button.

A pop-up window appears.

Enter a name and description for the transaction setup, then click [OK].

Check the box next to the setup, then click [Open] to allow changes to the settings of the setup.
5. Depending on the type of setup you created, click [IPDS setup] or [PCL setupl.

[@ NOTE

PCL is not available for all products. If you only have one license, the other PDL is not available.

Eall

You can change the settings:
« By group (click the pencil at the right-hand side of the group settings).
* By item (click the pencil behind the individual settings).

After you changed the settings of a transaction setup, you must load the transaction setup to
make the setup changes active (see Activate a Transaction Setup on page 199).
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Edit a Transaction Setup

Procedure

Select [Transaction printing] -> [Setups].

Tick the checkbox of the setup you want to edit.

If required, click the [Edit] button to change the name or description of the setup, then click [OK].
Click [Open] to allow changes to the setup.

Depending on the type of setup you want to change, click [IPDS setup] or [PCL setupl.

Z@ NOTE

PCL is not available for all products. If you only have one license, the other PDL is not available.

grwbd=

You can change the settings:
» By group (click the pencil at the right-hand side of the group settings).
» By item (click the pencil behind the individual settings).

After you changed the settings of a transaction setup, you must load the transaction setup to
make the setup changes active (see Activate a Transaction Setup on page 199).
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Activate a Transaction Setup

Introduction

After you create a new transaction setup or edited an existing transaction setup, you must
activate the transaction setup in the Settings Editor. Otherwise, the changes are not applied.

Procedure

1. In the Settings Editor, click [Transaction printing] -> [Settings] -> [Switch the printer online or
offline] to switch the printer offline.

2. Click [Transaction printing] -> [Setups], select the setup and click [Load].
The transaction setup is now activated.
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Exchange All Setups Between Printers

Introduction

If you have more than one printer, you can exchange the transaction setups between the printers,
provided that the printer type and software version are identical. You can then use identical
transaction setups on two or more printers.

Procedure
1. In the Settings Editor, click [Transaction printing] -> [Setups].
2. Click [Export].
3. Save the file.
4. To import the setups, click [Import].
5. Browse to the location where the setup file is stored.
6. Choose either [Replace] or [Mergel].

NOTE
After you imported the setup file you must open and load the transaction setup you want to use.
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IPDS

Media information (IPDS)

Introduction

The media catalog:

» Contains a list of predefined media and their attributes.

* Is an essential part of the system behavior of the varioPRINT 135 Series.
* Helps you to print your jobs more easily while using the correct media.

Make sure that the [Tray selection mechanism] setting in the Settings Editor is set to [Tray to
medial.

This is the preferred setting. The printer is a media-based machine. The tray-to-media method
supports this behavior.

For [IPDS tray to media for tray 1] assign the media catalogue item from the list. The list displays
all the media in the media catalog. The system copies the media attributes from the selected
media to the transaction setup.

When you assign A3/Tabloid-like media or want to use short-edge feed for other media, change
the feed direction to [Short-edge feed (SEF)].

Z@ NOTE

The Settings Editor displays only the media for which the media name is consistent with the
IPDS media name definitions. Valid characters for an IPDS media name are: A-Z, a-z, 0-9, blank.
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Output Recovery in Case of an Error (IPDS)

Introduction

The printer is equipped with an efficient, reliable output recovery in case of an error. By factory
default, the output recovery is set to [Normal]. After the error is solved, the job continues at the
page where the error occurred automatically.

However, some printing environments require that multiple copies must be avoided. For
example, in transactions involving the printing of valuable documents such as cheques. In such
an environment, the [Output recovery] setting of your IPDS setup must be set to [Suppressed].

When the output recovery is suppressed, the printer will not automatically make sure that the
output is corrected after a recovery. All pending pages in the printer will be deleted and the stack
will be ejected. The host system and the operator are responsible for the recovery. The operator
must restart the job manually on the correct page.

The tables below describe what happens when either the normal output recovery or the
suppressed output recovery is selected.

Normal Output Recovery in IPDS

Job Job progress states Normal output recov- | End up in the output
ery location after error re-

covery

Are stacked at one of
the output locations.

Sheets printed suc- Sheets are in output
cessfully. location

Remain in controller

memory.
Sheets copied to con- Once the error is re-
troller memory (in- solved, the printer re-
cluding error pages). starts by printing the

first page in the con-
troller memory.
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Job progress states Normal output recov- | End up in the output

ery location after error re-
covery

The control panel dis-
plays instructions on
how to solve the pa-
per jam. The operator
has to remove these
the jammed sheets

. . manually. .
Sheets jammed in the Y These sheets stay in

machine. the memory of the
controller. Once the
printer resumes print-
ing, these pages will
be printed again.

Remain in host mem-
ory.

Sheets in host memo- These sheets stay in

ry. the host memory.
When the printer
starts printing, these
pages will be copied
and sent to the con-
troller.

Suppressed Output Recovery in IPDS

Pages that are copied to the memory of the controller are deleted from the system. The operator
must send these missing pages as a new transaction print job to the printer.

Job Job progress states Suppressed output re- | End up in the output

covery location after error re-
covery

Are stacked at one of
the output locations.

Sheets printed suc- Sheets are in output
cessfully location 4

Chapter 6 - Carry Out Print Jobs 203
Canon varioPRINT 135 Series



Output Recovery in Case of an Error (IPDS)

Job progress states Suppressed output re- | End up in the output

covery location after error re-
covery

Are deleted complete-

ly.
/

Sheets copied to con- These sheets are not
troller memory (in- delivered to the out-
cluding error pages). put location.

The control panel dis-  § /

plays instructions on y 4

how to solve the pa-

per jam. The operator

has to remove these /

the jammed sheets }'

T P )

) . manually.
Sheets jammed in the Y These sheets are not
machine. delivered to the out-
put location.
Remain in host mem-
ory.
Sheets in host memo- Once the error is re-
ry. solved, the printer re-

starts by printing the
first page in the host
memory.
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PCL

Media Messages (PCL)

Introduction

The media catalog:

» Contains a list of predefined media and their attributes.

» Is an essential part of the system behavior of the varioPRINT 135 Series.
* Helps you to print your jobs more easily while using the correct media.

Response to Media Messages

For transaction printing, the content of the paper trays (in terms of media from the media catalog)
is translated into a format that the controller understands. However, the controller receives only a
limited amount of information (name or size of the media). This can lead to miscommunication
where the controller misses a media requirement. Then the controller will ask for the required
media via a message on the control panel. This [Media message] indicates the name or size of the
missing media.

Your response to the [Media message] depends on the mode in which the printer works, either:
e The tray-to-tray mode, or
e The tray-to-media mode.
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Handle the Media Messages in the Tray-to-Media Mode (PCL)

Procedure

1. A message on the control panel indicates that a media is missing. Select one of the following

actions as a response to the message.

* Press [Assign medial.
Continue with step 2 when you select this option.

* Press [Continuel.

* Press [Cancel stream].
The print job is stopped. You can now solve the problem. You will most likely be able to solve
the problem on the server.

Z@ NOTE

The following steps apply only when you chose to assign a media.

2. From the list of media, select the media that must be used as the media the controller is asking
for, and touch [OK].

If you do not select media from the media catalog with the requested size or name, the printer
will select a media with the default size.

3. Select one of the 16 memory locations of the logical-tray table to be used for the required media.
Note that the media that was previously allocated to that memory position in the setup will be
overwritten. Then that media will no longer be available to the transaction stream.

Now you can assign other media or continue the print job.
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Handle the Media Messages in the Tray-to-Tray Mode (PCL)

Procedure

1. A message on the control panel indicates that a media is missing. Select one of the following

actions as a response to the message.

* Press [Assign medial.
Continue with step two when you select this option.

* Press [Continuel.

* Press [Cancel stream].
The print job is stopped. You can now solve the problem. You will most likely be able to solve
the problem on the server.

L@ NOTE

The following steps two and three apply only when you chose to assign a media.

2. From the list of media, select the media that will be used as the media the controller is asking for
and touch [OK].

The media will now be displayed with the name that is defined in the media catalog.

If you do not select media from the media catalog with the requested size or name, the printer
will select a media with the default size.

Select the paper tray where you want to load the required media and touch [OK].

Load the media.

Close the paper tray.

Press [OKI.

Now you can assign other media or continue the print job.

o g Ww
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The Copy Function

The Copy Function

Introduction to the Copy Function

Introduction

The copy function enables you to copy paper originals. You can define the settings of the copy
jobs manually or by using templates. Templates contain predefined settings for recurring types of

copy jobs.

The copy function contains a number of factory default templates, for example for copying
mixed-size originals or combining several sets of originals. Furthermore, you can define
customized templates. The factory default templates are directly available when you access the
copy function. When you select one of these templates, the system sets the typical settings for
the selected type of copy job automatically. Next you can define all other settings for the originals
and the output.

The illustration and the table below show the factory default templates you can use to start a

copy job.

lllustration

[%) copyscan

5

NS

Combined copy job

\}
Booklet job

PDF viewing archiving
300 dpi

&

0

/,/\
Ry
R

N TIFF viewing archiving
M Seanto e s o et

PDF printing 600 dpi

@ Schedule

Jobs

=| Trays

% System

[44] Start a copy job
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The Factory Default Templates

Overview of the templates

[Copy job]

[Combined copy jobl

[To DocBox]

NOTE

[To DocBoxlis
only visible when
your system is
equipped with
the optional Doc-
Box function.

[Booklet jobl

[Last used]

[Mixed size]

Copy originals that have the same media size and only require
simple settings, for example two-sided or a staple.

Combine several sets of originals with the same or mixed media
size, and create one single copy job.

When you select this template, the possibility to add subsets is al-
ready displayed.

Send the job to the DocBox to get extended possibilities to pro-
grammed each page separately.

When you select this template, the destination of the copy job is
set to the first available DocBox. The destination is always set to
this DocBox, even when a different copy job destination has been
defined for the active workflow profile.

However, you can change the DocBox to which the job must be
sent.

Create booklets from paper originals.

When you select this template:

» The [Layout] setting is set to [Booklet], and

+ The [Media] setting is set to A3/Tabloid, because the system as-
sumes you want to create booklets of A4/LTR originals.

Reuse the settings of the previous copy job for your new copy job.

NOTE
You cannot use [Last used] when the previous job was a
scan job or a combined copy job.

Copy a set of originals that consists of different media sizes. The
output will also consist of these different media sizes.

Canon varioPRINT 135 Series
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Scanning Information

Introduction

You can place an original either vertically or horizontally. Always align the top edge of your
original with the back edge of the glass plate (by the arrow in the top left corner) or the back edge
of the ADF.

The size of the original is automatically detected, and the document is scanned.

The machine cannot always detect the size of the original if it is a non-standard paper size, such
as a book. In this case, specify the size of the original.

Orientation on the Glass Plate
When you put an original on the glass plate, always put the original face down on the glass plate.

NOTE

If the top edge of the original is not aligned with the back edge of the glass plate (by the arrow in
the top left corner), your original may not be scanned correctly.

Placement on the glass plate

T

Vertical placement

e

] N

|

Horizontal placement

Orientation in the ADF

Placement in the ADF

Vertical placement
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Plcoman i

Horizontal placement

]

AnC

Placement of the Originals

You can place originals of the following sizes either vertically or horizontally. However, the
scanning speed for horizontally placed originals is somewhat slower than that of vertically placed

originals. Place originals horizontally when you copy with a preset zoom, for example when you
enlarge an A4 original to A3 paper.

NOTE
You must always place A3, B4, B6 and 11" x 17" originals horizontally.
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Copy or Scan Originals Using the Glass Plate

Introduction

Use the glass plate to copy or scan bound originals (such as books and magazines), heavy or
lightweight originals, and transparencies. Also place originals on the glass plate when you want
to copy an A3 original with an image that extends all the way to the edges without the periphery
of the original being cut off.

CAUTION
Do not press down hard on the ADF when you use the glass plate to copy thick books. Doing so
may damage the glass plate and result in personal injury.

NOTE

The scanner automatically detects the following sizes of originals (after you closed the ADF): A5,
Statement 5.5"x8.5", B5, A4, A4R, Letter 8.5"x11", LetterR, B4R, B5R, LegalR 8.5"x14", A3R,
TabloidR 11"x17", B6.

Copy originals on the glass plate

N =

1 Open the ADF.

NOTE

Open the ADF at least 300 mm
(11.8"). Otherwise, the size of
the originals may not be detec-
ted correctly.

Sensor

2 Place one original face down on the glass
plate.
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3 Align the top edge of your original with I 1
the back edge of the glass plate (by the l _ I
arrow in the upper-left corner).

NOTE

When you enlarge an A4 or A5
original onto A3 paper, place
the original horizontally on the
glass plate, and align it with the
A4R or A5R marks.

Z@ NOTE

When you enlarge a Letter or
Statement original onto 11"x17"
or Legal paper, place the origi-
nal horizontally on the glass
plate, and align it with the Let-
terR or StatementR marks.

4 Gently close the ADF to prevent personal
injury or damage to the scanner.

5 Define the copy or scan settings on the
control panel and touch [Start]

6 When the copy or scan job is ready, open
the ADF and remove the original from the
glass plate.

7 Gently close the ADF to prevent personal

injury or damage to the scanner.
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Copy or Scan Originals Using the ADF

Introduction

Use the ADF to copy or scan a set of up to 300 originals. The scanner automatically feeds the
originals to the glass plate and scans them. Two-sided originals can be scanned as two-sided
documents.

Do not place the following types of originals into the ADF:

« Thin originals, when the scanner is located in an environment with high temperatures or high
humidity.

» Torn originals or originals with large binding holes.

« Severely curled originals or originals with sharp folds.

» Clipped or stapled originals.

e Carbon backed paper.

* Transparencies and other highly transparent originals.

* Any other originals which may not feed smoothly.

NOTE
Z@ Always smooth out any folds in your originals before placing them into the ADF.

Copy originals in the ADF

1 Adjust the paper guides to fit the size of
your originals.

2 Neatly place your originals with the side
to be copied face up into the originals
tray.

Place your originals as far into the ADF as
possible until the originals indicator is lit.

3 Define the copy or scan settings on the
control panel, and touch [Start]

4 When scanning is complete, remove the
originals from the original output area to
avoid paper jams.
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Access Other Functions During a Copy Job or Scan Job

Introduction

When you access the copy function or scan function from the [Copy/Scan] view, the job window
opens in full screen mode. Therefore, the buttons that give access to the other system functions
are not visible. However, you can access the other functions while you define the settings for
your copy job or scan job.

NOTE
The machine will remember all the job settings you already defined.

Procedure

1. In the job window on the control panel, touch [Minimize].

The [Copy/Scan] view appears. The navigation buttons at the bottom of the control panel become
visible and accessible.

Carry out the desired actions.

To get back to your job window, touch [Jobs].

4. Press [Resume job].

wn
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Copy Your Documents

Description of the Copy Job Settings

Introduction

When you make a copy, you can define the following.
* How the originals look.

* How the output must look.
* Generic settings for the whole job.

To improve the productivity, the system defines a number of logical settings for the [Original]l and
the [Output] automatically. However, you can overrule these automated settings manually. The
automated settings have the prefix [Autol.

Illustration

[* Copy job
Original 1 | Job 3)
I
1- or 2-sided | Criginal type Size | Background | | Number of sets Job name Separator sheets
Copy job 8 Off
= D & % 1 =
Auto: 1-sided Auto: Portrait left A4 Suppression: 0 Esanaten
e Scheduled jobs
Output (2 )
1- or 2-sided Binding edge Media Cover
& ] 0 )
ol
Auto: 1-sided Auto: Portrait left Auto: Off @
A4 off
Layaout | Zoom Align Shift
1 |
Q | w | + |
v |
Normal Fit to page: Auto: Top left Front: 0, 0, O |
100% Back: 0, 0,0 |
Print delivery Margin erase Adjust image | Color fBlack & white E
@  —
(4 =] 9 o | —
Auto: Stacker /stapl... 0 C8B: 0,0 Caolor I ——
0 Color: 0,0 N —
Binding Folding Trimming Punching |
. E{Pﬁ F |
& Bx =X
Method: None Folding: None None Punching: Mone
Save as template @ Minimize ‘ Subsets ‘ i Q,_ ‘ Cancel

[45] The copy job settings

e bwein

1 [Originall

The [Original]l section contains the settings to define
how the original looks.
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e Dmein

2 [Output] The [Output] section contains the settings available to
define how the resulting copy must look.

NOTE

All the settings have a fixed position. If a set-
ting is not possible, then the location of that
setting is empty. Example: The [Trimming] set-
ting is only be available when you have a trim-
mer. Otherwise, the location of the [Trimming]
setting is empty.

3 [Job] The [Job] section enables you to define generic proper-
ties for the whole job.

4 Preview The preview section shows the result of the settings de-
fined for the output.

5  Action buttons The buttons in this section allow you to select actions,
for example, save settings to a template, cancel a job, or
start scanning.

With the optional [Page programming] function, you can
insert pages and define the media and finishing settings
for the page ranges in a job.

[Original] Settings - [1- or 2-sided]

Soing ——awes  Dmeion

[1- or 2-sided] The automatically set value for this setting.

Only the front side contains an image or text.

I

[1-sided]

Both the front side and the back side contain an im-
age or text.

[2-sided]
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[Original] Settings - [Original typel

Soing ——awos Do

[Original typel

[Original] Settings - [Size]

2]

[Portrait left]

o
W

[Portrait top]

[T

[Landscape left]

[Landscape top]

The automatically set value for this setting.

» The original has a vertical format (height >
width).

« The binding edge is at the left-hand side.

* When you turn a sheet over the binding edge,
the image or text on the back of the sheet is in
readable form.

» The original has a vertical format (height >
width).

* The binding edge of the original is at the top.

* When you turn a sheet over the binding edge,
the image or text on the back of the sheet is in
readable form.

» The original has a horizontal format (width >
height).

+ The binding edge of the original is at the left-
hand side.

* When you turn a sheet over the binding edge,
the image or text on the back of the sheet is in
readable form.

* The original has a horizontal format (width >
height).

* The binding edge of the original is at the top.

* When you turn a sheet over the binding edge,
the image or text on the back side of the sheet is
in readable form.

Soing —awos —Dspion

[Size]

A4, A3, Letter,

Original in the ADF or on the glass plate:
» Automatic size detection, or

* Enter the media format of the original.

When your original has a non-standard size, you can use

Tabloid, etc. the - and + buttons to enter the exact measures. You can
enter the measures in steps of 1 mm/0.01". The text of
the[Size] button changes into [Custom].

— » Automatic orientation detection, or
D| * Indicate the orientation of nonstandard size media
[Portrait]
[
[Landscapel
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[Original] Settings - [Image typel

Soing ———aws  Dmeion

[Image typel The original contains a combination of text and im-
ﬁ ages.
[Mixed]
@ The original contains mainly or only images.
[Photo]
The original contains mainly or only text.
A
[Text]
7. The original contains an image with lots of details.
[High detail]

[Output] Settings - [1- or 2-sided]

[1- or 2-sided] The automatically set value for this setting.

[Auto]

The output contains an image on one side.

]

[1-sided]

The output contains an image on both sides.

[2-sided]
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[Output] Settings - [Binding edge]

Soing Vs omaion

[Binding edgel The automatically set value for this setting.
[Auto]
e + The output has a vertical format (height >
£ width).

* The binding edge is at the left-hand side.
[Portrait left] + When you turn a sheet over the binding edge,
the image or text on the back of the sheet is in
readable form.

ﬂ * The output has a vertical format (height >
m width).
* The binding edge of the print is at the top.
[Portrait top] « When you turn a sheet over the binding edge

the image on the back side of the sheet is in
readable form. This means that every back side
of a two-sided print is upside down compared to
the front side.

» The output has a horizontal format (width >
- height).
+ The binding edge of the print is on the left side.
[Landscape left] « When you turn a sheet over the binding edge,
the text or image is in readable form.

[_'I * The output has a horizontal format (width >
m height).
* The binding edge of the print is at the top.
[Landscape top] « When you turn a sheet over the binding edge,
the image on the back side of the sheet is in
readable form. This means that every back side
of a two-sided print is upside down compared to
the front side.

[Output] Settings - [Media]

Soing Vi omaion

[Medial Names of the media Here you can select the media for the copy job.
in the media cata- The list displays all the media that are available in
logue the media catalogue. The media catalog is a list of

media that you can define in the Settings Editor
application on the PRISMAsync controller.
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[Output] Settings - [Cover]

Soing Ve omain

[Coverl] E{i=”

[Front]
[Media]

[Print sides]

[Back cover]

[Media]

[Print sides]

Here you can indicate that the print job requires a
front cover. When the setting is enabled the corre-
sponding setting [Media] becomes enabled.

When the setting [Front cover] is enabled, you can
select a media from the media catalogue.

Here you can select the sides of the front cover
you want to print on.

« [Both sides]

 [Front side]

» [Back side]

* [Nonel

Here you can indicate that the print job requires a
back cover. When the setting is enabled the corre-
sponding setting [Media] becomes enabled.

When the setting [Back cover] is enabled, you can
select a media from the media catalogue.

Here you can select the sides of the back cover you
want to print on.

* [Both sides]

 [Front side]

« [Back sidel

* [Nonel
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[Output] Settings - [Layout]

Soing Vs omain

[Layout] B= The machine prints the pages with no special lay-
é_; out settings.
[Normal]
= The machine prints the pages in booklet order. The
E = pages one and four are printed on the front side of
a sheet. The pages two and three are printed on
[Booklet] the back side of a sheet.
E5p The machine prints the same image multiple times
E—l next to each other. By default, the system keeps

the size of the originals.

[Same up] When you copy A4/LTR originals with the setting
[Same up] and [Images per sheet] is two, the ma-
chine will automatically print the job on A3/ 11" x
17", for example. When you cut the A3/ 11"x 17"
sheets in two, you get two identical A4 /LTR cop-
ies of your document. To reduce your A4/LTR orig-
inals to A5/STMT prints, you can use the zoom
function or select another media type.

The machine prints multiple consecutive images

B51
—;—2 on one side of a sheet, next to each other.
[Multiple up]
e The machine prints the same image twice on one
I—E=g side of a sheet, but one image is upside down

compared to the other.
[Same-up flipped]

[Images per sheet] Here, you can select the number of images you
want to print when you select [Same up] or [Multi-
ple upl.

[Output] Settings - [Zoom]

[Zoom] [Fit to pagel When [Fit to page] is [On], the image is resized so
it fits onto the page.
When [Fit to page] is [Off], the original size of the
image is maintained.

[Percent] Use the + and - buttons to reduce or enlarge the
size of the image (from 25% to 400%). The preview
pane immediately shows the results of your ac-
tion.
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[Output] Settings - [Align]

Soing Ve omaion

[Align]

[Auto]

’T

[Top left]

T

[Top center]

A

[Top right]

&

[Center left]

i
AR

[Center]

N

[Center right]

54

[Bottom left]

¥

[Bottom center]

p|

[Bottom right]

The automatically set value for this setting.

The [Align] setting allows you to indicate the posi-
tion of the image on the sheet. [Top left] moves
the image to the upper left corner of the sheet.

[Top center] moves the image to the center at the
top of the sheet.

[Top right] moves the image to the upper right cor-
ner of the sheet.

[Center left] moves the image to center of the left
side of the sheet.

[Center] moves the image to the center of the
sheet.

[Center right] moves the image to the center of the
right side of the sheet.

[Bottom left] moves the image to the lower left
corner of the sheet.

[Bottom center] moves the image to the center of
the bottom side of the sheet.

[Bottom right] moves the image to the lower right
corner of the sheet.
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[Output] Settings - [Shift]

Soing Vi omaion

[Shift] [Margin shift]

[Image shift]

Use this setting to increase or decrease the mar-
gin. By default, the values of the front side and the
back side are interlocked. This means that the val-
ues for the front side and the back side remain
identical.

Widening the margin can be useful if you want to
staple or punch the output, for example. Narrow-
ing the margin can be useful if you do not need
additional space for stapling or punching the out-
put, for example.

If you want to define a different value for each
side, press i. The icon changes to the unlocked sta-
tus. Now you can define the values for the front
side and the back side separately.

Use this setting to shift the image horizontally or
vertically. By default, the values of the front side
and the back side are interlocked. This means that
the values for the front side and the back side re-
main identical.

If you want to define a different value for each
side, press i. The icon changes to the unlocked sta-
tus. Now you can define the values for the front
side and the back side separately.
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[Output] Settings - [Print delivery]

Soting s omsapion

[Print delivery] [Output loca-
1 tion]

[Sort]

[Offset stack-
ing]

Select the output location for the job. Depending on the set-
tings for your copy job, the machine automatically suggests
the preferred output location for your job. However, you can
manually overrule this suggestion.
» [Stacker/stapler upper trayl

Deliver the prints at the upper tray of the stacker/stapler.
« [Stacker/stapler lower tray]

Deliver the prints at the lower tray of the stacker/stapler.
 [Stacker/stapler booklet tray]

Deliver the prints at the booklet tray of the stacker/stapler.
* [Folder main tray]

Deliver the folded prints to the tray at the bottom of the

folder.

1111

[By pagel
The output is sorted by page.

123

[By set]
The output is sorted by set.

This setting is only available when the [Offset stacking] set-
ting is set to [Sets (as in job)] in the workflow profile.

e

e

e

b =
[Each set]
Each set delivered to an output location will have a small
shift on top of the previous set. This makes it easier to rec-

ognize individual sets.

=
=
—
=

[Off]

All the sets or jobs that get to an output location are stacked

in a straight stack.
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Soing —_awos Do

[Print delivery] [Advanced set-
2 tings] -> [Sheet
123

order]

[Face up]
Deliver the prints face up, first sheet on top.

[32‘1

[Face up reverse]
Deliver the prints face up, last sheet on top.

[1'23

[Face down]
Deliver the prints face down, first sheet on top.

[321

[Face down reverse]
Deliver the prints face down, last sheet on top.
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Soing —awos Do

[Print delivery] = [Advanced set- =
3 tings] -> [Sheet +
orientation]

[Header up LEF]
Deliver the prints with the header on top side and in portrait
position (vertical).

N

[Header up SEF]
Deliver the prints with the header on top side and in land-
scape position (horizontal).

4

[Header down LEF]
Deliver the prints with the header at the bottom side and in
portrait position (vertical).

&

[Header down SEF]
Deliver the prints with the header at the bottom side and in
landscape position (horizontal).

[Advanced set- + [Front/back]
tings] -> [Print Default value. The front page on the front, the back page
order] on the back.
» [Back/front]
Puts the front page on the back and the back page on the
front.

[Advanced set- -« [0 degrees]
tings] -> [Rota- + [180 degrees]
tion] Rotates the prints 180 degrees.

[Output] Settings - [Margin erase]

A [Binding edge] Margins of a document sometimes contain notes

= or punch holes, for example. The machine allows
. you to hide these elements on the copy. With the +
[Margin erase] and - buttons of the [Binding edge] setting you can

define how much margin of the original you want
to erase. You can enter a value up to 100 mm /
3.94",
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[Output] Settings - [Exposure]

Soing Vs omaion

[Exposure] [Dark] You can adjust the settings for light areas and dark
areas on the print separately.
* When an area on the output must be darker,
then select a value of -1 to -3.
* When the area must be lighter, then select a val-
ue of 1to 3.

[Light] * When the area must be darker, then select a val-
ue of -1to -3.
* When an area on the output must be lighter,
then select a value of 1 to 3.

[Output] Settings - [Binding]

Soing Vs omain

[Binding] [Nonel Here you can define the required number of sta-

ples. Furthermore you can define where you want

=) the stap.les with th(? [Location] option.
The available locations for one staple:

[1 staple] * [Top left]
* [Top right]

D + [Bottom left]

D

* [Bottom right]

[2 staples] The available locations for two staples:
+ [Left edgel

' « [Top edgel

| » [Bottom edge]
» [Right edgel]

[Saddle stitching] Check the preview for the result of the selection.

[Output] Settings - [Folding]

This option is only available when you have a folding unit connected.
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[Folding] F
'~

[None]
Required output location for Z-folded A4R, LetterR
and Legal:
* Folder output tray, or
« Any output tray of the stacker/stapler.
[Z-fold] NOTE

Z-folded A3, B4 and Tabloid 11" x 17"
sheets must be sent to the stacker/
stapler.

Required output location for Z-folded A3, B4 and
Tabloid 11" x 17": Any output tray of the stacker/
stapler.

[Z-fold large sheets
only]

Required output location: Folder output tray

[Tri-fold in]

Required output location: Folder output tray

[Tri-fold out]

Required output location: Folder output tray

[Parallel fold]

[Print method] Use the [Print method] option to define on which
side to print:
* [Print inside]
 [Print outside]

Check the preview for the result of the selection.

[Output] Settings - [Trimming]

This option is only available when you have a trimming unit connected.
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Soing oo Dmein

[Trimming] [Nonel No trimming of the document.
b You can indicate the amount of trimming at
. the long edge and short edge (from 2.0 mm to
' 20.0 mm/0.08" - 0.80")
[Trim size]
You can indicate the size of the resulting docu-

ment after trimming. You can either touch
[Size] to select a default media size or manual-
[Finishing sizel ly define the width and length of the docu-
ment. When you define a non-standard media
size, the [Size] box displays [Custom].

[Output] Settings - [Punching]

This option is only available when you have a punching unit connected.

Soing oo Dmein

[Punching] ,—] Here you can select the required number and
: the location of the punch holes.
S Location:
[None] . [Lef‘t]
" * [Topl
+ [Right]
G * [Bottom]
[2 holes]
[3 holes]
[4 holes]

*Eeee

[Die set dependent]
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[Number of sets]

Soing ———Naws —owain

[Number of sets] [Check first set]

[Number of sets]

Job name

Soing ——awes Do

[Job name]

When the [Check first set] setting is enabled,
the printer stops after the first set of a job has
been printed. You can check the quality of the
output.

NOTE

This setting is only available when in
the workflow profile [Check first set]
is set to [As in job].

You can indicate how many copies of the job
you need. You can enter a value from 1 -
65,000. The default value is 1.

To identify your job more easily, you can change
the name of the job. When you touch the [Job
name] button a keyboard appears. Then you can
change the name of the job.

U:|
Original
1-or 2-sided eets
<§ 2 eco <}=' Backspace off
L-sided
Output
1-or 2-sided
1-sided
Layout =
ayoul
8 a 5 d f g h 3] k |
z ‘ X ‘ 4 ‘ v ‘ b ‘ n ‘ m ‘ @asg ‘
Print delivery
Stacker stay
r’shga 9 Caps Lock Spacebar ‘
Binding
O A
vV oK Cancel
Method: None
Location: No stay
Minimize ‘ Cancel | Subsets z

[46] Change the job name
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[Destination]

Soing oo Dmwion

[Destination] [Scheduled jobs] Add the copy job to the list of [Scheduled jobs] in
the [Jobs] view.

[Waiting jobs] Add the copy job to the list or [Waiting jobs] in the
[Jobs] view.
[DocBox] Add the copy job to the [DocBox] (if licensed).

[Separator sheets]

[Separator sheets] [On] When the [Separator sheets] setting is enabled, a
separate sheet is inserted automatically before
each set of a job to create a clear distinction be-
tween two sets. Separator sheets are always emp-
ty. In the Settings Editor, select a media from the
media catalog use as separator sheets. You can al-
so indicate the feed direction of the separator
sheets (long-edge feed or short-edge feed).

[Off] No separator sheet will be inserted before each set.
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Make a Basic Copy

Introduction

A basic copy is a copy for which you only define a few settings before touching the Start button
@, such as:

* One-sided or two-sided

* Astaple

+ The number of copies required.

Before you begin

* Remove staples or paper clips.

+ Make sure that the automatic document feeder (ADF) contains maximum 300 sheets (80 g/m?2
or 20 Ib bond).

* Make sure that the originals are not curled.

lHlustration

[&x CopyiScan

A i,
_f g
) - 8= y
e ’ P /
<<V :‘
Combined copy job To DacBox Booklet job
-
Copyi/Scan
2]

0%‘ PDF viewing archiving
300 dpi

@ Schedule Jobs I=l| Trays % System

[47] Make a basic copy

Procedure

1. Place the originals face up into the automatic document feeder (ADF), or place one original face
down on the glass plate.

On the control panel, touch [Jobs] -> [Copy/Scan] -> [Copy job].

If required, define the settings and the required number of copies.

Select [Scheduled jobs] in the [Destination] field to start copying immediately.

Press .

The job is added to the list of [Scheduled jobs].

as0wnN
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Create templates to use for recurring jobs

Introduction

When you regularly carry out identical copy or scan jobs, you can create custom templates for
them. The custom templates contain the default settings for these jobs.

Procedure
1. Touch [Jobs] -> [Copy/Scan].
2. Select an existing copy or scan job template.
3. Make the required settings for the recurring job.
4. Touch [Save as template] to save the settings to a custom template.
5. Enter the name of the custom template and touch [OKI.
6. Press [Cancell.

The custom template is now available at [Jobs] -> [Copy/Scan].
7. To edit the template, touch the custom template for 2 seconds.

You can now select the following options.

* [Renamel.

* [Movel.
Touch a blue line in front of a template to indicate the new location.
The location of the [Last used] template is set.

» [Delete]

NOTE
Touch the [Last used] template for 2 seconds to save the settings of the last job to a template.
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Copy Non-Standard Size Originals

Introduction

The scanner can detect the following media sizes automatically:

« A3R + A3R

- A4 « A4

« A4R « A4R

« A5 « Ab

« B4R « A5R

« B5 « B4R

« B5R « B5

- B6 « B5R

« Statement 5.5" x8.5"  B6R

* Letter 8.5" x 11" » Statement 5.5" x 8.5"
* LetterR 11"x 8.5" » StatementR

* LegalR 8.5" x14" + Letter8.5"x 11"

e TabloidR 11" x 17" + LetterR 11" x 8.5"

* LegalR 8.5" x 14"
+ TabloidR 11" x 17"

When you copy originals with a different size, you must enter the correct measures manually.
The ADF supports originals of 140 mm x 128 mm - 630 mm x 304.8 mm (5.5"x 5" - 24.9" x 12").

The glass plate supports originals of 10 mm x 10 mm - 432 mm x 297mm (0.4" x 0.4" - 17" x
11.7").

Procedure

1. Place the originals face up into the automatic document feeder (ADF), or place one original face
down on the glass plate.

2. On the control panel, touch [Jobs] -> [Copy/Scan] -> [Copy job].

3. Inthe [Original] section, touch [Size].

4. Use the - and + buttons to enter the correct media size.

5. Press [OKI.
The [Size] button displays the defined size.

6. Inthe [Output] section, touch [Medial.

7. Select a media from the list and touch [OK].

The setting [Zoom] determines how the copy will look. When [Zoom] ->[Fit to page] is enabled,
the original will be scaled to fit the media size of the output. When [Zoom] -> [Fit to pagel is
disabled, you can enter a custom zoom percentage.
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The Zoom Behavior

Introduction

&

When you carry out a copy job or scan job, you can use the [Zoom] function to reduce or enlarge

an image, for example:

* Copy an A4 original on an A3 sheet. The system enlarges the image.

* Copy an A3 original on an A4 sheet. The system reduces the image.

+ Copy an A4 original with a small illustration on an A4 sheet, and at the same time enlarge the
illustration.

By factory default, the [Zoom] function is set to [Fit to page]. To change the zoom factor
manually, touch the - and + buttons of the [Zoom] function.

The zoom function for originals in the automatic document feeder is different from the zoom
function for originals on the glass plate.

Zoom behavior

m Starting point of the zoom function

Automatic document feeder Center
Glass plate Upper left-hand corner
NOTE

The zoom function works identical for both copy jobs and scan jobs.

How to Use the Zoom Function for a Scan from the ADF

The following table shows the zoom behavior of the machine when the originals are scanned
from the automatic document feeder. The focus is on the centre of the original.

Scan from the automatic document feeder using the zoom function

S isrion —ospion

The original is placed face-down and in readable form into the au-

:"7 ! tomatic document feeder.
l___ | The center of the original is a fixed point and is used as the origin
of the image.

F 4
e Result of a scan with a 100% zoom factor.

Result of a scan with a 50% zoom factor.

NOTE

The center of the image is fixed.

Result of a scan with a 200% zoom factor.

e NOTE

The center of the image is fixed.
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How to Use the Zoom Function for a Scan from the Glass Plate

The following table shows the zoom behavior of the machine when the originals are scanned
from the glass plate. The focus is on the upper right-hand corner of the original (upper left-hand
corner of the glass plate).

Scan from the glass plate using the zoom function

N | The original is placed face-down and in readable form in the upper
: left-hand corner on the glass plate.

T The upper left-hand corner of the glass plate is a fixed point and is
used as the origin of the image.

Result on paper of a scan with a 100% zoom factor.

E Result on paper of a scan with a 50% zoom factor.

NOTE
The upper right-hand corner of the image is fixed.

- Result on paper of a scan with a 200% zoom factor.

e NOTE

The upper right-hand corner of the image is fixed.
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Staple, Punch, Fold, or Trim the Output

NOTE
When you make one copy of one original, stapling is not possible.

Procedure

1.

©oNOO~WN

Place the originals face up into the automatic document feeder (ADF), or place one original face
down on the glass plate.

On the control panel, touch [Jobs] -> [Copy/Scan] -> [Copy job].

At the [Binding] setting, select the required number of staples and the location of the staples.
At the [Punching] setting, select the required number of holes.

At the [Folding] setting, select the folding method.

At the [Trimming] setting, define the trim settings

If required, define the other settings for the original document and the output.

Enter the generic values in the [Job] section.

Touch [Start]
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Rename a Copy Job

Introduction

When you carry out a new copy job, the system creates an automatic name for the job. The
default name 'Copy Job' followed by a sequence number is displayed in the [Job name] field.
However, you can rename the copy job into a name of your choice. This name helps you to
recognize the job in the list of [Scheduled jobs], [Waiting jobs] or in the [DocBox] (optional).

Procedure
1. Inthe job window on the control panel, touch [Job name].
A keyboard appears.
2. Touch and hold 'Backspace' until the current name is deleted.
3. Enter a new name.
4. Press [OK].
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Combining subsets into one document

Introduction

You can copy or scan several sets of originals to one document or file with subsets. With the

optional [Page programming] function, you can add pages, for example, tab sheets, and define
the media and finishing settings for each page and subset.

Procedure

1

&

g

8.

9.
10.

Place the first subset face up into the ADF.
Touch [Jobs] -> [Copy/Scan] -> [Combined copy job].
Define the subset settings for both in the [Original] and [Output].

NOTE

Some settings that you define for the first subset apply to the whole job, the [Type] and
[Resolution] settings, for example. These settings are fixed and are grayed out after scanning the
first subset.

Press [Scan].

Put the next subset into the automatic document feeder or on the glass plate.
Repeat steps 3 to 5 for all subsequent subsets.

A number indicates the order in which the subsets have been scanned.

NOTE
When you combine 1-sided and 2-sided originals, you can define whether a new subset must
continue on a new sheet or on the previous sheet.

Touch [Ready] when the last subset is scanned and processed.

A full overview of all the scanned subsets appears in the right-hand pane. If required, you can
add, insert, delete or edit subsets.

If required, use the optional [Page programming] function to insert pages and define the media
and finishing settings per page range.

Touch [Ready] again to close the [Page programming] function.

Press

242

Chapter 7 - Carry Out Copy Jobs

Canon varioPRINT 135 Series



Insert Tab Sheets to Divide Your Document

Insert Tab Sheets to Divide Your Document

Introduction

If you want to use tab sheets to create a physical division in your document, you must treat the
copy job as a combined copy job. The tab sheets will be processed as inserts.

Before you begin

* Make sure that you split up your original document into the parts (subsets) that must be
preceded by tab sheets.
* Make sure that you load the required tab sheets into a paper tray or into the optional inserter

module.
lllustration
i a ‘ D:}

Original %

Add

Pages | Media
A4 Tab Insert
12 243 tab inclusive, insert, 80 g/?, White

Output

D Normal A4
34 24D, 80 g, White
B A4Tab Insert

24D, tab inciusive, insert, 80 g, White

H Normal A4
78 a4, 80 g, whie

N A4 Tab Insert

810 A4[D. tab nclusive, insert, 80 g/, White

D Normal A4
112 24D, 80 gim?, White

I N N N

Minimize ‘ Cancel ‘ Ready

[48] Insert tab sheets

Procedure

1. Place the first subset face up into the automatic document feeder (ADF), or place one original face
down on the glass plate.

On the control panel, touch [Jobs] -> [Copy/Scan] -> [Combined copy job].
Define the settings for the subset (both in the [Original] and [Output] section).
Press

Place the next subset face up into the ADF, or face down on the glass plate.
Repeat the steps three and four for all subsequent subsets.

Touch [Ready] when all subsets were scanned.

Press [Edit].

A preview pane displays the scanned subsets.

9. Touch the subset before which you want to insert the first tab sheet.

ONog~LN
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The selected subset is highlighted.
10. Press [Insert].
11. In the settings pane, touch [Media] and select a tab media.
12. Press
13. Press [Readyl.
14. Press [Edit].
15. Repeat the steps nine to fourteen until all the tab sheets were inserted.
16. Touch [Ready] when all the tab sheets were inserted.
17. Define the general job settings such as [Number of sets].
18. Press
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Scan Now and Print Later

Introduction

You can scan an original document now and print the document later (postponed copying). To

use this function, you must send a copy job to the list of [Waiting jobs] or to the [DocBox]
(optional).

When to do

You must only change the destination to [Waiting jobs] or [DocBox] (optional) when the default
destination of copy jobs is [Scheduled jobs]. The default destination of copy jobs is defined in the
workflow profiles.

Procedure

1.

o0 eWwN

Place the originals face up into the automatic document feeder (ADF), or place one original face
down on the glass plate.

On the control panel, touch [Jobs] -> [Copy/Scan] -> [Copy job] or [Combined copy job].

Define the settings for your copy job.

Touch [Destination] to select [Waiting jobs] or [DocBox] (optional).

If required, touch [Job name] to rename the job. This helps you to recognize the job more easily.
Touch [Start]

The job is sent to the selected destination. There you can select the job whenever you want to
print it.
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Configure the Scan Function

Introduction to the Scan Function

Definition

The scan function enables you to create digital documents from paper originals. You can scan
paper originals from the automatic document feeder (ADF) and from the glass plate of the
scanner.

Scan Types and Output Locations

NOTE

The scan function requires a software license. If you have a license, scan to file, scan to SMB,
scan to email and scan to USB are available. Scan to DocBox requires an additional software
license for the DocBox function.

Scan types and output locations

Scan type Output location

Scan to file FTP server
Scan to SMB SMB server
Scan to email SMTP server. The file is attached to an email
message.
Scan to USB USB flash drive
Scan to DocBox PRISMAsync controller
Condition

The customer must have a fully configured FTP, SMB and SMTP server available. The settings in
the Settings Editor are used to connect the printer to the customer's FTP, SMB and SMTP server.

Configuration

To use the scan-to-file, scan-to-SMB and scan-to-email functions, the following items must be

configured in the Settings Editor on the PRISMAsync controller.

» Scan to file ([Configuration] -> [Connectivity])

« Scan to SMB ([Workflow] -> [SMB shares])

« Scan to email ([Configuration] -> [Connectivity])

» LDAP server ([Configuration] -> [Connectivity]), if available. Otherwise, you can use an address
list file (ral.csv) to search for recipients.

» A scan profiles file (sjt.csv) in which the scan-to-email and scan-to-file templates are defined
([Workflow] -> [Scan profiles]).

248 Chapter 8 - Carry Out Scan Jobs
Canon varioPRINT 135 Series



Introduction to the Scan Function

lllustration

PDF viewing archiving
300 dpi

@ Schedule Jobs =l Trays %’ System

[49] The Copy/Scan view on the control panel

Usage

You can use the scan-to-email, scan-to-file and scan-to-SMB templates through the [Copy/Scan]
section on the control panel ([Jobs] -> [Copy/Scan]. To scan a document, select the required
template. Next, the job window opens. There you can change a number of settings for this scan
job. However, these changes are only valid for this job. The default settings of the scan template
will not change.

The scan-to-USB function is accessible through the USB button in the [Jobs] section on the
control panel. The left-hand side of the control panel contains the slot for the USB flash drive.

The scan-to-DocBox function is accessible through the [To DocBox] tile in the [Copy/Scan]
section.

Removal of Scan Jobs

The PRISMAsync controller buffers the scan jobs until the jobs are delivered to the specified

output location. You can remove scan jobs from the buffer manually or automatically.

* Manually via the printer control panel: Touch [Jobs] -> list of [Scan jobs] -> select a scan job ->
touch [Deletel.

* Manually via the Settings Editor: Access the Settings Editor -> click [Support] ->
[Troubleshooting] -> [Clean the scan job export buffer].

« Automatically: The PRISMAsync controller removes a buffered scan job automatically 48 hours
after a scan job has finished.
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Configure the Settings for Scan to File

Introduction

To use the scan-to-file function, the system administrator must configure the function in the
Settings Editor on the PRISMAsync controller ([Configuration] -> [Connectivity]). A scan job will

be sent to the FTP server configured.

How to Configure the Settings for Scan to File

The table below describes the settings that the system administrator must configure in the

Settings Editor.

Settings for scan to file in the Settings Editor

soimg o

[Connection test]

[Scan to file, scan to email and scan
to SMB enabled]

[Host name / IP address]

[Port]

[User namel

[Password]

[Destination directory]

Click [Connection test] to check if the scan-to-file func-
tion is configured correctly.

This setting must be set to [Yes] to use the scan func-
tion.

The name or IP address of the FTP server that receives
the scan jobs.

The TCP port number of the FTP server. The default val-
ue is 21.

The user name that is used to access the FTP server
when sending scan jobs.

The password that corresponds with the user name.

The directory on the FTP server to which the scan jobs
will be sent.
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Configure the Settings for Scan to SMB

Introduction

To use the scan-to-SMB function, the system administrator must enable this function in the
Settings Editor on the PRISMAsync controller ([Configuration] -> [Connectivity]). The system
administrator must add SMB shares ([Workflow] -> [SMB shares]). The maximum number of SMB
shares is 3. A scan job will be sent to the selected SMB share.

How to Configure the Settings for Scan to SMB

The table below describes the settings that the system administrator must configure in the

Settings Editor.

Settings for scan to SMB in the Settings Editor

[Scan to file, scan to email and scan
to SMB enabled]

[Name]

[Description]
[Network destination]
[Domain name]

[User namel

[Password]

[Path]

This setting must be set to [Yes] to use the scan func-
tion.

The name of the SMB share.

The description of the SMB share.
Select [Domain] or [Workgroup].
Name of the domain.

The user name that is used to access the SMB server
when sending scan jobs.

The password that corresponds with the user name.

The directory on the SMB server to which the scan jobs
will be sent.
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Configure the Settings for Scan to Email

Introduction

To use the scan-to-email function, the system administrator must configure the function in the
Settings Editor on the PRISMAsync controller ([Configuration] -> [Connectivity]). A scan job will
be sent as an attachment to the email address defined.

How to Configure the Settings for Scan to Email

The table below describes the settings that the system administrator must configure in the

Settings Editor.

Settings for scan to email in the Settings Editor

soimg T pin

[Connection test]

[Host name / IP address]

[Port]

[User namel

[Password]

[Sender]

[Maximum attachment size]

[Allow scanning to multiple email ad-
dresses]

Click [Connection test] to check if the scan-to-email func-
tion is configured correctly.

The name or IP address of the SMTP server that handles
the emails containing the scan jobs.

The TCP port number of the SMTP server. The default
value is 25.

The user name that is used to access the SMTP server
when sending scan jobs.

The password that corresponds with the user name.

The name that will be displayed as the sender of the
email that contains the scan job.

The maximum size allowed for the attached scan job in

MB. You can enter a value from 0 - 2147483647 in steps
of one. The value '0' means unlimited. The default value
is 5 MB.

When enabled you can send the scan job to one or more
email addresses. You must enter the email address on
the control panel. Separate the email addresses with ';'.
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Configure the Settings for the LDAP Server

Introduction

If the scan-to-email function is enabled, a list of user codes and matching email addresses is
required. When a user enters his/her unique code on the control panel, the scan job will be sent
to the matching email address.

The list of user codes and matching email addresses can be available at the following places:

* On an LDAP server, if available

» |f an LDAP server is unavailable, in an address list file (default name: ral.csv), which must be
uploaded to the PRISMAsync controller through the Settings Editor ([Configuration] ->
[Connectivity]).

When a user enters the user code, the system will first look for a matching email address in the
LDAP database. When the system does not find a matching email address there, or when an
LDAP server is not available, the system will search the address list file (ral.csv) for the matching
email address.

How to Configure the Settings for the LDAP Server

The table below describes the settings that the system administrator must configure in the
Settings Editor.

Settings for LDAP in the Settings Editor

[Connection test] Click [Connection test] to check if the connection to the
LDAP server works correctly.

[Enabled] This setting must be set to [Yes] to realize a connection
between the printer and the LDAP server.

[Host name / IP address] The name or IP address of the LDAP server where user
information for scan to email can be retrieved.

[Port] The TCP port number of the LDAP server. The default
value is 389.

[User name] The user name that is used to access the LDAP server.

[Password] The password that corresponds with the user name.

[Search database] The path to the LDAP directory that contains the user

identifiers, for example o=YourOrganization.

[User identification] The type of user identification that must be searched for,
for example a telephone number or employee ID.

[Email address attribute] The LDAP attribute that contains the email address of
the user, for example 'mail'.
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Use the Address List File (ral.csv)

Introduction

If an LDAP server is not available, you must use a remote address list file (ral.csv) for scan to

email. This file must contain the unique user codes and matching email addresses. The

PRISMAsync controller stores the address list file. Proceed as follows:

1. Download the file via the Settings Editor ([Configuration] -> [Connectivity], scroll down to the
[LDAP] section -> [Download address list file]).

2. Edit the file in Microsoft® Excel®, for example.

3. Upload the file via the Settings Editor ([Configuration] -> [Connectivity], scroll down to the
[LDAP] section -> [Upload address list filel).

Syntax of the Address List File

The address list file must contain a header line (mandatory) and at least one line with an email
recipient.

A"," or ";" separates the items in a record.
<CR> or <LF> separates records.
The header record shows the fields that the address list uses (ruid,address,comment).

A profile record contains the unique user codes and matching email addresses. ruid and address
are mandatory. comment is optional.

Record Items

Record items

ruid A unique user code, for example an employee number or tele-
phone number.
Maximum 20 digits. Leading zeros are allowed.

address The email address that matches the user code.
Maximum 40 characters. Do not use the characters <CR>, <LF>, ","
and ||’_||.
comments Additional information, if required.
NOTE

Do not change the header information.

Examples of Correct Profiles

* 01234,userA@companyX.com
* 56789,userB@organizationY.com
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Use the Scan Profiles File (sjt.csv)

Introduction

When the scan function is licensed, the [Copy/Scan] section on the printer operator panel displays

templates that give access to copy and scan functions. The copy templates are factory default

templates. To use scan templates, you must first create scan-to-file and scan-to-email profiles in

the scan profiles file (sjt.csv) on the PRISMAsync controller. Proceed as follows:

1. Download the file via the Settings Editor ([(Workflow] -> [Scan profiles] -> [Download scan
profiles]).

2. Edit the file in Microsoft® Excel®, for example.

3. Upload the file via the Settings Editor ([Workflow] -> [Scan profiles] -> [Upload scan profiles]).

Each scan profile consists of a combination of individual settings for specific scan jobs, either
scan to file or scan to email. The display name you define for a scan profile is shown in the [Copy/
Scan] section on the control panel.

NOTE
In the scan profiles file, you can define a maximum of 99 scan profiles.

Syntax of the Scan Profiles File

The scan profiles file must contain a header line (mandatory) and at least one line with a scan
profile.

A"," or ";" separates the items in a record.
<CR> or <LF> separates records.

The header record shows the items that the scan profile uses
(dispname,format,ilc,prefix,minnr,maxnr,name_nr_title,cfname,subfolder,postfix,OrigOrientation,
OrigDuplex,OrigKind,OrigZoom,OrigFormat,DestFormat,DestQual,DestColor).

A profile record contains the unique settings for various scan job types.
dispname,format,ilc,prefix,minnr,maxnr,name_nr_title and cfname are mandatory. The other
record items are optional.

1@ NOTE

When you leave optional items empty, the system defines the settings automatically. However,
you can change a number of settings via the control panel.

Record Items

Record items

dispname The unique name of the scan profile that is displayed in the [Copy/Scan] sec-
(display name) tion on the control panel.
Minimum 1 and maximum 40 characters. Do not use , ; <CR> <LF>.
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format The file format and compression used for the resulting scan file.

(file format) .

TIFF G31D_MH

Multi-page TIFF CCITT Group 3 1D modified Huffman compressed images
TIFF G42D_Fax

Multi-page TIFF CCITT.T6 Group 4 2D compressed images

TIFF LZW

Multi-page TIFF LZW compressed images

SINGLE TIFF G31D_MH

Single-page TIFF CCITT Group 3 1D modified Huffman compressed im-
ages

SINGLE TIFF G42D_Fax

Single-page TIFF CCITT.T6 Group 4 2D compressed images

SINGLE TIFF LZW

Single-page TIFF LZW compressed images

PDF G31 D_MH

PDF version 1.3 with Group 3 1D modified Huffman compressed images
PDF G42D_Fax

PDF version 1.3 with Group 4 2D compressed images.

PDF LZW

PDF version 1.3 with LZW compressed images

PDF JPG

PDF with JPEG compressed images

JPG

JPEG

ilc The best scan result for a specific purpose.

(Image Logic® .
characteristics)

1

600 dpi. Optimized for printing on Copy Press systems.

2

300 dpi. Optimized for viewing and archiving.

3

600 dpi at 85 Ipi. Optimized for printing on Demand Stream® and other
B&W systems.

4

600 dpi at 106 Ipi. Optimized for printing on Demand Stream® and other
B&W systems.

5

200 dpi

6

150 dpi

7

100 dpi

8

75 dpi

prefix The prefix can specify the application, for example archive or email. The pre-
(file name prefix) fix is a fixed part of the file name.
When you create a scan-to-email profile, you must use the prefix email.
Maximum eight characters. Use a-z, A-Z, 0-9, _.
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minnr
(minimum num-
ber of digits)

maxnr
(maximum num-
ber of digits)

name_nr_title
(dialogue title)

cfname
(file name feed-
back)

subfolder
(subfolder on
scan server)

postfix
(file name post-
fix)

The minimum number of digits a user must enter when the scan profile is
selected in the [Copy/Scan] section. The digits entered are stored in the file
name.

Minimum 0, maximum 20 digits.

The maximum number of digits a user must enter when the scan profile is
selected in the [Copy/Scan] section. The digits entered are stored in the file
name.

Minimum 0, maximum 20 digits.

NOTE
When minnr and maxnr are both 0, the system will not ask for a
user code.

The title of the dialogue that appears when the user must enter a code to
use the scan profile, as defined in <minnr> and <maxnr>. The title must ex-
plain to the user which number is required.

Maximum 40 characters. Do not use, ; <CR> <LF>.

Activate an additional dialogue on the control panel after starting a new
scan job to write down the generated file name. The control panel displays
the dialogue title that is defined in name_nr_title.

y: show the additional dialogue.

n: do not show the additional dialogue.

The path to a subfolder on the scan server where the files are stored.
Maximum 150 characters. Do not use * ? : < > | <CR> <LF>.

Add a postfix to the file name. For example, when the prefix is ‘'email’, you
can add an email address as a postfix.
Maximum 30 characters. Do not use /\: * ? " <> | <CR> <LF>.
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OrigOrientation ~ The default orientation and binding of the originals on the scanner.
(orientation of e portrait book
the originals) * portrait calendar

* landscape book

* landscape calendar

&l

[50] portrait book
H

[51] portrait calendar
[T
[62] landscape book

[53] landscape calendar

NOTE
You can overrule this setting on the control panel.
OrigDuplex The number of sides of the originals on the scanner that will be scanned.
(number of sides + on
of the originals The originals are scanned 2-sided
that will be scan- + off
ned) The originals are scanned 1-sided
NOTE

You can overrule this setting on the control panel.

OrigKind The image type of the originals.
(type of originals) ¢ photo
The originals contain (mainly) photos or illustrations.
¢ text
The originals contain (mainly) text.
* auto
The system chooses the best settings automatically.
* mixed
The originals contain a mixture of photos and texts.

NOTE

You can overrule this setting on the control panel.
OrigZoom The percentage by which the originals on the scanner will be increased or
(zoom of the decreased.
originals) Any value from 25 to 400.

When this item remains empty, the value is 100. Then the originals and the
output have the same size.

NOTE
You can overrule this setting on the control panel.
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OrigFormat
(paper size and
feed direction of
the originals)

DestFormat
(paper size of the
output)

DestQuality
(quality of the
output)

DestColor
(type of color of
the output)

NOTE

The paper size and feed direction of the originals on the scanner, for exam-
ple A4 lef.

Paper sizes:

- A5

+ Statement 5.5x8.5
« B5

» Letter 8.5x11

- A4

* Foolscap

* Folio

* Legal 8.5x14

- B4

+ A3

+ US Gov 8x10.5

* Tabloid 11x17

+ Commercial

» Letter Gov 8.5x10
* Legal Gov 8.5x12
* Letter 8.25x10

* Legal 8.5x13

Feed directions:
- sef (short-edge feed)
» lef (long-edge feed).

NOTE
You can overrule this setting on the control panel.

The paper size of the resulting scan file. Select a paper size from the list de-
scribed in <OrigFormat>. You cannot select a feed direction.

NOTE
You can overrule this setting on the control panel.

Define the quality as a percentage. This item is used for file types which sup-
port loss compression, JPG for example. For other file types, it is ignored.
Any value from 1 to 100.

NOTE
You can overrule this setting on the control panel.

Define the color mode of the resulting scan file, either color, grayscale or
black & white.

+ color

» grayscale

* blackAndwhite

NOTE
You can overrule this setting on the control panel.

Do not change the header information.
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Examples of Correct Profiles

* PDF printing,PDF G31D_MH,2,scanjob,0,0,,n,,,,,,...,
¢ Scan to email,PDF G31D_MH,1,email,5,5,Enter your employee number.,y,,,.....
* PRISMAaccess,PDF G31D_MH,1,Scanjob,0,0,,n,ScanLogic,,,,,,,

260 Chapter 8 - Carry Out Scan Jobs
Canon varioPRINT 135 Series



Scan Your Documents

Scan Your Documents

Description of the Scan Job Settings

Introduction

When you make a scan, you can define the following.
* How the original looks.

* How the resulting file must look.

* Generic settings for the whole job.

To improve the productivity, the system defines a number of logical settings for the [Original] and
the [Output] automatically. However, you can overrule these automated settings manually. The
automated settings have the prefix [Autol.

lllustration

" TIFF printing

Original ‘ 1 )

1-or 2-sided Original type

] M

Auto: 1-sided Auto: Portrait left

Size

A4
LEF

Background

=

Suppression: 0

Destination Job name

TIFF printing 9

]

Enter file ID

g

Type

Size

Resolution

[ Ij
TIFF Multi Page, LZW Auto: A4 300 dpi
Zoom Align

Fit to page: Auto: Top right

100%

Margin erase Adjust image Color fBlack & white
@
= 9 o
0,0 C&B: 0,0 Color
0 Color: 0, 0 sRGB

Save as template

File name: TIFF_printing_9_20131128_121628.tiff

@

s~

@ Minimize ‘ Subsets ‘ 'ﬁ‘}“ ‘ Cancel

[54] The scan job settings

e bwein

The [Originall section contains the settings to define
how the original looks.

1 [Originall

2 [Filel

The [File] section contains the settings to define how the
resulting file must look.
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sein  Dmein

3 [Jobl

4 Preview

5 Action buttons

[Original] Settings - [1- or 2-sided]

The [Job] section enables you to define generic proper-
ties for the whole job.

The preview section shows the result of the settings de-
fined for the output.

The buttons in this section allow you to select actions,
for example, save settings to a template, cancel a job, or
start scanning.

With the optional [Page programming] function, you can
insert pages and define the media and finishing settings
for the page ranges in a job. The optional [Page pro-
gramming] function is available when you scan subsets
into one file.

Soimg i Deeion

[1- or 2-sided]

il

=
@,
o
®

o

[2-sided]

The automatically set value for this setting.

Only the front side contains an image or text.

Both the front side and the back side contain an im-
age or text.
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[Original] Settings - [Original typel

Soing ——aws Do

[Original type] The automatically set value for this setting.

2]

[Portrait left]

l
L]

[Portrait top]

[&3

[Landscape left]

[Landscape top]

The original has a vertical format (height >
width).

The binding edge is at the left-hand side.
When you turn a sheet over the binding edge,
the image or text on the back of the sheet is in
readable form.

The original has a vertical format (height >
width).

The binding edge of the original is at the top.
When you turn a sheet over the binding edge,
the image or text on the back of the sheet is in
readable form.

The original has a horizontal format (width >
height).

The binding edge of the original is at the left-
hand side.

When you turn a sheet over the binding edge,
the image or text on the back of the sheet is in
readable form.

The original has a horizontal format (width >
height).

The binding edge of the original is at the top.
When you turn a sheet over the binding edge,

Canon varioPRINT 135 Series

the image or text on the back side of the sheet is
in readable form.
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[Original] Settings - [Size]

Soing s Dmion

[Size] Original in the ADF or on the glass plate:
‘ + Automatic size detection, or
* Enter the media format of the original.
When your original has a non-standard size, you

A4, A3, Letter, Ledg-

er, etc. can use the - and + buttons to enter the exact
measures. You can enter the measures in steps
of 1T mm/0.01". The text of the[Size] button
changes into [Custom].
— + Automatic orientation detection, or
D| * Indicate the orientation of nonstandard size me-
— dia
[Portrait]
[
[Landscapel

[Original] Settings - [Image typel

Soing ———awes  Dmeion

[Image typel The original contains a combination of text and im-

ﬁ ages.

[Mixed]
ﬁ The original contains mainly or only images.
[Photo]
The original contains mainly or only text.

A

[Text]

[File] Settings - [Typel]

Soing Vs omain

[Typel [Format] Select the required format.
Define the compression factor to reduce the file
fa—a% size.
[Compression] NOTE

A higher compression factor results in a
scan with lower quality.
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[File] Settings - [Resolution]

Soing Ve —omin

[Resolution] [300 dpil Select [300 dpi] when you want to view or archive
the generated file, for example.

= Select [600 dpi] when you want to print or edit the
w0 generated file, for example.

| €00 |
[600 dpi]

[File] Settings - [Size]

Soing Vs omaien

[Sizel All media sizes that = Select the media size of the resulting file.
the media catalog
supports

[File] Settings - [Zoom]

Soing Vs omaien

[Zoom] [Fit to pagel You can select a media size for the file that differs
from the media size of the original. When the [Fit
to page] setting is enabled, the system scales the
original in such a way that the image fits on the se-
lected media size of the file.

[Percent] Use this setting to change the zoom manually
within the range 25% to 400%.
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[File] Settings - [Align]

Soing ———Vaes—— omain

[Align] ‘ R

[Top left]

T

[Top centerl]

A

[Top right]

&

[Center left]

b1
AR

[Center]

Y

[Center right]

£4

[Bottom left]

¥

[Bottom center]

b

[Bottom right]

The [Align] setting allows you to indicate the posi-
tion of the image on the sheet. [Top left] moves
the image to the upper left corner of the sheet.

[Top center] moves the image to the center at the
top of the sheet.

[Top right] moves the image to the upper right cor-
ner of the sheet.

[Center left] moves the image to center of the left
side of the sheet.

[Center] moves the image to the center of the
sheet.

[Center right] moves the image to the center of the
right side of the sheet.

[Bottom left] moves the image to the lower left
corner of the sheet.

[Bottom center] moves the image to the center of
the bottom side of the sheet.

[Bottom right] moves the image to the lower right
corner of the sheet.
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[File] Settings - [Margin erase]

Soing Vi omaion

[Margin erase] [Binding edge] Margins of a document sometimes contain notes
or punch holes, for example. The machine allows
you to hide these elements on the copy. With the +
and - buttons of the [Binding edge] setting you can
define how much margin of the original you want
to erase. You can enter a value up to 100 mm /
3.94".

[File] Settings - [Exposure]

Soing Vs omain

[Exposure] [Dark] You can adjust the settings for light areas and dark
areas on the print separately.
* When an area on the output must be darker,
then select a value of -1 to -3.
* When the area must be lighter, then select a val-
ue of 1to 3.

[Light] * When the area must be darker, then select a val-
ue of -1 to -3.
* When an area on the output must be lighter,
then select a value of 1to 3.

[File] Settings - [Color/Black & white]

[Color/Black & .O Select this setting to make black & white scans.

white] [Black and white]

Select this setting to make grayscale scans. When

| :O you select this option, the [Image type] and
- [Zoom] functions are disabled. The file type auto-
matically changes into the preferred settings.
[Grayscale]

Select this setting to make color scans.

@ NOTE
. . To make color scans, the color scanning

option must be licensed.

[Color]
[Job name]
Setg Vs Desrplon
[Job name] For scan to USB, you can enter a job name.
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[Destination]

Soing s Dmeion

[Destination] For scan to USB, you can enter the destination of
the scan job on the USB drive. You can select ei-
ther the root of the USB drive, or a new folder
called ScansX, whereby X is an incrementing num-
ber. The first time you use this option, the folder
will be called Scans1.

[Enter the user code.]

Soimg ——awes  Dmeion

[Enter the user This setting applies only to scan-to-email jobs. To

code.] use the scan-to-email function, an LDAP server
must be configured. The LDAP server contains a
mapping of unique user codes and email address-
es. When you enter your user code, for example
your employee number or telephone number, the
LDAP server checks if you are a registered user. If
you are a registered user, the system sends the
scan job as an attachment to the corresponding
email address.

NOTE
The name of this button depends on the
name defined in the scan profile file.

[Account ID]

[Account ID] Enter the account ID for the current job. The [Ac-
count ID] setting is only available when the ac-
counting function on the PRISMAsync controller is
enabled.
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Scan to File

NOTE
Scanning mixed size originals is supported.

Procedure

1. Place the originals face up into the automatic document feeder (ADF), or place one original face
down on the glass plate.

2. On the control panel, touch [Jobs] -> [Copy/Scan].

3. Select a scan-to-file profile.
The job window opens.

4. Change the settings for the original and the file.

5. Touch [Start]

The scanner scans the originals. The system sends the resulting file to the scan server. The file is
stored with a predefined name in a designated directory. There is no message on the control
panel to inform you that the file was stored successfully. You can access the status information
on the controller.
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Scan to Email

Procedure
1. Place the originals face up into the automatic document feeder (ADF), or place one original face
down on the glass plate.
2. On the control panel, touch [Jobs] -> [Copy/Scan].
3. Select a scan profile.

The job window opens.

NOTE
The system administrator can create scan profiles in addition to the factory default profiles (see
Use the Scan Profiles File (sjt.csv) on page 255).

Select email as [Destination].

Change the settings for the original and the file.

If applicable, change the subject at [Email subject].

A keyboard appears to enter the subject.

At [Email address] enter an email address or user ID.

You can enter more email addresses when you configured this option in the Settings Editor (see
Configure the Settings for Scan to Email on page 252). Separate the email addresses with a ';'.
When you entered a user ID, the corresponding email address is displayed. You must configure
the connection between the ID and email address (see Configure the Settings for the LDAP Server
on page 253 and Use the Address List File (ral.csv) on page 254).

Touch [Start]

The scanner scans the originals. The system sends the resulting file to the entered email address
or email addresses.
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Scan to USB

lllustration

H:|

[T* Scan to USB

Origina
1-or 2-sided Original type | Size Background Destination Job name
Scan to USB 1
M ] & i)
L USB\SkannaustytL
Auto: 1-sided Auto: Portrait left A4 Suppression: 0
LEF
] File
Type |['size Resolution
£

POF, & Auto: A4

= - = . B _

Fit to page: 100% Auto: Top right

Margin erase Adjust image Colors

¢ °
&8 ¢ &
C88: 0,0 Color
Color: 0,0 SRGB

oo ¢

0,
0,

R
v

Minimize ’ Cancel | Subsets ‘

[55] Scan to USB

Procedure

1.

&

o

Insert a USB drive into the USB port at the left-hand side of the control panel.

Place the originals face up into the automatic document feeder (ADF), or place one original face

down on the glass plate.

On the control panel, touch [Jobs] -> [Copy/Scan] -> [Scan to USBI.
The job window opens.

Change the settings for the original and the file.

Touch [Job name] to change the default job name.

Use the keyboard to change the name, then touch [OK].

Touch [Destination] to indicate the folder on your USB drive where you want to save the file.

If applicable, enter the [Account ID].

Touch [Start]

The scanner scans the originals. The system sends the resulting file to your USB drive.
Touch = to eject the USB drive.

. Remove the USB drive from the control panel when the message [USB drive has been

successfully ejected.] displays.
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Scan to DocBox

Procedure

1. Place the originals face up into the automatic document feeder (ADF), or place one original face
down on the glass plate.

2. On the control panel, touch [Jobs] -> [Copy/Scan] -> [To DocBox].
The job window opens.

3. Change the settings for the original and the file.

4. Touch [Job name] to change the default job name.
Use the keyboard to change the name, then touch [OK].

5. Touch the [Destination] button.

6. From the drop-down menu, touch [DocBox]

7. Touch the [DocBox] button

8. Touch the DocBox to which you want to scan the job.

9. Press [OK].

10. Press [Start]

The scanner scans the originals. The system sends the resulting file to the selected DocBox.
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Scan to SMIB

Procedure

1. Place the originals face up into the automatic document feeder (ADF), or place one original face
down on the glass plate.

2. On the control panel, touch [Jobs] -> [Copy/Scan] -> [Scan to SMB].
The job window opens.

3. Change the settings for the original and the file.

4. Press [Start]
The scanner scans the originals. The system sends the resulting file to the shared device.
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Create templates to use for recurring jobs

Introduction

When you regularly carry out identical copy or scan jobs, you can create custom templates for
them. The custom templates contain the default settings for these jobs.

Procedure
1. Touch [Jobs] -> [Copy/Scan].
2. Select an existing copy or scan job template.
3. Make the required settings for the recurring job.
4. Touch [Save as template] to save the settings to a custom template.
5. Enter the name of the custom template and touch [OKI.
6. Press [Cancell.

The custom template is now available at [Jobs] -> [Copy/Scan].
7. To edit the template, touch the custom template for 2 seconds.

You can now select the following options.

* [Renamel.

* [Movel.
Touch a blue line in front of a template to indicate the new location.
The location of the [Last used] template is set.

» [Delete]

NOTE
Touch the [Last used] template for 2 seconds to save the settings of the last job to a template.
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Combine subsets into one file

Introduction

You can copy or scan several sets of originals to one document or file with subsets. With the

optional [Page programming] function, you can add pages, for example, tab sheets, and define

the media and finishing settings for each page and subset.

Procedure

1

&

8.

9.
10.

Place the first subset face up into the ADF or face down on the glass plate.
Touch [Jobs] -> [Copy/Scan] -> Scan profile -> [Subsets]
Define the subset settings for both [Original] and [File].

NOTE

Some settings that you define for the first subset apply to the whole job, the [Type] and
[Resolution] settings, for example. These settings are fixed and are grayed out after scanning the
first subset.

Press [Scanl].

Put the next subset into the automatic document feeder or on the glass plate.
Repeat the steps 3 - 5 for all other subsets.

A number indicates the order in which the subsets have been scanned.

NOTE
When you combine 1-sided and 2-sided originals, you can define whether a new subset must
continue on a new sheet or on the previous sheet.

Touch [Ready] when the last subset is scanned and processed.

A full overview of all the scanned subsets appears in the right-hand pane. If required, you can
add, insert, delete or edit subsets.

If required, use the optional [Page programming] function to insert pages and define the media
and finishing settings per page range.

Touch [Ready] again to close the [Page programming] function.

Press
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Optimize the Scan Quality

Introduction

The printer can detect photos, rasters and fine lines on the original. This information is processed
in such a way that the digital result has a high scan quality. This means that in most cases you do
not need to adjust quality settings to get the best result.

Problems and Solutions

Overview of possible scan problems and solutions

All the pages are upside
down

Every second page is up-
side down

All the pages are posi-
tioned sideways

The information on the
page is too large or too
small

The information on the

page is too light or too dark

You placed the originals in the wrong direction into the automatic
document feeder (ADF) or on the glass plate.

Make sure the originals are placed correctly and scan the originals
again.

The [Original typel] and [Size] settings that you selected do not cor-
respond with the orientation of the information on the originals.
Select the correct [Original type] and [Size] settings and scan the
originals again.

There is more than one explanation for this problem.

« Wrong orientation selected.

» Original feed direction confused with the orientation of the in-
formation on the original.

» The application you use does not process the TIFF/PDF file in
the right way.

Select the correct [Original type] and [Size] settings and scan the
originals again. If the problem remains, the application you use
can be the cause of the problem. Check the results in another ap-
plication.

This problem can occur when the size of the original and the selec-
ted size of the target scan are not the same. The problem can also

be caused by a (manual) change in the zoom factor.

Check the size of the [Originall and the [File] on the operator panel
and scan the originals again.

You can change the [Exposure] settings to influence the result.

Place the originals face up into the ADF, or place one original face down on the glass plate.

From the [Image type] setting, select the correct type of original ([Photol, [Text] or [Mixed])

Procedure
1.
2. On the control panel, touch [Jobs] -> [Copy/Scan].
3. Select a scan profile.
4. Define the settings for the [Original]
5.
6. Define the settings for the [File].
7. Select [Exposure].
8.

Select the desired value to change the settings for the [Light] and [Darklareas on the scan.

[Light]: When the area must be darker, then select a value of -1 to -3. When an area on the output
is light gray but must be white, then select a value of 1 to 3.
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[Dark]: When an area on the output is dark gray but must be black, then select a value of -1 to -3.
When the area must be lighter, then select a value of 1to 3.
9. Press [OK].
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The DocBox Function

Introduction to the DocBox Function

Introduction

&

DocBox is short for Document Box. The DocBox function, which is available through the operator
panel, creates a buffer between the preparation of a job, for example page programming, and the
printing of the job. The DocBox supports the operator by offering comprehensive means to store,
group, edit and reprint documents. These editing options are a subset of the PRISMAprepare job
preparation software.

A DocBox can contain the following jobs:
e Print jobs
e Scan jobs

NOTE
In the Settings Editor, the system administrator can create as many DocBoxes as required, for
example a DocBox for each individual customer or department.

lHlustration

(= pocBox 4 DacBoxes)
@ This view shows all available DocBoxes.

| Public | Client A | clients
2 jobs, 2 new) (0 jobs, 0 new) [ t0jobs, 0 new
DocBox
L

4 DocBoxes. J Client C L

@ Schedule @ Jobs =l Trays % System

[56] The starting page for DocBox jobs

When to Use the DocBox

For example:

* To carry out advanced job preparation actions.

» To correct settings when the proof print is not correct, for example change the print quality or
layout of a document.
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* To combine analogue documents with digital documents.
* To store jobs that must be reprinted regularly, for examples reports or books.
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Create a New DocBox

lHlustration

Doctio name  ——
/ P enabled =
™ —
Confiem PIN —

B S T

[67] Create a DocBox

Procedure

NOTE
Only the System Administrator is allowed to create a new DocBox in the Settings Editor.

Open your web browser and enter the host name or IP address of the PRISMAsync controller.
Log on to the Settings Editor as System Administrator.

Select [Workflow] -> [DocBoxl.

Click [Add].

Enter a new DocBox name. Identical DocBoxes are not allowed.

If you want to secure the new DocBox with a PIN, set [PIN enabled] to [Yes] and enter a PIN to
secure the DocBox.

Each time you access this DocBox through the operator panel, you must enter this PIN.
Confirm the PIN.

8. Click [OK].

I

N
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Handle the Jobs in a DocBox

Overview of the Available Settings for DocBox Jobs

Introduction

When you select a job in a DocBox and touch [Properties], the current settings of the selected job

are displayed. Below, the available settings are described.

NOTE

Depending on the type of job you want to edit, either a print job or scan job, some settings
cannot be changed. When a setting cannot be changed, the setting is greyed out.

lllustration

Output

1-or 2-sided

[ Properties

A

To DocBox 4

{[30b

User: localuser
Pages: 1
Submitted:
Duration: 0:01
Label: Copy job

Nov 28, 2013 11:36:43 AM

Number of sets

1

Job name Separator sheets
To DocBox 4 Off
Print range

Al

Binding edge

Cover

1

|:| a4, 100 g/m?, TopColor,

White

@

& 0 =
1-sided Portrait left Off
Off
a Shift
I
= <4
()
Top left Front: 0, 0,0
Back: 0, 0, 0
Print delivery Margin erase Adjust image Color/Black & white
&
b7 =4 9 o
Stacker/stapler upp... 0,0 Default Colar
0,0
Binding Folding Trimming Punching
: & | 8
Method: Mone Folding: Mone None Punching: None

LN e~

Page
programming

®

0K ‘ Cancel ‘

fmbor e bsmpion

The [Original] pane shows the settings you can de-

1

[Originall

[Output]

[Jobs]

fine for the paper originals

The [Output] pane shows the generic settings you

can define for the whole job

The [Jobs] pane shows the settings you can define

for the job

Canon varioPRINT 135 Series
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mbor e bsmpion

4 Preview

5 Action buttons

[1- or 2-sided]

The preview displays the settings you defined for
the output.

The action buttons indicate the actions you can car-
ry out.

With the optional [Page programming] function,
you can insert pages and define the media and fin-
ishing settings for the page ranges in a job.

Soing s owain

[1- or 2-sided]

L

[1-sided]

[2-sided]

The output contains an image on one side.

The output contains an image on both sides.
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[Binding edgel

Soing ———aws —owain

[Binding edgel = * The original has a vertical format (height >
[::| width).
» The binding edge is at the left-hand side.
[Portrait left] + When you turn a sheet over the binding
edge, the image or text on the back of the
sheet is in readable form.
|_| « The original has a vertical format (height >
|2| width).
* The binding edge is at the top.
[Portrait top] .

When you turn a sheet over the binding
edge, the image or text on the back of the
sheet is in readable form.

» The original has a horizontal format (width >
(&3 height).

» The binding edge of the original is at the
[Landscape left] left-hand side.
* When you turn a sheet over the binding
edge, the image or text on the back of the
sheet is in readable form.

[_] « The original has a horizontal format (width >
[2] height).
* The binding edge of the original is at the
[Landscape top] top.
* When you turn a sheet over the binding
edge, the image or text on the back side of
the sheet is in readable form.

[Medial

Soing ———Naws —owaien

Names of the media in Here you can select the media for the job. The

the media catalogue list displays all the media that are available in
the media catalog including the temporary me-
dia. The media catalog is a list of media that
you can define in the Settings Editor.

NOTE

You can only change to media with
the same size, for example, from A4
blue to A4 green.

[Media]
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[Cover]

Soing ———awes —Dmeion

[Cover] E{i=”

[Front]
[Media]

[Print sides]

[Back]
[Media]

[Print sides]

Touch the button to toggle between [On] and
[Off]l. When [Front] is [On] then the [Medial
setting below [Front] becomes enabled.

When [Front] is [On], you can select a media
from the media catalog to use as front cover.

When [Front] is [On], you can indicate which
side of the front cover must be printed. You
can select.

« [Both sides]

* [Front side]

» [Back side]

* [Nonel

Touch the button to toggle between [On] and
[Offl. When [Back] is [On] then the [Media] set-
ting below [Back] becomes enabled.

When [Back] is [On], you can select a media
from the media catalogue to use as back cover.

When [Back] is [On], you can indicate which
side of the back cover must be printed. You
can select:

« [Both sides]

* [Front side]

» [Back side]

* [Nonel
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[Layout]

Soing Vs omain

[Layout] E= The machine prints the pages with no special lay-
out settings.

L

[Normal]
p- The machine prints the pages in booklet order. The
E = pages one and four are printed on the front side of
a sheet. The pages two and three are printed on
[Booklet] the back side of a sheet.
Es The machine prints the same image multiple times
E_l next to each other. By default, the system keeps

the size of the originals.

[Same up] When you copy A4/LTR originals with the setting
[Same up] and [Images per sheet] is two, the ma-
chine will automatically print the job on A3/ 11" x
17", for example. When you cut the A3/ 11"x 17"
sheets in two, you get two identical A4/ LTR cop-
ies of your document. To reduce your A4/LTR orig-
inals to A5/STMT prints, you can use the zoom
function or select another media type.

The machine prints multiple consecutive images

EEy
;—2 on one side of a sheet, next to each other.
[Multiple up]
e The machine prints the same image twice on one
I—-zzg side of a sheet, but one image is upside down

compared to the other.

[Same-up flipped]

[Images per sheet] Here, you can select the number of images you
want to print when you select [Same up] or [Multi-
ple upl.

[Zoom]

[Zoom] [Fit to pagel When [Fit to pagel] is [On], the image is resized so
it fits onto the page.
When [Fit to page] is [Off], the original size of the
image is maintained.

[Percent] Use the + and - buttons to reduce or enlarge the
size of the image (from 25% to 400%). The preview
pane immediately shows the results of your ac-
tion.
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[Align]

Soing ———awes —Dmein

[Align] ‘ R

[Top left]

1}

[Top center]

A

[Top right]

&

[Center left]

i
AR

[Center]

>

[Center right]

t

[Bottom left]

¥

[Bottom center]

|

[Bottom right]

An image on a sheet may be smaller than the
media size of the output, for example because
you scaled the image to 70% of its original
size. The [Align] setting allows you to indicate
the position of the image on the sheet. [Top
left] moves the image to the upper left corner
of the sheet.

[Top center] moves the image to the center at
the top of the sheet.

[Top right] moves the image to the upper right
corner of the sheet.

[Center left] moves the image to center of the
left side of the sheet.

[Center] moves the image to the center of the
sheet.

[Center right] moves the image to the center of
the right side of the sheet.

[Bottom left] moves the image to the lower left
corner of the sheet.

[Bottom center] moves the image to the center
of the bottom side of the sheet.

[Bottom right] moves the image to the lower
right corner of the sheet.
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[Shift]

Soing ———Naws—owapien

[Shift] [Margin shift] Use this setting to increase or decrease the
margin. By default, the values of the front side
and the back side are interlocked. This means
that the values for the front side and the back
side remain identical.

Widening the margin can be useful if you want
to staple or punch the output, for example.
Narrowing the margin can be useful if you do
not need additional space for stapling or
punching the output, for example.

By default, the front side and the back side are
linked §. Then the image on both sides will be
shifted the same amount. Touch § to terminate
the link and shift each side individually.

[Image shift] Use this setting to shift the image horizontally
or vertically. By default, the values of the front
side and the back side are interlocked. This
means that the values for the front side and
the back side remain identical.

By default, the front side and the back side are
linked §. Then the image on both sides will be
shifted the same amount. Touch § to terminate
the link and shift each side individually.
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[Print delivery]

Soing s owin

[Print delivery] 1 [Output location] Select the output location for the job. Depend-
ing on the settings for your copy job, the ma-
chine automatically suggests the preferred
output location for your job. However, you can
manually overrule this suggestion.

» [Stacker/stapler upper tray]
Deliver the prints at the upper tray of the
stacker/stapler.

» [Stacker/stapler lower tray]
Deliver the prints at the lower tray of the
stacker/stapler.

» [Stacker/stapler booklet tray]
Deliver the prints at the booklet tray of the
stacker/stapler.

* [Folder main tray]
Deliver the folded prints to the tray at the
bottom of the folder.

[Sort]
1111
[By page]
The output is sorted by page.
[ _Jn
123
[By set]
The output is sorted by set.

[Offset stacking] This setting is only available when the [Offset
stacking] setting is set to [Sets (as in job)] in
the workflow profile.

"

=

e

p—
[Each set]
Each set delivered to an output location will
have a small shift on top of the previous set.
This makes it easier to recognize individual
sets.

=

=

=

[
[Off]
All the sets or jobs that get to an output loca-
tion are stacked in a straight stack.

[Advanced settings] It may only be necessary to change the ad-

vanced settings when an offline finisher pro-
cesses sheets in a non-standard way. Please
refer to the finisher manuals for more informa-
tion.
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Soivg s omaien

[Print delivery] 2

[Sheet order]

[Sheet orientation]

=

123
[Face upl
Deliver the prints face up, first sheet on top.

w’;
N
-

[Face up reverse]
Deliver the prints face up, last sheet on top.

=

12

[Face down]
Deliver the prints face down, first sheet on top.

321

[Face down reverse]
Deliver the prints face down, last sheet on top.

=

s

[Header up LEF]
Deliver the prints with the header on top side
and in portrait position (vertical).

<>

[Header up SEF]
Deliver the prints with the header on top side
and in landscape position (horizontal).

¥

[Header down LEF]
Deliver the prints with the header at the bot-
tom side and in portrait position (vertical).

&

[Header down SEF]

Deliver the prints with the header at the bot-
tom side and in landscape position (horizon-
tal).
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Soimg ——awes o

[Print delivery] 3 [Print order] « [Front/back]
Default value. The front page on the front,
the back page on the back.
« [Back/front]
Puts the front page on the back and the back
page on the front.

[Rotation] - [0 degrees]
» [180 degrees]
Rotates the prints 180 degrees.

[Margin erase]

) [Binding edge] Margins of a document sometimes contain notes

— or punch holes, for example. The machine allows
. you to hide these elements on the copy. With the +
[Margin erase] and - buttons of the [Binding edge] setting you can

define how much margin of the original you want
to erase. You can enter a value up to 100 mm /

3.94".
[Exposure]
Seting __Vahos Do
[Exposure] [Dark] You can adjust the settings for light areas and dark

areas on the print separately.

* When an area on the output must be darker,
then select a value of -1 to -3.

* When the area must be lighter, then select a val-
ue of 1to 3.

[Light] * When the area must be darker, then select a val-
ue of -1 to -3.
* When an area on the output must be lighter,
then select a value of 1to 3.
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[Print quality]

Soing s owapien

[Print quality] 1

[Brightness] (default
0)

[Contrast] (default 0)

[Advanced settings]

[Fattening] (default
[Off])

[Minimum line width]
(default [On])

When your prints are too dark or too light,
changing the brightness can correct this prob-
lem.

-1 to -3 creates darker prints.

+1 to +3 creates lighter prints.

When the difference between light and dark
areas of a print is not big enough, you can
change the contrast to correct this problem.
Example: When a blue text is displayed ras-
tered, you can increase the contrast to make
the text more black and sharper.

The advanced settings are intended for special
print jobs, such as printing bar codes or print-
ing a color image on a B/W printer.

The fattening function can increase the reada-
bility of texts with small fonts (< 6 points, 6/72
inch).

However, when you print special data such as
bar codes, fattening can make bar codes diffi-
cult to read. Therefore, you can turn the fatten-
ing function off when you print such special
data.

The minimum line width function is required
to keep thin lines visible. The lines in PS/PDF
jobs always keep a minimum width of 1/600
inch.

However, when you print special data such as
CAD drawings, smaller lines may be required.
Therefore, you can turn the minimum line
width function off. Then even thinner lines will
be printed.
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Soimg s omaien

[Print quality] 2 [RIP resolution] (de- The RIP resolution can improve the readability
fault [600x2400] dpi) of fine details. When you print very thin, slan-
ted lines, for example in Chinese characters,
1200x1200 gives the best result. 600x2400 is
best suited for mainly horizontal and vertical
objects.

[RIP raster] (default The default raster is [LINE_200LPI]. This is best

[LINE_200LPI]) suited for over 95% of all prints. In special ca-
ses, for example moiré patterns from scanned
images, you can try to improve the print result
with the [DOT_200LPI] raster or even the
[DOT_125LPI] raster. However, then you may
loose some fine details.
The raster screen for PS/PDF jobs is
[LINE_200LPI]. All raster screens are compati-
ble with resolutions of 600x2400 dpi and
1200x1200 dpi.

[Color profile] (default You can use color profiles when you print col-
[Normal]) or images on a B&W printer. The selected col-
or profile determines how a color image is re-
produced in black and white.
» [Enhanced] is a color profile developed by
Océ that converts CMYK or RGB data into
different gray values in a contrast-balanced
way. When you select [Enhanced], the im-
ages will become lighter, softer and less
contrast-rich.
* [Normal] is a color profile developed by
Adobe® that converts color data into gray
values. When you select [Normal], the im-
ages will become darker and more contrast-
rich.

NOTE

You can also use your own color
profiles. Make the required settings
in the Settings Editor.
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[Binding]

Soing Ve omaien

[Binding]

[Folding]

[None]

(2=
[1 staple]

=
(&=

[2 staples]

[Saddle stitching]

Here you can define the required number of sta-
ples. Furthermore you can define where you want
the staples with the [Location] option.

The available locations for one staple:

o [Top left]

* [Top right]

» [Bottom left]

+ [Bottom right]

The available locations for two staples:
« [Left edgel

* [Top edgel

« [Bottom edge]

* [Right edgel

Check the preview for the result of the selection.

This option is only available when you have a folding unit connected.
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[Folding] F
'~

[None]
Required output location for Z-folded A4R, Let-
terR and Legal:
* Folder output tray, or
* Any output tray of the stacker/stapler.
[Z-fold] NOTE

Z-folded A3, B4 and Tabloid 11" x 17"
sheets must be sent to the stacker/
stapler.

Required output location for Z-folded A3, B4
and Tabloid 11" x 17": Any output tray of the
stacker/stapler.

[Z-fold large sheets
only]

Required output location: Folder output tray

[Tri-fold in]

Required output location: Folder output tray

[Tri-fold out]

Required output location: Folder output tray

[Parallel fold]

[Print method] Use the [Print method] option to define on
which side to print:
* [Print inside]
 [Print outside]

Check the preview for the result of the selec-
tion.

[Trimming]

This option is only available when you have a trimming unit connected.
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Soing s Dmeion

[Trimming] [Nonel No trimming of the document.
8 You can indicate the amount of trimming at
. the long edge and short edge (from 2.0 mm to
' 20.0 mm /0.08" - 0.80")
[Trim size]
You can indicate the size of the resulting docu-

ment after trimming. You can either touch
[Size] to select a default media size or manual-
[Finishing sizel ly define the width and length of the docu-
ment. When you define a non-standard media
size, the [Size] box displays [Custom].

[Punching]

This option is only available when you have a punching unit connected.

Soing ————Nawsomapin

[Punching] ,—| Here you can select the required number and

: the location of the punch holes.
e Location:

[None] . [Left]
n * [Topl

 [Right]

T * [Bottom]

[2 holes]

[3 holes]

LA A Rl

[4 holes]

et

[Die set dependent]
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[Number of sets]

Soing ——awes —Dmepin

[Number of sets] [Check first set] When the [Check first set] setting is enabled,
the printer stops after the first set of a job has
been printed. You can check the quality of the

output.
NOTE
This setting is only available when in
the workflow profile [Check first set]
is set to [As in job].
[Number of sets] You can indicate how many copies of the job

you need. You can enter a value from 1 -
65,000. The default value is 1.

[Job name]
Soting Vs Desrpion
[Job namel To identify your job more easily, you can change

the name of the job. When you touch the [Job
name] button a keyboard appears. Then you can
change the name of the job.

[Page range]

Soing ———awes —Dmeion

[Page rangel [All] When [All] is selected, all pages of the job will
be printed.
[Page rangel When [Page range] is selected, use the [From]

and [To] fields to indicate the first and last pa-
ges you want printed.

[Separator sheets]

[Separator sheets] [On] When the [Separator sheets] setting is ena-
bled, a separate sheet is inserted automatically
before each set of a job to create a clear dis-
tinction between two sets. Separator sheets
are always empty. In the Settings Editor, select
a media from the media catalog use as separa-
tor sheets. You can also indicate the feed di-
rection of the separator sheets (long-edge feed
or short-edge feed).

[Off] No separator sheet will be inserted before
each set.
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Edit a Job in a DocBox

lllustration

I | T |
:;,'l,,,,f, —
e Page programming
[Ce—a—
Originals - .:Ir: % 1{_ ‘ k i
Pages: 2 Add Delete Merge Select

Submitted: Jul 22, 2011 8:52:32 AM

D 021 Finshing Subset Pages Media
Labet  (Defaul) il ——
v L 24Dy 800
Output

1- or 2-sided Binding edge Wedia

[

2-sided Portrat left Normal A4
Layout Zoom Align Shift
) A
AN ki
Normal 100% Center Front: 0, 0,0
Back 0, 0,0
Print delivery Margin erase Folding
1 o L
Stackeristapler upper 0,0 Foiding: None
tray 0
Binding Trimming Continue
&8 0 B8
Method: None None On previous sheet ~F
Location: No staple

[58] Use page programming

Add

. Current selection: 1 - 1

|:| Hormal A4
24D, 50 gim, White

[59] Add a page

Chapter 9 - Use the DocBox (Option) 299
Canon varioPRINT 135 Series



Edit a Job in a DocBox

Procedure
1. On the control panel, touch [Jobs] -> [DocBoxl.
2. Touch the DocBox that contains the job you want to edit.
3. Touch the job you want to edit.
4. Touch [Properties], or double-tap the job to open the [Properties] window.
5. If you want to carry out extended page programming, touch [Page programming].
6. Change the required settings.
7. Press [OK].
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Combine Jobs in a DocBox (Build Function)

Introduction

You can combine a job in a DocBox with other jobs from the same DocBox. The system creates a
new job from the selected jobs. The % icon indicates a built job.

lllustration

Build(job 2) B Number of sets

Operator

% Check first set

Media

Sheets | Media

2 |:| #4403, 80 gfm?, Plain paper, White

Submitted

%] job2 19, 2012
localuser A:’ne:zqm

Apr 19, 2012

job 1
localuser 2:06:21PM

[60] The [Create build] window

Procedure

1.  On the control panel, touch [Jobs] -> [DocBox].

Touch the DocBox that contains the jobs you want to combine.

3. Touch the jobs you want to combine, or use an option from the [Select] menu to select multiple
jobs at once.

4. Touch the [Build] button or select [Build] from the drop-down menu.
A [Create build] window appears that allows you to make some changes.

5. If necessary, use the [Up] and [Down] buttons to change the job order.

If necessary, change the generic job settings, such as [Number of sets].
7. Press [OK].

N

o
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Split a Combined Job in the DocBox

Introduction

You can split a combined job in the DocBox into the original separate jobs. Then the system
restores the jobs with their original settings and status. You cannot split a combined job in the list
of Waiting jobs.

NOTE
You can only split a job when the job is not locked. Otherwise, you must unlock the job first.

Procedure

1. On the control panel, touch [Jobs] -> [DocBoxl.

Touch the DocBox that contains the job you want to split.

Touch the job you want to split.

Touch the [Split] button, or select [Split] from the drop-down menu.
The DocBox displays the original jobs.

Ll
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Introduction

The DocBox allows you to lock the settings of your jobs. Advantages:
» Settings cannot be changed accidentally.

+ The job is always printed exactly the same.

lllustration

Lock a Job in a DocBox

Public 5% i
= =
o7 X . R B 4
Properties Delete Unlock Select Print now Proof Print
Job Submitted Duration Used media
Move
Copy job 10 May 8, 2012
[ octietr e 0:01 % a4, 80 gjmz, Plain
paper, White
Build
% Ticket
Lock
unlock
M
@ Schedule ‘ Jobs =] Trays {%} System

[61] Select [Lock].

Procedure

1.  On the control panel, touch [Jobs] -> [DocBox].
. Touch the DocBox that contains the job you want to lock.
3.

Touch one or more jobs that you want to lock, or use an option from the [Select] menu to select
multiple jobs at once.
4. From the drop-down menu, select [Lock].

% indicates that the job is locked.
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Unlock a Job in a DocBox

Introduction

Unlocking a job can be required if you want to split a locked, combined job into the original jobs,
for example.

Illustration

Public
e~ (=h
0o X v 5 o ET &
Properties Delete Lock Select Print now Proof Print
Job Submitted Duration Used media
Move
i job 10
ps ”3?;‘;;62“# o:01 % 43, 80 gjmz, Plain
paper, Whits
Build
1 Ticket
Lock
unlock
b d
@ Schedule ‘ Jobs =/ Trays {%}. System

[62] Select [Unlock].

Procedure
1. On the control panel, touch [Jobs] -> [DocBoxl.
2. Touch the DocBox that contains the job you want to unlock.
3. Touch the job that you want to unlock.
4. From the drop-down menu, select [Unlock].
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Move a Job from One DocBox to Another

lllustration

[63] Move a DocBox job

Procedure

On the control panel, touch [Jobs] -> [DocBox].

Touch the DocBox button that contains the job you want to move.
Touch the job you want to move.

Touch the [Movel] button, or select [Move] from the drop-down menu.
Touch the destination.

Press [OK].

2B
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Print the Jobs in a DocBox

Print a Non-Urgent Job from the DocBox

Introduction

You can print jobs from the DocBox in two ways:

* Without urgency
The system sends the print job to the bottom of the list of [Scheduled jobs].

* With urgency (immediately)
The system sends the print job to the top of the list of [Scheduled jobs]. The job currently
active is put on hold.

Procedure

1. On the control panel, touch [Jobs] -> [DocBoxl.

2. Touch the DocBox that contains the job you want to print.
3. Touch the desired job.

4. Touch [Print] to print the non-urgent job.
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Print an Urgent Job from the DocBox Immediately

Introduction

You can print jobs from the DocBox in two ways:

* Without urgency
The system sends the print job to the bottom of the list of [Scheduled jobs].

* With urgency (immediately)
The system sends the print job to the top of the list of [Scheduled jobs]. The job currently
active is put on hold.

Procedure
1. On the control panel, touch [Jobs] -> [DocBox].
2. Touch the DocBox that contains the job you want to print.
3. Touch the desired job.
4. Touch [Print now] to print the urgent job immediately.
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Select and Print Multiple Jobs from the DocBox

Introduction

When you want to print one job in a DocBox you can select and print that job. However, you can
also select multiple jobs at a time. The table below shows the available options.

Select multiple jobs

[All] Select all the jobs from the active DocBox.

[Jobs with available media] These are the jobs for which the required media are cur-
rently available in the paper trays.

[Jobs with label] These are the jobs that have a label. A label is a name
that helps you to identify certain jobs on the operator
panel, for example the name of a customer. The label
can be defined in the printer driver, in a job ticket or via
an automated workflow. For example, the label ‘Custom-
er XYZ' can be added to jobs. Then you can select and
print all the jobs for 'Customer XYZ' at once.

[Printed jobs] These are the jobs that have already been printed be-
fore.

[New jobs] These are the jobs that have not been printed yet.

Manually Touch the required jobs one by one

lHlustration

r e Delete Build Select Print now Proof Print
Job - Used media
s AN
[ ‘o2 s -
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4 DocBoxes: ‘

! a4y, 0 g, e

(N Invert selection

Jobs with available media

[S;l Jobs with label

i Printed jobs

Hew jobs
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@ Schedule Lﬂ Jobs |=I| Trays % System

[64] Select multiple jobs
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Procedure

On the control panel, touch [Jobs] -> [DocBox].

Touch the DocBox that contains the jobs you want to print.
Touch the [Select] button.

From the drop-down menu, select the required option.
Press [Print].

apwbd=
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Introduction to the Removable Hard Disk

Introduction to the Removable Hard Disk

Introduction

The PRISMAsync controller can be equipped with a removable hard disk. The removable hard
disk is located behind the horizontal cover in front of the control panel.

@ IMPORTANT

Avoid installing the machine at high altitudes above approximately 3,000 meters above sea
level, or higher.

Machines with a hard disk may not operate properly when used at high altitudes above
approximately 3,000 meters above sea level, or higher.

Illustration

TENT

[65] Location of the removable hard disk

Using the Removable Hard Disk

The removable hard disk is intended to prevent the theft of confidential data. After working hours,
for example, the hard disk can be removed from the controller and stored in a safe. The next
working day, the hard disk must be placed back before the printer is turned on.

A lock in front of the removable hard disk prevents unauthorized removal of the hard disk. For
security reasons, only a limited number of people will have a key to the lock.

Each removable hard disk is unique. Always use the same dedicated removable hard disk with a
particular printer.
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Main Parts

lHlustration

I

L

[66] Main parts of the removable hard disk

P omein

1 Hard disk

2 Hard disk housing
3 Right-hand handle
4 Left-hand latch
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Remove the Removable Hard Disk

Before you begin
Shut down the printer completely.

Wait until the Sleep button and the On/Off button are off.

Remove the removable hard disk

1 Open the cover (1) in front of the oper- N
ator panel.
2 Remove the staple box (2).
3 Remove the lock (3). @
4 Press the left-hand latch (1) of the hard S—
disk housing. The right-hand handle (2)
is released.
5 Pull the right-hand handle to slide out S—
the removable hard disk. §
6 Place the staple box back.
7 Close the cover.
8 Store the hard disk in a secure place,

for example a safe.
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Insert the Removable Hard Disk

Before you begin

Make sure that the printer is completely off before you insert the removable hard disk.

1

Take the removable hard disk
from the secure location where it
is stored.

Open the cover in front of the op-
erator panel.

Remove the staple box.

Slide the removable hard disk in. S—
Make sure that you push the

hard disk itself. Do not use the

right-hand handle to slide the

hard disk in.

When the hard disk is completely S—
inserted, close the right-hand

handle (1).

A click confirms that the right-

hand handle is locked correctly

behind the left-hand latch (2).

— 11

Place the lock (1).

Place the staple box (2) back.

Close the cover (3). @

N e

Canon varioPRINT 135 Series
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Insert the Removable Hard Disk

9 Press the On/Off button to turn
the printer on.
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Troubleshooting

Troubleshooting

e

You turn the printer on while the removable The printer operator panel displays an error

hard disk is not inserted message.
Press the On/Off button behind the printer
operator panel for approximately 5 seconds.
The printer will shut down.

* Insert the correct hard disk for this printer.

* Press the On/Off button to turn on the print-
er.

You turn the printer on while the hard disk of a
different printer is inserted

NOTE
Do not insert other hard disks or hard disks without the correct varioPRINT 135 Series software.
The printer will not function correctly.
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Remote Service

Remote Service

Introduction

NOTE

Remote Service requires a license. Remote Service also requires a permission to an Canon site
outside the customer domain, either via a proxy server or via IP white list. Contact your local IT
specialist to give you the permission.

Remote Service is an application that runs on a printer or a separate server in the customer's
network. Remote Service requires a working Internet connection to establish a secure connection
between the customer's site and Canon. In case a proxy server is present, Remote Service must
be configured correctly.

Remote Service has the following functionality:

Remote Diagnostics When a customer contacts Canon in case of a problem, Canon can
automatically retrieve service related data from the printer for
analysis and troubleshooting. With these data, Canon can quickly
identify the source of the problem and possibly solve the problem
via the telephone.

Remote Meter Reading With this function counter information that is needed for billing
can be automatically sent to Canon on a regular basis. Then the
customer does not need to collect the metre readings manually
and send these to Canon. The customer can always check the sent
data and approve the meter readings.
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Remote Software Upgrade = With this function, the customer can update the printer with the
latest software. The software is only retrieved from Canon when
the customer wants this.

From release 3.3 onwards, the jobs on the system are not deleted
after you upgraded the software.

lllustration

Key operator settings

Connectivity output

7 | Remote connection

L[]

; when tray s ful
Remote connection status Mot connected

Remote connection enabled
Remote Service country code Other

Remote Service custom country code NONE

I
4]

Test Remote connection Test

System settings
Operator panel settings
Close
Shut down system

e Schedule ‘ Jobs ‘ = Trays H % System

Using Remote Service

In the Settings Editor, all settings for the customer's proxy server must be set correctly
([Configuration] -> [Connectivity] -> [Proxy server]).

Via the control panel, the remote connection must be enabled ([System] -> [Setup] ->[Local key
operator settings] -> [Remote connection] -> [Remote connection enabled] -> [Yes]).

Via the control panel, you can test the remote connection ([System] -> [Setup] ->[Local key
operator settings] -> [Remote connection] -> [Test Remote connection]).

The test can take up to 30 seconds. When the connection is not OK, a message indicates the
reason for the failure.

The dashboard of the control panel displays a red icon (see figure) when the printer becomes
disconnected from the Internet. Make sure the connection is online, because otherwise Canon
cannot retrieve data from your printer.

If required, you can change a number of connectivity settings via the control panel ([System] ->
[Setup] ->[Local key operator settings] -> [Connectivity]).

You can verify the communication with Canon by downloading the audit log files via the
Settings Editor ([Support] -> [Logging] > [Save the log files of the remote service connection]).
The Settings Editor keeps up to four audit log files. Each log file can contain maximum 10 Mb
of data. When all 4 files are full, the first file is overwritten. You can open the audit log files
with any text editing application.
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Remote Monitor

Remote Monitor

Description

NOTE
Remote Monitor requires a license.

Remote Monitor is a web application that you can access via a URL from a remote PC. The
application shows part of the operator panel with up-to-date status information, for example
about how long the printer can continue printing without operator intervention.

Remote Monitor also has an alert function. The Remote Monitor window will automatically pop
up on your PC monitor when the printer status changes from ‘running' (attention light is green) to
'stopped' (attention light is red) or 'going to stop' (attention light is orange).

For confidentiality reasons, Remote Monitor does not display job information.

Specifications

Remote Monitor specifications
URL to access Remote Monitor

Recommended resolution of your
computer screen

Supported web browsers

Language

Update frequency
Time line

Printer information displayed

http://<printername or IP address>/remoteinfo
https://<printername or IP address>/remoteinfo

Minimum 640 x 480 pixels

Microsoft® Internet Explorer® 7 and higher
Mozilla Firefox® 3 and higher

Google Chrome™

Apple Safari®

As defined in your browser, as long as the printer sup-
ports this language

Every 5 seconds

Fixed (30 minutes)

Host name

System mode
Status panel
Attention light
Operator instruction
Time line
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With PRISMAsync Remote Manager you can monitor printers, operate printers remotely and send
jobs and ready-to-print documents to the printer queues of all configured printers. You must
enable and configure PRISMAsync Remote Manager in the Settings Editor.

Refer to the user manual for the PRISMAsync Remote Manager for the options available when
using this product.
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Introduction to the Counters

Introduction to the Counters

Description

The following table describes the counters in the [Maintenance] section of the [System] view.

Counter information

[Billing counters] The [Billing counters] display the total number of normal and large
prints that have been made since the printer was installed. A service
technician can configure the billing counters displayed. You cannot re-
set the billing counters.

[Day counters] The [Day counters] display the number of normal (A4/Letter-like) and
large (A3/Tabloid-like) prints that have been made since the counter
was last reset to 0. You can reset the day counters at the beginning of a
working day or before you start a new job for a specific customer, for
example.

NOTE

The [Billing counters] and the [Day counters] provide information about the number of one-sided
and two-sided prints that have been made on normal and large media. The length of the media
determines whether a media is normal or large. Media with a length of less than 364 mm (14.3")
are referred to and counted as normal media, for example A4/Letter. Media with a length of 364
mm (14.3") or more are referred to and counted as large media, for example A3/Tabloid.
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Reset the Day Counters

lllustration

o Maintenance

Start maintenance ﬂ

Go to the service mode 0[?

ofi Counters

1) serialnumber: 1234567890
Counters

illng counters Day counters
112 Total (Black/Large) 0 0

113 Total (Black/Small} 0 0

Reset day counters ]

Print billing counters report ‘E‘

@ Schedule @ Jobs = Trays %}, System

Procedure

1.  On the control panel, touch [System] -> [Maintenance] -> [Reset day counters].
A dialog box will ask you to confirm that you really want to reset the day counters.
2. Touch [Yes] to reset the day counters to 0.
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Print the Billing Counters Report

Introduction

You can print a report that contains all figures of the configured billing counters. The language of
the billing counters report is the same as the selected language for the system.

Illustration

afi Maintenance

Start maintenance ﬁ?

Go to the service mode Tr

ufi Counters

i‘ Serial number: 1234557830

Counters

Billing counters Day counters

112 Total (Black/Large) o 0
112 Total (Black/Small) o 0
Reset day counters it i

Print biling counters report B

@ Schedule Jobs =l Trays % System

[67] Print the billing counters report

Procedure

1. On the control panel, touch [System] -> [Maintenance] -> [Print billing counters report].
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General Information

General Information

Introduction to the Accounting Function

Introduction

NOTE
Accounting requires a license. Contact your local authorized dealer for more information.

Basics

The accounting function is meant to charge the costs for print, copy and scan jobs to customers
or users.

Below, the basics of accounting are described. Detailed information about the accounting
function is described in separate chapters.

Mandatory:

To use the accounting function, a license file must be uploaded to the PRISMAsync controller
first. Then the account log file is created too.

For each job, the account log file stores job information such as type of job and account ID, if
applicable. To calculate the costs, you can download the account log files via the Settings
Editor.

Optional:

If you want to distinguish jobs for various customers, you must use account IDs. An account ID
is a number that is unique for a certain customer. To be able to enter account IDs, you must set
the [Identification enabled] setting in the Settings Editor to [Yes]. From now on, each job
requires an account ID. However, any ID entered is considered valid. Jobs with an account ID
can be recognized by a $ on the job icon.

On the control panel, the [Account ID] and the [Accounting mode] buttons become available.
Optional:

If you want to make sure that only predefined account IDs are accepted, you must set the
[Verification enabled] setting in the Settings Editor to [Yes] and upload an account ID file to the
PRISMAsync controller. The account ID file (‘accid.csv') must contain account related
information, but at least account IDs.

Now the PRISMAsync controller checks whether an account ID entered on the control panel is
predefined in the account ID file. When you enter a non-valid account ID for a job, the control
panel displays the message [Invalid account ID. Enter a valid account ID.]. You must enter a
valid account ID to continue with this job.

NOTE
In the Settings Editor, navigate to [Configuration] -> [Accounting] for all accounting settings.
Only key operators or system administrators can perform actions in the [Accounting] section.
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The Accounting Related Settings in the Settings Editor

Description

NOTE
Accounting requires a license. Contact your local authorized dealer for more information.

The table below describes the available accounting related settings in the Settings Editor
(navigate to [Configuration] -> [Accounting]).

The accounting related settings

[Save account log files] You can save the account log files to a location on your
PC or network to create invoices for customers, for ex-
ample.

[Upload account ID file] [Upload a file with account IDs to make sure that submit-

ted print jobs will only be printed when they have a valid
account ID. To use this functionality, verification of ac-
count IDs must be activated.]

[Download account ID file] [Download the file with account IDs from the system, for
example to update the file with new IDs.]

[Default account ID for streaming [Use this setting to define the default account ID that is
jobs] used when the system processes streaming jobs.]
[Identification enabled] [Enable this setting if every job which is printed/copied

on the system must have an account ID.]

[Verification enabled] [Enable this setting if the account ID of every job must
be verified. For this verification, an account ID file must
be uploaded to the system.]

[Account field separator] This setting allows you to select the character used in
the account log files to separate the information. You
can select [Use ;' (semi-colon)] or [Use ',' (comma)]l.

[UTF-8 header enabled] This settings allows you to indicate that the account log
files must be encoded in UTF-8.

Chapter 15 - Accounting 333
Canon varioPRINT 135 Series



Enable the Identification and Verification of Account IDs

Enable the Identification and Verification of Account IDs

Introduction

NOTE
Accounting requires a license. Contact your local authorized dealer for more information.

To be able to enter account IDs for jobs, the [Identification enabled] setting in the Settings Editor
must be set to [Yes].

If you want to make sure that the PRISMAsync controller accepts only predefined account IDs, the
[Verification enabled] setting in the Settings Editor must be set to [Yes] too. Then an account ID
file is required too.

NOTE
You can only enable the verification function when the identification function was enabled first.

Procedure

1.
2.
3.
4.
&

NOTE

System administrators only.

Access the Settings Editor.

Click [Configuration] -> [Accounting].

To enable the identification function, click [Identification enabled] -> [Yes] -> [OK].
To enable the verification function, click [Verification enabled] -> [Yes] -> [OK].

NOTE

When both the [Identification enabled] and the [Verification enabled] settings in the Settings
Editor are set to [Yes], the control panel displays the account name that corresponds to the
account ID as defined in the 'accid.csv' file. When no account name is defined, the control panel
displays the account ID.
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The Account ID File

The Account ID File

Introduction

NOTE
Accounting requires a license. Contact your local authorized dealer for more information.

All account related information, such as account IDs and account names, is stored in an account
ID file (‘accid.csv'). You can download this file via the Settings Editor to add, edit or delete
account information. You can enter a maximum of 2,000 account IDs. Make sure that each
account ID is unique.

L@ NOTE

The first row of the account ID file contains header information. Do not change or delete this
row.

The content of the Account ID File

The account ID file contains 4 columns with the account information. Only the first two columns
<recordid> and <accountid> are mandatory. Filling in the other columns is optional.

The content of the account ID file

<recordid> All accounts, starting in row two, must have the ID 4313.

<accountid> This column contains the IDs (maximum 40 characters) that will be
checked for validity when [Verification enabled] is set to [Yes].

NOTE
You can only enter 12 digits on the control panel.

<accountname> This column contains the account name (maximum 40 characters)
that corresponds with the account ID in the second column.
When you enter an account ID and [Verification enabled] is set to
[Yes], the control panel displays the name that corresponds with
the account ID. When no name is defined in the account ID file, the
control panel displays the account ID.

<comment> This column is a free text field (maximum 255 characters) where
you can enter additional information about an account, for exam-
ple the maximum monthly print volume. This information is not
displayed on the control panel.
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Download, Edit and Upload the Account ID File

Procedure

I

7.
8.

9.

NOTE
Accounting requires a license. Contact your local authorized dealer for more information.

In the Settings Editor, click [Configuration] -> [Accounting].

Click [Download account ID filel.

Click the link to the 'accid.csVv' file.

Click [Savel.

Browse to the location where you want to save the file, then click [Savel].

Using Microsoft® Excel®, for example, you can now add, edit, or delete account IDs from the file,
then click [Savel].

In the Settings Editor, click [Configuration] -> [Accounting].

Click [Upload account ID filel.

Browse to the location of the changed 'accid.csv' file.

10. Select the required file and click '‘Open’.
11. Click [Upload account ID file].
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The Account Log File

The Account Log File

The Name of an Account Log File

NOTE
Accounting requires a license. Contact your local authorized dealer for more information.

An account log file has the following name format:
<serialnumber><yyyy><mm><dd><extension>, for example 012345678920120115.CSV.

I =

<serialnumber> The serial number of the device.
This number is a text string with a maximum length of 10 characters
(A-Z, a-z, 0-9). The serial number is provided by the PRISMAsync con-
troller at the moment the account log file is created.

<yyyy><mm><dd> The year, month and day the account log file was created.

<extension> The file extension, either .CSV (Comma Separated Values) for inactive
log files, or .ACL (ACtive Log) for the active log file.
For the current day, the file has the extension .ACL. At midnight,
the .ACL file is converted into a .CSV file.
The PRISMAsync controller can store a maximum of 99 .CSV files +
1.ACL file. When the limit is reached, the oldest .CSV file is removed.
You can retrieve the account log files from the Settings Editor ([Config-
uration] -> [Accounting] -> [Save account log files]) and import the files
into Microsoft® Excel, for example.

Data Records

An account log file consists of data records. The data records contain information about the use
of the varioPRINT 135 Series. For each job, a new data record is added to the current account log
file.

The first record of an account log file is the header record. The header record always starts with
4302. Every subsequent data record starts with 4303. These records contain the actual accounting
information for each job.

The Fields of an Account Log File

The following table describes the fields of each data record in an account log file.

<recordtype> 4303 A number that identifies a data record.
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<documentid> A text string with a max- A unique identification for a job or document,
imum length of 40 char- which is supplied by the submitter of the job. The
acters document ID is extracted from the print data, for ex-
ample the attribute 'documentid’ in an OJT. This
field keeps the same value when the job is submit-
ted multiple times. The field is empty when the at-
tribute is not available.

<jobid> A number The PRISMAsync controller creates a unique job
identification number when:
* A new print job is received
* A new copy or scan job is started
* An existing job is started from the mailbox
* An existing job is moved from the [Printed jobs]
section to the [Waiting jobs] section

NOTE
The term mailbox is understood to in-
clude the list of [Waiting jobs] and the

[DocBoxl.
<jobtype> Possible entries: Describes the type of job.
« COPY * COPY: Direct copy job
« |IP » |P: Interactive print job (a job that was printed
« AP from the mailbox).
« SYSTEM « AP: Automatic print job (a job that was directly
« SCAN printed from the network, not from the mailbox)
« SCAN2MBX + SYSTEM: A test print that was started in the serv-
« MBXCOPY ice mode or service copy mode.

+ SCAN: A scan-to-file job.

+ SCAN2MBX: A job that was scanned to the mail-
box.

+ MBXCOPY: A copy job that was printed from the
mailbox.

NOTE

The term mailbox is understood to in-
clude the list of [Waiting jobs] and the
[DocBox].

<startdate> <yyyy>-<mm>-<dd> The date on which the printer started printing the
job. Typically, this is the first moment that a job can

NOTE be interrupted or stopped via the control panel.

When you
open the file
in Microsoft®
Excel, the date
format
changes into
the date for-
mat that is de-
fined in Micro-
soft® Excel

338 Chapter 15 - Accounting
Canon varioPRINT 135 Series



The Account Log File

<starttime>

<activetime>

<idletime>

<readydate>
<readytime>

<result>

<username>

<jobname>

<costcentre>

<custom>

<hh>:<mm>:<ss>

NOTE

When you
open the file
in Microsoft®
Excel, the time
format
changes into
the time for-
mat that is de-
fined in Micro-
soft® Excel

<hh>:<mm>:<ss>

<hh>:<mm>:<ss>

<yyyy>-<mm>-<dd>
<hh>:<mm>:<ss>

Possible entries:
* Done
e Abrt
« Stop

A text string with a max-
imum length of 255
characters

A text string with a max-
imum length of 255
characters

A text string with a max-
imum length of 40 char-
acters

A text string with a max-
imum length of 255
characters

The time on which the printer started printing the
job. Typically, this is the first moment that a job can
be interrupted or stopped via the control panel.

The total time the job is active and actually printing.
Hours can exceed 24.

The total time the job is active, but waits for an ac-
tion by the operator, such as clearing an error or
loading the required media. Hours can exceed 24.

The date on which the job was finished or aborted.
The time the job was finished or aborted.

Information about how the job was completed.

* Done: The job was finished correctly.

» Abrt: The operator or the PRISMAsync controller
stopped or aborted the job, for example in case
of an error.

» Stop: The job was stopped by the user and
moved to the [Waiting jobs] section. When the
job is restarted or continued later, multiple ac-
count records will be generated for this job.

The user name that is defined for the job, for exam-
ple in the attribute 'username' in an OJT.

The name of the job for automatic or interactive
print jobs and scan jobs, for example in the attrib-
ute 'jobname' in an OJT. For scan jobs, the gener-
ated file name is used.

The name of a department or user as defined in the
[Cost center] field of the [Account] tab of the printer
driver or in the attribute 'GroupName' in an OJT.
This field is empty when the attribute is not availa-
ble

Information as defined in the [Custom] field of the
[Account] tab of the printer driver or in the attribute
‘custom’ in an OJT, for example.

This field is empty when the attribute is not availa-
ble

Canon varioPRINT 135 Series
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<accountid>

<jobaddressee>

<nofscana4>

<nofscana3>

<nofsinglesta-
ples>

<nofdoublesta-
ples>

<noffinished-
sets>

<outputdestina-
tion>

<nofprinte-
dadbw>

<nofprinte-
dadc>

<nofprinte-
da3bw>

<nofprinte-
da3c>

<tonerblack>

<tonercolor>

A text string with a max- The account ID as defined in the [Account ID] field
imum length of 40 char- = of the [Account] tab of the printer driver, or on the
acters control panel, or in the attribute 'accountid' in an
OJT, for example.
This field is empty when the attribute is not availa-

ble
A text string with a max- The name of the recipient of the print job. The
imum length of 255 name is extracted from the print data, for example
characters the attribute 'jobaddressee' in an OJT.
A number The number of scanned A4-like sheets, including

custom sized sheets of which at least one dimen-
sion is equal to or less than 2567 mm/ 10.1".

A number The number of scanned A3-like sheets, including
custom sized sheets of which all dimensions are
larger than 257 mm / 10.1".

A number The number of times that a single staple was used
in a job.

NOTE
This number does not include the staples
from an off-line stapler.

A number The number of times that double staples were used
in a job.

NOTE
This number does not include the staples
from an off-line stapler.

A number The number of finished sets. A set is finished after
the last sheet is sent to the output location.

Names of output loca- A descriptive name of the output location. The ex-
tions act names vary per product and depend on the con-
figuration of the product.

A number The number of printed A4-like sheets (copy jobs or
print jobs) printed in B&W. Inserts will be counted
as B&W too.

A number The number of printed A4-like sheets (copy jobs or

print jobs) printed in color.

A number The number of printed A3-like sheets (copy jobs or
print jobs) printed in B&W. Inserts will be counted
as B&W too.

A number The number of printed A3-like sheets (copy jobs or

print jobs) printed in color.

Value in milligrams The estimated total usage of black toner for sheets
that are printed or copied in B&W.

Value in milligrams The estimated total usage of toner for sheets that
are printed or copied in color.
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<nofsim-
plex>(1-16)*

<nofdu-
plex>(1-16)*

<mediafor-
mat>(1-16)*

<medi-
atype>(1-16)*

<media-
weight>(1-16)*

<mediacol-
or>(1-16)*

<media-
name>(1-16)*

<cycle-
length>(1-16)*

<isin-
sert>(1-16)*

<istab>(1-16)*

<punch-
count>(1-16)*

<nofpunches>

<noffolds>

A number

A number

A text string with a max-
imum length of 255
characters

A text string with a max-
imum length of 40 char-
acters. Some entries are
standardized:

« PLAIN

 TRANS

- COVER

- MYPAPER

+ COLOR_COPY

» COATED

« OTHER

A number

A text string with a max-
imum length of 40 char-
acters

A text string with a max-
imum length of 40 char-
acters

A number

Yes or no ('y' or 'n')

Yes or no ('y' or 'n')

A number

A number

A number

The number of 1-sided sheets of a certain paper
type used in a job.

The number of 2-sided sheets of a certain paper
type used in a job.

The media size used for the job. Not every product
supports all media sizes.

Description of the media types used.

* PLAIN: normal paper

* TRANS: transparencies

* COVER: a special front or back page

« MYPAPER: a special media type that must be
placed in a paper tray before starting the job, and
that must be removed from that paper tray as
soon as the job is ready.

* COLOR_COPY: color copy paper

* COATED: coated media

* OTHER: unspecified media. This is used when
custom strings are not available.

The weight of the media type in grams per m2 or Ib.

The color of the media used for the job.

The name of the media used for the job.

If subsequent sheets are not identical (cyclic me-
dia), the cycle length indicates after how many
sheets the same sequence starts again. For normal
media the cycle length is 1. For cyclic media with an
unknown cycle length, the cycle length is 0.

A media attribute that indicates whether the bit-
maps are printed on this media (y) or not (n).

An insert sheet can be 1-sided or 2-sided. The bit-
maps corresponding to insert sheets typically are
still part of the print job. Selection of insert media
enforces that these bitmaps are not printed (again)
on the insert media.

This is a media attribute that indicates whether the
media is tab media. Typically, tab media has a cycle
length of 1, but this is not mandatory

The number of punch holes of the prepunched me-
dia.

The number of punched sheets in a job.

The number of folded sheets in a job.

Canon varioPRINT 135 Series
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<nofbooklets> = A number The number of booklets in a job.
<nofbinds> A number The number of bound sets in a job.
NOTE

* All fields that contain (1-16) will be included 16 times in an account log file. Each number refers
to the type of media (1 up to 16) that is used. The media characteristics of the first media type in
a job are logged in the fields ending on '1'. The characteristics of the next, different media type
are logged in the fields ending with '2' and so on. For example, <mediatype2> and
<mediaweight2> both correspond to the second type of media used in a job. If you use less than
16 media types, the remaining fields are empty. If you use more than 16 media types, they are
logged as if they were media type 16. The maximum number of media types per job is 16.
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Save an Account Log File

Procedure

NOTE

Accounting requires a license. Contact your local authorized dealer for more information.
In the Settings Editor, click [Configuration] -> [Accounting].

Click [Save account log files].

Click the link to the required file, then click [Savel].

Browse to the location where you want to save the file, then click [Savel.

N =
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Use Accounting

Select an Accounting Mode

Introduction

NOTE
Accounting requires a license. Contact your local authorized dealer for more information.

When the [Identification enabled] setting in the Settings Editor is set to [Yes], the accounting
function becomes available on the control panel. In the [Accounting mode] setting on the control
panel, you can select when an account ID must be entered. The table below describes the
options.

The accounting modes

e ==

[Per job] Each job requires an account ID. You can enter a new ac-
count ID for each job. By default, the control panel dis-
plays the account ID used for the previous job. However,
you can change the account ID displayed.

[Per job(Clear account ID)] Each job requires an account ID. You must enter a new
account ID for each job. The system clears the account
ID used for the previous job. Therefore, the [Account ID]
field in the [Job] pane is empty before the next job.
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Setting Description

[Fixed] The same account ID is used for all jobs until you select
[Change account ID] or [Clear account ID] under [Sys-
tem] -> [Setup] -> [Accounting] to terminate the fixed ac-
count ID currently in use.

When you use a fixed account ID, the [Account ID] field
in the [Job] pane is grayed out.

NOTE

The [Fixed] setting overrules account IDs that
are indicated in applications or printer drivers.
Therefore, select another accounting mode be-
fore printing jobs that were submitted from an
application or printer driver.

lllustration

[68] Select an accounting mode

Procedure
1. On the control panel, touch [System] -> [Setup] -> [Accounting].
2. Press [Accounting mode].
3. Select the desired setting.
4. Press [OK].
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Enter an Account ID per Job

Introduction

NOTE
Accounting requires a license. Contact your local authorized dealer for more information.

When the [Identification enabled] setting in the Settings Editor is set to [Yes], the accounting
function becomes available on the control panel. The description below applies to entering an
account ID on the control panel when the [Accounting mode] is set to [Per job(Clear account ID)].

E ‘ D:|
[T Copy job
1-or 2-sided Original type Size Image type Number of sets Job name Separator sheets
Copy job 1 off
& v & ®
Destination ! Account D
Auto: 1-sided Auto: Portrait eft e Mixed Scheduled jobs
1-or 2-sided Binding edge Media Cover
& & 0 = (« |
Auto: 1-sided Auto: Portrait left Auto: off
A4 off
Layout Zoom Align Shift B —
p R _—
o < —
Q % —
Normal Fit to page: 100% Auto: Top left Front: 0,0, 0 —
Back: 0, 0,0
Print delivery Margin erase Exposure j—
1 ¢ V4 —
Auto: Stacker/stapler 0,0 Dark: 0 pr—
upper tray 0,0 Light: 0
Binding Folding Trimming —
3 B E%
Lo Al =N
Method: None Folding: None None
Location: No staple ! Enter the account ID.
Minimize | Cancel Subsets ‘

[69] The [Account ID] field in the [Job] pane

Procedure

1. On the control panel, touch the [Account ID] button in the [Job] pane of print, copy and scan jobs.
A numerical keyboard appears.

2. Enter the account ID for the current job (1 - 12 digits).
Use the "C" button to correct a wrong entry.

3. Press [OK].
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Enter an Account ID in the Printer Driver

Before you begin

&

NOTE
Accounting requires a license. Contact your local authorized dealer for more information.

To use the accounting function in the printer driver the [Enable accounting] setting in the
[Properties] of the printer driver must be enabled.

In Microsoft® Windows® XP, for example, you must click Start -> Settings -> Printers and Faxes ->
right-click your printer -> [Properties] -> tab that shows the name of your printer, to enable
accounting.

NOTE

The fixed account ID as defined on the operator panel overrules the account ID that is defined in
the printer driver. Therefore, make sure that you cancel the fixed account ID before you print the
job from the [Waiting jobs] section on the operator panel.

Procedure

oorLbd =

~

In your application, click 'File' -> 'Print'.

If more printers are available, select the required printer from the list.

Click [Properties].

Click [Account].

Enter the [Account ID].

Optionally, you can enter the name of the [Cost center] and any additional information in the
[Custom] field.

Click [OK].

NOTE

When the [Verification enabled] setting in the Settings Editor is set to [Yes], automatic print jobs
that do not have a valid account ID are automatically placed in the [Waiting jobs] section. You
must enter a valid account ID to print the jobs.
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Check the Status of the Toner Reservoir

Check the Status of the Toner Reservoir

Introduction

This section describes the following:
* Warnings when the toner level is low.
* Where to find the current filling level of the toner reservoir.

Toner Low Warnings

When the toner level is low, and toner is required, you will get the following warnings:

20% + Dashboard: Orange warning icon, and a corresponding mes-
sage.
» Operator attention light: Orange lamp lights up.

0% + Dashboard: Red warning icon, and a corresponding message.
* Operator attention light: Red lamp lights up.

Procedure

1. On the control panel, touch [System] -> [Printer].
The [Supplies] pane displays the current filling level.

off Supplies [ Finishers

Toner Stacker/stapler
Status ftem Status.

. Lower tray: stapler 1 0 staples used since last refl

Perfect Binder
ftem Status.

Glue container oK

@ Schedule [A] Jobs (= Trays &, system

[70] Check the status of the toner reservoir
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Add Toner

Introduction

When the control panel indicates that you must add toner, then you can add maximum two
bottles of toner. Add the toner according to the instructions.

Only use genuine Canon toner to get the best print quality.

Canon varioPRINT 135 Series Canon varioPRINT 135 Series Toner Black

c CAUTION
« Handle toner bottles carefully.

Do not burn or throw used toner bottles into open flames, because this can ignite toner
residuals inside the toner bottles, which can cause burns or start a fire.

Do not store toner bottles in places exposed to open flames, because this can ignite the
toner, which can cause burns or start a fire.

If you accidentally spill or scatter toner, then carefully collect the toner particles or wipe them
up using a soft, damp cloth in a way that prevents inhalation. If you use a vacuum cleaner to
clean up spilled toner, only use a vacuum cleaner that has safeguards against dust
explosions. The use of a vacuum cleaner without these safeguards can result in a malfunction
of the vacuum cleaner, or a dust explosion due to static discharge.

Keep toner out of reach of children. If toner is ingested, consult a physician immediately.
Avoid breathing dust.

Only use toner in environments with adequate ventilation.

@ IMPORTANT

Only use toner bottles that are intended for use with this printer.

Be aware that there are counterfeit Canon toners are available on the market. The use of
counterfeit toners can result in a poor print quality or machine performance. Canon is not
responsible for any malfunction, accident or damage caused by the use of counterfeit toner.
For more information, see http://www.canon.com/counterfeit.

Store toner bottles in a cool and dry location, away from direct sunlight. It is recommended to
store the toner at a temperature below 30 °C (86 °F) and a relative humidity below 80%.

Do not store toner bottles in an upright position.

Do not add more toner than described in the table below.

Before you use the toner bottle, shake the closed toner bottle well.

Maximum Amount of Toner to Be Added

Add toner

= 100% The toner reservoir is filled for more than 60%.
P Do not add toner.

. 60% The toner reservoir is filled for 20%-60%.
Py Do not add more than one bottle of toner.
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[ <l 20% The toner reservoir is filled for less than 20%. The printer
A can print another 600 sheets.
Add maximum two bottles of toner as soon as possible.
0% The toner reservoir is empty. The printer stops.
e Add maximum two bottles of toner immediately to re-

sume printing.

How to add toner

@ IMPORTANT
Only add toner when the printer is ON.

Procedure
1. Open the cover of the toner reservoir in front of the control panel.
2. Put the toner bottle upside down into the toner reservoir.
3. Pull the slide to the right.
4. Wait until the toner bottle stops shaking, then push the slide to the left.
5. Remove the toner bottle.
6. Close the cover of the toner reservoir.
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Check the Status of the Staple Cartridges

Introduction

The stacker/stapler can contain the following staplers:

* One stapler that can add one or two staples to non-booklet prints. These prints are delivered to
the upper or lower output tray.

* One stapler that can add two staples to booklets. These booklets are delivered to the booklet
tray.
This stapler is only available when the stacker/stapler is equipped with the optional saddle
stitch unit.

When all the staple cartridges are sufficiently filled, the staple icon in the dashboard is blue.
When the staple icon in the dashboard is orange or red, one of the staple cartridges is empty or
almost empty. You must refill the staple cartridge as soon as possible.

To find out which staple cartridge is empty or almost empty, you must go to the [Printer] section
of the [System] view. The icon for the staple cartridge that must be refilled is orange or red.

Z@ NOTE

Even when the staple icon is blue, you can still go to the [System] view to check the number of
staples that has been used since the last refill.

The Colors of the Staple Icon

The colors of the staple icon

A blue staple icon indicates that all the staple cartridges contain suffi-
&= cient staples.

An orange staple icon indicates that one of the staple cartridges is al-

= most empty.
A red staple icon indicates that one of the staple cartridges is empty.
The printer stops when a job requires staples from the empty staple
cartridge.
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Illustration

[ Finishers
Stacker/stapler

Status ftem Status.

100% . Stapler waste box Absent
. Lower tray: stapler 1 0 staples used snce last ref

Perfect Binder

ttem Status.

. Trimmer waste box Absent
Glue container 0K

@ Schedule @ Jobs = Trays % System

[71]1 Check the status of the staple cartridges

Procedure

1. Check the staple icon in the dashboard.
2. When the staple icon is orange or red, go to the [Printer] section of the [System] view to check
which staple cartridge must be refilled.
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Replace the Staple Cartridge of the Stapler Unit

Introduction

When a staple cartridge of the stapler unit inside the stacker/stapler is empty, the control panel
will display a message indicating which staple cartridge must be replaced. The procedure below
describes how to replace the staple cartridge.

Required tools

Staple N1

Replace the staple cartridge of the stapler unit

Illustration

1 Open the front door of the stacker/stapler.

2 Grab the green tab of the staple case and
pull the staple case out of the staple unit.

NOTE

When the stapler unit is at the
back and it is difficult to pull out
the staple case, turn the dial at
the bottom left-hand side to the
left to move the stapler unit.

3 Pull out the staple cartridge.
4 Insert the new staple cartridge (Staple
N1).

Chapter 16 - Add Toner and Staples 355
Canon varioPRINT 135 Series



Replace the Staple Cartridge of the Stapler Unit

5 Gently push the staple case as far as pos-
sible into the stapler unit until the staple
case is securely in place.

6 Pull out the stapler waste box. The stapler
waste box is located below the stapler
unit.

7 Caution: Do not touch the staple waste.

Empty the stapler waste box into a com-
mon dustbin.

8 Put the stapler waste box back into place.

9 Caution: When you close the front door of
the stacker/stapler, be careful not to get
your fingers caught, because this may re-
sult in personal injury.

Close the front door of the stacker/stapler.
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Replace the Staple Cartridge of the Saddle Stitch Unit

Introduction

When a staple cartridge of the saddle stitch unit of the optional Saddle Finisher-AF2 is almost
empty, the control panel will display a message indicating which staple cartridge must be
replaced. The procedure below describes how to replace the staple cartridge.

NOTE
This procedure is only necessary when the Saddle Finisher-AF2 is attached.

Required tools

Staple P1

Replace the staple cartridge of the saddle stitch unit

\
{
|

I

1 Open the front door of the stacker/stapler. | 3

| i

s <y s

<<

2 Pull out the saddle stitch unit.

3 Grab the tab of the staple case and pull
the staple case out of the staple unit.

4 Hold the cover of the staple case by its
left and right sides
Lift the cover and slide the cover off.
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5

Squeeze at the indicated positions to re-
lease the empty staple cartridge.

Lift the empty staple cartridge and pull
the staple cartridge out.

Insert the new staple cartridge (Staple
P1).

NOTE

When you replace the staple
cartridges, replace both the
front and back staple cartridges.

Return the staple case to its original posi-
tion in the saddle stitch unit.

Make sure that the arrow on the staple
case aligns with the arrow on the saddle
stitch unit.

/@ NOTE

Follow the steps 3to 7 to re-
place the other staple cartridge
in the saddle stitch unit.

Gently push the saddle stitch unit back in-
to the printer.

Caution: When you close the front door of
the stacker/stapler, be careful not to get
your fingers caught, because this may re-
sult in personal injury.

Close the front door of the stacker/stapler.
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Clean the Scanner Sensors

Clean the Scanner Sensors

When to do

When copies contain stains.
Required tools
Soft tissue

Clean the scanner sensors

e Joswn 0 fWeam ]

1 [Open the main cover.]

2 [Use a tissue to clean the scanner sensor.] i [ pm—_
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3 [Open the white plate.] / e,

=3

4 [Open the lower right-hand guide.]

5 [Use a tissue to clean the scanner sensor.]
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L

6 [Close the lower right-hand guide.]
7 [Close the white plate.]
9 [Close the main cover.]
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Clean the Z Sensor

When to do

In case of error code 16718.

Required tools

Soft tissue.

Clean the Z sensor

1 [Open the front door.]
2 [Use handle 3 to slide out the transport
unit.]

Canon varioPRINT 135 Series
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3 [Use handle 4 to open the turn unit.]
4 [Use handle 5 to open the flap.]
5 [Use a tissue to clean the sensor and the

sensor box on the inner side.]

6 [Close the flap.]
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7 [Use handle 4 to close the turn unit.]

8 [Use handle 3 to slide the transport unit
back.]

9 [Close the front door.]
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Manually Start a Drum Cleaning

Introduction

The cleaning procedure consists of the following steps:
* The drum cools down. The control panel indicates the time required.
* The drum is cleaned automatically. You cannot interrupt this action.

When to do

When the prints contain dots.

Procedure

1. On the control panel, touch [System] -> [Maintenance] -> [Start maintenance] -> [Clean the drum]
-> [Start].

2. [Enter the maintenance PIN.]

3. Follow the instructions on the control panel.
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Automatic Drum Cleaning

Introduction

&

The imaging drum inside the machine can get contaminated with glue spots. Glue spots on the
drum can affect the print quality. Possible causes of the glue spots:

* The use of recycled media, or

* Worapper glue residues on one or more sheets of paper.

The machine contains a sensor that can detect glue spots. When the [Automatic drum cleaning]
setting is enabled, and spots are detected, an automatic drum cleaning procedure will take place.

NOTE

When automatic drum cleaning is enabled, the cleaning will not take place before the first
detection of glue spots. If you want to clean the drum immediately, you must start the manual
drum cleaning procedure via the control panel ([System] -> [Maintenance] -> [Start maintenance]
-> [Clean the drum] -> [Start]).

Precautions

Some contamination of the drum cannot be excluded completely, but you can take precautions to
limit the possibility of contamination.

Advice:

* Open the wrapper very carefully, using a knife or scissors.

* Remove the top and bottom sheets of the paper package before you load the paper into a
paper tray.

» Use paper from a box.

Settings for Automatic Drum Cleaning

The control panel contains the following settings with regard to automatic drum cleaning.

[Automatic drum cleaning] Here you can enable or disable the automatic drum cleaning func-
tion.
When the setting is disabled, the drum is not cleaned automatical-
ly. The settings described below in this table are grayed out on the
control panel.
If the setting is enabled, the sensor will frequently check the drum
for glue spots ([Glue detection intervall). If necessary, the auto-
matic drum cleaning procedure is performed. The three settings
described below in this table are active.
Possible values:
+ [On]
+ [Off]

Factory default value: [Off].

NOTE
The drum cleaning can take a couple of minutes. The
control panel provides feedback.
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[Glue detection intervall You can indicate the interval, in number of sides, after which the
drum sensor checks the drum for glue spots. A lower value means
that the sensor checks the drum more often. The frequency of the
occurrence of glue spots depends highly on the media used.
Possible values:

* [20 sides]
 [50 sides]
» [100 sides]
+ [200 sides]
- [350 sides]

Factory default value: [350 sides].

NOTE

A side is not necessarily equal to a sheet. A side is based
on an image on A4/LTR-like media. An image is anything
that is printed on one side of A4/LTR-like media. Below,
you can find an example of the conversion for the [20
sides] value.

At lower intervals, the productivity can decrease.

* When A4/LTR is printed one-sided, then 20 sides = 20 sheets.

* When A4/LTR is printed two-sided, then 20 sides = 10 sheets.

* When A3/Tabloid is printed one-sided, then 20 sides = 10
sheets.

* When A3/Tabloid is printed two-sided, then 20 sides = 5 sheets.

So when you print A3/Tabloid two-sided, for example, the sensor
checks the drum after every 5 sheets printed.

[Glue detection sensitivity] = You can indicate the size of glue spots that the sensor detects. The
factory default value makes sure that only fairly large spots will be
detected. Only select a higher value when smaller glue spots must
be detected.

Possible values:
* [Normal]
 [Highl]

« [Very highl

Factory default value: [Normal].

[Resume automatically af-  You can indicate the behavior of the printer after an automatic

ter cleaning] drum cleaning took place.
Select [Yes] if you want to continue printing immediately, without
checking the output first.
Select [No] if you first want to check the prints that were made be-
fore the drum cleaning. When the drum cleaning is ready, the con-
trol panel displays a message that asks you if you want to contin-
ue. Now you can check the output.
Possible values:
e [Yesl]
* [Nol

Factory default value: [Nol.
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[Start of run detection] You can indicate if the system checks for glue pollution before the
start of a run.
Select [On] if you want the system to check for glue pollution be-
fore the start of a run.
Possible values:
+ [On]
+ [Off]

Factory default value: [Off].

NOTE
It is advised that you enable [Start of run detection] only
when you often use recycled media.

Advised settings for different types of users

Setting m User that demands high quality

Plain paper Frequent use of Plain paper Frequent use of
recycled media recycled media

[Automatic drum [On] [On] [On] [On]
cleaning]

[Glue detection [350 sides] [350 sides] [100 sides] [100 sides]
intervall

[Glue detection [Normal] [Normal] [Very highl] [Very highl]
sensitivity]

[Resume auto- [Yes] [Yes] [Yes] [Yes]
matically after

cleaning]

[Start of run de- [Off] [On] [Off] [On]
tection]

How to Change the Settings for Automatic Drum Cleaning

Procedure

1.  On the control panel, touch [System] -> [Setup] -> [Advanced media settings] (under [Advanced]).
2. Touch the [Automatic drum cleaning] button to enable the setting.

3. If required, change the values of the settings described in the table.

4. Touch [Apply] to confirm the changes.
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Introduction to Printer Operation Care (POC)

Introduction

Printer Operation Care (POC) is a concept that allows you to replace a number of parts yourself
without the help of a service technician. This saves costs and improves the productivity.

The following actions are part of the POC concept:
* Replace the separation rollers in the paper trays.
* Replace the heat exchanger foils.

* Replace the spiral cleaner.

NOTE
Removing paper from the TTF in case of a paper jam is also part of POC, because this requires
the replacement of the spiral cleaner.

Which POC actions you can carry out depends on your service contract. When a POC action is not
part of your service contract, you will get the message [Call Service] after you selected a
maintenance action.

When maintenance is required, the dashboard will display an orange or red maintenance icon.

Maintenance is required soon. It is advised to start maintenance as
soon as possible.

The maintenance icons

(1 Maintenance is required now. The printer stops. The required mainte-
nance must be carried out before you can resume printing.

CAUTION
Only trained personnel is allowed to carry out POC actions.

372

Chapter 18 - Printer Operation Care (POC)

Canon varioPRINT 135 Series



Introduction to Printer Operation Care (POC)

lllustration

Start maintenance

Go to the service mode ﬂ
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[72] Start maintenance

Assistance on Printer Operation Care

You can find more assistance on how to replace the consumables at the following places:
* On the control panel. The control panel shows and describes the required actions step by step.
* In this User Manual.
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Perform a Paper Path Registration

Perform a Paper Path Registration

Introduction

NOTE
Only trained operators who have permission to perform POC actions, and Service Technicians,
are allowed to perform the paper path registration.

The paper path registration adjusts the registration for bulk media for printer-dependent offsets.
Usually, the paper path registration is performed by a Service Technician at the installation or
after a software upgradeThe paper path registration adjustment is a machine adjustment. The
paper path registration is the basis of the media registration. The media-specific adjustment
creates a difference with the bulk registration adjustment.

When to do

&

The Service Technician must perform the paper path registration adjustment after the
replacement or disassembly of certain units.

After the trained operator replaced the heat exchanger foils, the trained operator must verify the
media registration. If the media registration is not optimal, the paper path registration adjustment
is required.

NOTE

After the bulk registration adjustment, the media-specific registration can be changed. It is
recommended to verify the media registration for the specific media. If the media registration is
not satisfactory, the media specific registration is required.

Procedure

1.

&

On the control panel, touch [System] -> [Maintenance] -> [Start maintenance] -> Printer
registration adjustment A4/Letter -> [Start].
The tray for the A4/LTR bulk media is tray 1.

NOTE
You must first perform the paper path registration adjustment for A4/LTR and after that you
must perform the paper path registration adjustment for A3/Ledger.

NOTE

When the optional bulk tray for small format is installed, make sure that bulk tray 1 contains A4
or Letter. Also, make sure that you have assigned A4 or Letter to bulk tray 1. If needed you must
adjust the size of the tray (see Adjust the Size of the optional Bulk Tray for small Format on
page 71).

Enter the maintenance PIN

WARNING
Only trained personnel is allowed to carry out POC actions.

Follow the instructions on the screen.
If the printer has not warmed up, the registration starts with warming up the printer.
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Perform a Paper Path Registration

NOTE

Make sure that the registration sheets are placed correctly in the left-hand upper corner of the
glass plate. Make sure that the registration sheet on the glass plate is not curled or has dog ears.
You can use a stack of paper to reduce the curl.

You must close the ADF / cover for each scan.

The instructions for the paper path registration are the same as the instructions for the automatic
media specific registration.

4. Repeat step 1, 2 and 3 for A3/Ledger.
The tray for the A3/Ledger bulk media is tray 3.

After you finish

If the front-to-back side registration is not satisfactory after you performed the paper path
registration, you must check the actual sheet length in the feed direction. The paper path
registration assumes nominal sheet length. If the actual sheet length differs from the nominal
sheet length, you must enter the actual sheet size (see Registration Values on page 98). If the
media registration is not correct you must perform the manual media registration for this media
(see Option 2 - Manual Media Registration Adjustment (Only Needed in Incidental Cases)on
page 95).

[@ NOTE

Previously performed media specific registration can influence the media registration for bulk
media. To verify the paper path registration, we therefore recommend to set all media specific
registration settings to 0.
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Replace the Separation Rollers

When to do

The control panel will indicate when the separation rollers of a paper tray must be replaced. The
life of separation rollers is more than 200,000 sheet separations.

Before you begin

1. Touch the paper tray button = at the right-hand side of the control panel.
2. On the control panel, touch the tray of which you want to replace the separation rollers.
3. Touch [Open] to open the tray.

Required tools
Socket wrench

New separation rollers

CAUTION
Only trained personnel is allowed to carry out POC actions.

Illustration

@/

)
&

[73] Required tools

Replace the separation rollers

e == R

1 [Turn the upper separation roller until the
roller is face up.]
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Replace the Separation Rollers

2 [Use the socket wrench to loosen the
bolt.]
3 [Remove the cover plate.]
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Replace the Separation Rollers

.

4 [Remove the 3 fixation clips.]
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Replace the Separation Rollers

5

[Remove the upper separation roller.]

[Push the lower separation roller down to
remove the middle separation roller.]

[Remove the lower separation roller.]

Canon varioPRINT 135 Series
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Replace the Separation Rollers

T

8 [Place a new lower separation roller. Turn
the roller into position.]

9 [Place a new middle separation roller.
Turn the roller into position.]

10 [Place a new upper separation roller. Turn
the roller into position.]
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Replace the Separation Rollers

11 [Place the 3 fixation clips.]
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Replace the Separation Rollers

.

12 [Place the cover plate back.]

13 [Use the socket wrench to tighten the cov-
er plate.]

14 [Turn the upper separation roller back in-

to position.]
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Replace the Separation Rollers

15 Gently close the tray. \
It is advised to push at the centre of the
tray.
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Replace the Heat Exchanger Foils

Replace the Heat Exchanger Foils

Before you begin

NOTE
This POC action is available, depending on the type of the heat exchanger foils.

1. On the control panel, touch [System] -> [Maintenance] -> [Start maintenance] -> [Replace the
heat exchanger foils] -> [Start].

2. [Enter the maintenance PIN.]

3. [Touch Next to unlock the door.]

Required tools
Socket wrench

New heat exchanger foils

CAUTION
Only trained personnel is allowed to carry out POC actions.

Illustration

[74] Required tools

Replace the heat exchanger foils

Action

1 [Open the front door.]
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Replace the Heat Exchanger Foils

2 [Use handle 3 to slide out the transport
unit.]
3 [Use handle 4 to open the turn unit.]
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Replace the Heat Exchanger Foils

4 [Remove the 2 plugs from the heat ex-
changer.]
5 [Use the socket wrench to loosen the 2

fixation pens.]
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Replace the Heat Exchanger Foils

6

7

8

[Use the red handle to remove the heat
exchanger.]

[Place the heat exchanger on a clean, flat
surface.]

[Turn the pressure plate over.]

Canon varioPRINT 135 Series
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Replace the Heat Exchanger Foils

9 [Remove the 2 heat exchanger foils.]

10 [Discard the foils into a common dustbin.]
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Replace the Heat Exchanger Foils

1 [Place the wrapper with the new foils in
the heat exchanger.]

12 [When the new foils are in place, remove

the wrapper.]
[Caution: Do not touch the foils to keep

the new foils clean.]
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Replace the Heat Exchanger Foils

13 [Turn the pressure plate back.]

14 [Place the heat exchanger back.]
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Replace the Heat Exchanger Foils

15 [Use the socket wrench to tighten the 2
fixation pens.]

NOTE
Push the fixation pens down
during the fastening.

16 [Place the 2 plugs of the heat exchanger
back.]
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Replace the Heat Exchanger Foils

17 [Use handle 4 to close the turn unit.]

18 [Use handle 3 to slide the transport unit
back.]

19 [Close the front door.]

20 Answer the question [Which heat ex-

changer foils did you put back?] with
[New] to confirm that you installed new
heat exchanger foils.

When you did not replace the heat ex-
changer foils, touch [Existing].
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Replace the Spiral Cleaner

Introduction

When the spiral cleaner is almost full, the control panel displays the orange maintenance icon.
The POC action [Replace the spiral cleaner] becomes active. The table below describes the
meaning of the maintenance icons.

The maintenance icons

o pion

Maintenance is required soon. It is advised to replace the spiral cleaner
as soon as possible. You can print about 45,000 more images before re-
placing the spiral cleaner becomes required.

§r Maintenance is required now. The printer stops. You must replace the
spiral cleaner to resume printing.

When to do

You can replace the spiral cleaner:

+ Immediately or at a convenient time soon, when you cannot wait for the printer to cool down
(for example when your printer is in use 24/7), or

* During a cold start of the printer, for example the next morning when the printer was off or in
sleep mode during the night.

NOTE

When the printer is shut down or put into sleep mode while the orange maintenance icon is
displayed, you must replace the spiral cleaner at the next start-up. Then the red maintenance
icon will be displayed.

Before you begin

1. On the control panel, touch [System] -> [Maintenance] -> [Start maintenance] -> [Replace the
spiral cleaner] -> [Start].

2. [Enter the maintenance PIN.]

3. [Touch Next to unlock the door.]
Wait until the printer is turned off.

4. Put on the heat-resistant gloves in case the machine is warm.

Required tools
Heat-resistant gloves
Socket wrench

New spiral cleaner

c CAUTION
Only trained personnel is allowed to carry out POC actions.
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Replace the Spiral Cleaner

Illustration

[75] Required tools

CAUTION
You must wear the heat-resistant gloves when you replace the spiral cleaner and the printer is

warm.

Replace the spiral cleaner

(sop et i

1 [Open the front door.]
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Replace the Spiral Cleaner

2 [Use the socket wrench to loosen the 2
fixation pens.]

3 [Turn the red handle counter-clockwise.]
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Replace the Spiral Cleaner

4 [Slide the TTF unit out of the frame.]

5 [Pinch both fixation springs.]

6 [Slide the fixation caps from the cleaner
ends.]
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Replace the Spiral Cleaner

7 [Remove the spiral cleaner from the TTF.]
[Place the spiral cleaner on the packaging
of the new cleaner.]

NOTE

[When the spiral cleaner has
cooled down, discard the clean-
er into a common dustbin.]
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Replace the Spiral Cleaner

8 [Place the new spiral cleaner in the TTF.]

YY)
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Replace the Spiral Cleaner

9 [Slide both fixation caps over the cleaner
ends until the caps click in place.]

10 Check if the spiral cleaner can rotate free-
ly.
11 [Align the TTF with the rail.]
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Replace the Spiral Cleaner

12 [Slide the TTF unit back.]

13 [Turn the red handle clockwise.]
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Replace the Spiral Cleaner

14 [Use the socket wrench to tighten the 2
fixation pens.]

15 [Close the front door.]

16 Answer the question [Which spiral clean-
er did you put back?] with [New] to con-
firm that you installed a new spiral clean-
er.

When you did not replace the spiral clean-
er, touch [Existing].
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Remove Paper from the TTF

When to do

The control panel will indicate when paper must be removed from the TTF.

Before you begin

1. When the control panel displays the message [Touch Next to unlock the door.], touch [Next].
Wait until the printer is turned off.
2. Put on the heat-resistant gloves.

Required tools
Heat-resistant gloves
Socket wrench

New spiral cleaner

f CAUTION
You must wear heat-resistant gloves.

lllustration

[76] Required tools

CAUTION
You must wear the heat-resistant gloves when you remove paper from the TTF.
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Remove Paper from the TTF

Remove paper from the TTF

1 [Open the front door.]

2 [Use the socket wrench to loosen the 2
fixation pens.]

3 [Turn the red handle counter-clockwise.]

Chapter 18 - Printer Operation Care (POC) 403
Canon varioPRINT 135 Series



Remove Paper from the TTF

4 [Slide the TTF unit out of the frame.]

5 [Pinch both fixation springs.]

6 [Slide the fixation caps from the cleaner
ends.]
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Remove Paper from the TTF

7 [Remove the spiral cleaner from the TTF.]
[Place the spiral cleaner on the packaging
of the new cleaner.]

NOTE

[When the spiral cleaner has
cooled down, discard the clean-
er into a common dustbin.]

8 [Remove paper underneath the spiral
cleaner.]
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Remove Paper from the TTF

9 [Use handle 2 to open the flap and check
for paper.]
10 [Remove sheets underneath the TTF.]
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Remove Paper from the TTF

1 [Place the new spiral cleaner in the TTF.]
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Remove Paper from the TTF

12 [Slide both fixation caps over the cleaner
ends until the caps click in place.]

13 Check if the spiral cleaner can rotate free-
ly.
14 [Align the TTF with the rail.]
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Remove Paper from the TTF

15 [Slide the TTF unit back.]

16 [Turn the red handle clockwise.]
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Remove Paper from the TTF

17 [Use the socket wrench to tighten the 2
fixation pens.]

18 [Close the front door.]

19 Answer the question [Which spiral clean-
er did you put back?] with [New] to con-
firm that you installed a new spiral clean-
er.

When you did not replace the spiral clean-
er, touch [Existingl.
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Remove Paper from the Heat Exchanger

Remove Paper from the Heat Exchanger

Required tools
Socket wrench
New heat exchanger foils

NOTE

New heat exchanger foils are only needed with certain configurations. Follow the instructions on
the screen.

Procedure

1. When the control panel displays the message [Touch Next to unlock the door.], touch [Next].
Wait until the printer is turned off.

2. Follow the instructions on the screen.
The actions displayed on the screen, depend on the type of the heat exchanger foils.
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Advanced Maintenance Actions for High Capacity
Stacker-G1

Replace the Flip Rings in the Flip Unit

When to do

Replace the four flip rings (indicated by (1) in the illustration below) when the stacking quality is
not OK or when the flip rings are worn significantly. The flip rings are located behind the front
cover.

Required tools

Four new flip rings

CAUTION

Only trained personnel is allowed to carry out this action, if supported by your service
organization.

Illustration

[77] The location of the flip rings
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Replace the Flip Rings in the Flip Unit

Replace the flip rings

1 Open the front cover. i
2 If required, rotate the flip wheel to get ac-
cess to the flip rings.
Q'

3 Put an A3/Tabloid sheet on the stack tray
to prevent parts from falling into the
stacker.
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Replace the Flip Rings in the Flip Unit

Sop heion i

4 Remove the flip rings one by one.

5 Place the new flip rings one by one.
Check if the flip rings can rotate freely.
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Replace the Flip Rings in the Flip Unit

6 Remove the sheet from the stack tray.

7 Close the front cover.
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Clear a Paper Jam in the Lower Input Paper Path of the
Registration Unit

When to do

* Avred LED lights up at the stacker control panel.

* The printer stops. The printer control panel displays the red maintenance icon [il.

» The printer control panel displays a message that indicates a paper jam in the lower input
paper path of the registration unit.

CAUTION
When the lower input paper path of the registration unit also contains jammed paper, the

printer control panel displays the red maintenance icon [il. In that case only trained personnel is
allowed to remove the jammed paper.

Illustration

| |

[78] Indication at the stacker control panel

Clear a paper jam in the lower input paper path of the registration unit

1 Open the front door.

2 Caution: When you turn the knob, be
careful not to get your fingers caught.
Turn A7 to remove the jammed paper.
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Clear a Paper Jam in the Lower Input Paper Path of the Registration Unit

3 Remove the jammed paper from A6.

4 Lift the handle to open the paper path
section.

5 Remove the jammed paper.

6 Caution: When you close the paper path
section, be careful not to get your fingers
caught.

Lower the handle to close the paper path
section.

7 Close the front door.

8 The control panel will display the mes-

sage [Did you remove all sheets from the
paper path?] Touch [Yes] to confirm that
all paper was removed.
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Clear a Paper Jam in the Registration Unit

Clear a Paper Jam in the Registration Unit

When to do

* Avred LED lights up at the stacker control panel.
* The printer stops and the printer control panel displays the red maintenance icon [il.
* The printer control panel displays a message that indicates a paper jam in the registration unit.

Required tools

Socket wrench 5.5

CAUTION
Only trained personnel is allowed to carry out this action, if supported by your service
organization.

Illustration

|

[79] Indication at the stacker control panel

Clear a paper jam in the registration unit

e = R

1 Open the top cover.
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Clear a Paper Jam in the Registration Unit

2 Open B2 to remove the jammed paper.

3 Caution: When you close the top cover,
be careful not to get your fingers caught.
Close the top cover.

4 Open the front door.
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Clear a Paper Jam in the Registration Unit

T

5 Use the socket wrench to loosen the
screw and open the cover.

6 Open the 2 retaining clips and disconnect
the flat cable.
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Clear a Paper Jam in the Registration Unit

Attention: Do not pull the flat cable.
Pull out the registration unit.

Remove any pieces of paper from the reg-
istration unit.

Place the registration unit back. The ar-
rows must be on top.

Canon varioPRINT 135 Series
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Clear a Paper Jam in the Registration Unit

Sop deion i

10 Attention: Do not twist the flat cable.
Connect the flat cable and close the 2 re-
taining clips.

11 Close the cover and use the socket
wrench to fasten the screw.

12 Close the front door.

13 The printer control panel will display the
message [Did you remove all sheets from
the paper path?]. Touch [Yes] to confirm
that all paper was removed.
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Solving Errors

Solving Errors

Introduction

The main types of possible errors are the following.
* Errors that relate to the machine
* Errors that relate to the jobs

This section gives an overview of the possible errors and the solutions to these errors.

NOTE
Only operators who received the special maintenance training are allowed to replace or clean
parts and solve paper jams in the process units.

Overview of Possible Machine Errors

Handle machine errors

m Additional information

Paper jam Follow the instructions on  After you solved the error, the machine starts
the control panel. from the point where the printing stopped due
to the error. Check for double prints.
Software error Follow the instructions on A message on the control panel will indicate
the control panel. that you must restart the machine.

Service required  Follow the instructions on A message on the control panel will indicate
the control panel. that you must contact Service or your local au-
thorized dealer.

Unit recondition- Follow the instructions on  After an error was solved, the machine checks

ing the control panel. if the print job can continue from the point
where the printing stopped. When you use cy-
clic media, you must probably remove a cou-
ple of sheets.

The system can-  Follow the instructions on  Sometimes, the system cannot determine if
not determine if  the control panel and check the output is complete. Then you must check

the output is the output. the output. Touch the [OK] button when the
complete output is complete.

The prints con- Carry out the drum clean- On the control panel, you can start this proce-
tain dots ing procedure. dure by touching [System] -> [Maintenance] ->

[Start maintenance].

A paper tray does Check if all paper trays are

not open closed correctly.

Paper jams or Make sure that the horizon-
dog ears because tal transport unit is always
the horizontal completely pushed in until

transport unitin-  locked.
side the printer is

not closed com-

pletely.
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Solving Errors

Overview of Possible Job Errors

Handle job errors

The required sup-
plies are not
available

The defined com-
bination of job
settings is not
possible

Add the required supplies
(media, toner and staples)
before the machine stops
printing.

* The controller corrects
the settings.

* You must define a cor-
rect combination of job
settings in the [Proper-
ties] section of the
[Jobs] view on the con-
trol panel.

Additional information

The dashboard helps you to determine when
the supplies are required.

The solution depends on the place where the

job settings are defined.

* When the job settings are defined in an ap-
plication or printer driver, the controller au-
tomatically corrects the settings.

* When you define the job settings on the
control panel, the control panel displays a
message that the defined combination is not
possible. The [OK] button is disabled.

Canon varioPRINT 135 Series
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Store the logging in case of software errors

Store the logging in case of software errors

Introduction

When the system has a software error, you can store the logging. Service can use this logging to
analyse the error.

Procedure

1.

% %P.‘*’N

On the control panel an error screen is visible that indicates a software error. A software error has
an error code that starts with 115. The system creates a log. This may take a few minutes. After
the creation of the log is complete, you can insert a USB drive into the USB port &8 at the left-
hand side of the control panel.

When you do not want to store the logging of the software error, you can touch the error screen
to exit the error. The system restarts.

Only non-recoverable software errors will store the error log.

Touch the USB drive button . * on the error screen.

The systems stores the logging of the error on the USB drive.

When the systems indicates that the storing is completed, remove the USB drive.

Touch the error screen to exit the error. The system restarts.

NOTE
When the system has two identical software errors after each other, you can delete all jobs. If
one or more jobs caused the software error, the system restarts without an error.

NOTE
If the system experiences three identical software errors, one after another the system reinstalls
the software upon restarting. Reinstallation will take a while.
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Upgrade PRISMAsync from server

Upgrade PRISMAsync from server

Introduction

You can update the printer with the latest PRISMAsync software that is available at the printer
dealer. The printer dealer stores the software at a server.

Before you begin

Remote Service must be available.

Procedure

NOTE
You must log in as System Administrator to upgrade the software.

1. Access the Settings Editor.
. Click [Support] -> [Software updates].
3. Inthe [PRISMAsync upgrades] section, click [Upgrade from server]. Select the available version.
When no version is visible, the printer dealer has made no version available.
After you downloaded the version, you must install this version.
5. When the upgrade is completed you must restart the system.

b
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Upgrade PRISMAsync

Upgrade PRISMAsync

Introduction

You can upgrade or downgrade the printer with the PRISMAsync software that is available on the
system.

Procedure

NOTE

You must log in as System Administrator to upgrade the software.

Access the Settings Editor.

. Click [Support] -> [Software updates].

3. Inthe section [PRISMAsync upgrades] click [Upgradel. Select the available version.
When no version is visible, the printer dealer has made no version available.

4. After you downloaded the version, you must install this version.

N =

@ NOTE
After you upgraded the software, you can downgrade to the previous installed version. In the
section [PRISMAsync upgrades] click [Downgrade].

5. You must restart the system once the the upgrade or downgrade is complete.
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Upgrade Microsoft Windows

Upgrade Microsoft Windows

Introduction

You can update the printer with the latest upgrade of Microsoft® Windows®.

Before you begin

You must download the Microsoft Windows upgrade before you can upgrade Microsoft
Windows.
Procedure

NOTE
You must log in as System Administrator to upgrade the software.

-_—

Access the Settings Editor.

Click [Support] -> [Software updates].

3. Inthe [Windows updates] section, click [Install]l. Browse to the Microsoft Windows upgrade you
downloaded.

Follow the instructions on the screen to upload the required files.

5. When the upgrade is completed you must restart the system.

N

>
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General

General

Specifications

Description Light to mid production, B&W printer / scanner / copier

Required toner Canon varioPRINT 135 Series Toner Black

Imaging technology DirectPress®; mono-component toner

Warm-up time 150-270 seconds, depending on amount of toner in cleaner

First copy time One-sided: 3.9 seconds

First print time One-sided, ripped: 5.1 seconds

Printer dimensions Excluding operator panel: 1,130 mm x 765 mm x 1,040 mm (44.5"
x 30.1" x 40.9")
Including operator panel: 1,130 mm x 765 mm x 1,430 mm (44.5" x
30.1" x 56.3")

Printer weight 263 kg (578.6 Ib)

Power requirement 1-Phase: 200-240 V, 50/60 Hz

+ USA 20 A (16 A rated)
+ USA 15 A (12 A rated)

Certificates EPA Energy Star® / TEC compliancy, RoHS, Cetecom / CE Class A,
FCC Class A, UL/ TuV/CE
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Environmental

Environmental

Ozone emis-
sions

Optimum tem-
perature

Relative humid-
ity
Altitude

Room ventila-
tion

Sound power
level

Power con-
sumption

TEC value

None (printer)

17-30 °C (62.6-86 °F), printer up to 34 °C (93.2 °F). For accessories, refer to their
specifications.

20-80%

Lower than 1,000 m (3,281 ft)

35 m3 or > 1 AC/hour for room sizes > 35 m3

Standby mode: 47.3 dB
Print mode: maximum 75.3 dB

Off mode: 0.3 W

Sleep mode: 4 W (excluding controller)

Low power mode: 210 W

Ready mode: 275 W

Operation mode (USA, LTR, 20 Ib bond, two-sided): 1.85 kW / 1.9 kW / 2.1 kW
(varioPRINT® 110/ 120 / 135 respectively)

USA, LTR, 20 Ib bond: 18.9 kWh / 20.0 kWh / 22.4 kWh (varioPRINT® 110/ 120/
135 respectively)

Canon varioPRINT 135 Series
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Printer Speed

Printer Speed

Below you find the maximum engine speeds in images per minute.

Printing, media
weight

Two-sided, less
than 120 g/m2 (32
Ib bond)

One-sided, less
than 220 g/m2 (80
Ib cover)

Two-sided, 120
g/m2- 220 g/m?2
(32 Ib bond - 80
Ib cover)

>220g/m3(80 Ib
cover)

Speed li-
cense

120
135
110
120
135
110
120
135

B5, A4 (8.5
x 11"), Ab
(5.5 x 8.5")

123
138
102
113
123
102
113
123
61

61

61

- '“
110 57 59 55

120
135
100
110
120
100
110
120
60

60

60

63
70
52
57
63
52
57
63
31
31
31

64
72
53
59
64
53
59
64
32
32
32

60
68
50
55
60
50
55
60
30
30
30
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Paper Modules

Paper Modules

Internal Paper Module

NOTE
Whenever a number of sheets is mentioned in the table below, the figure is based on media of
80 g/m2 (20 Ib bond).

Description Standard paper module

Paper trays * Bulk tray 1: 1,500 sheets (A4, JIS B5, Letter, 16K. When the bulk
tray for small format is installed also A5, Statement.)
* Bulk tray 2: 1,500 sheets (A4, JIS B5, Letter, 16K. When the bulk
tray for small format is installed also A5, Statement.)
* Multi-size tray 3: 500 sheets; 140 mm x 182 mm - 320 mm x 432
mm (5.5" x 7.2" - 12.6" x 17.0")
* Multi-size tray 4: 500 sheets; 140 mm x 182 mm - 320 mm x 488
mm (5.5" x 7.2" - 12.6" x 19.2")

Paper weight 50 - 300 g/m? (14 Ib bond - 110 |Ib cover)

Detection Automatic paper size detection (multi-size tray), tray-empty detec-
tion

Paper feed technology Friction feed

Features Paper Logic, tray linking, paper level indication, on-the-fly loading,

tab sheet processing

External Paper Module

Description Optional paper module. The bulk trays three and four can be
equipped with dual paper trays (optional).

Dimensions (WxDxH) 980 mm x 750 mm x 1,040 mm (38.6" x 29.5" x 40.9")
Weight 200 kg (441 Ib)

Power supply 90-264 V, 40-67 Hz, 200 W

Paper trays » Tray 1: 600 sheets

» Tray 2: 600 sheets
* Tray 3: 1,700 sheets; dual paper tray: 3,300 sheets (A4, LTR)
» Tray 4: 1,700 sheets; dual paper tray: 3,300 sheets (A4, LTR)

Paper size All paper trays: 203 mm x 203 mm - 320 mm x 488 mm (8.0" x 8.0"
- 12.6" x 19.2"), JIS B5 LEF, including custom sizes

Paper weight 50 - 300 g/m? (14 Ib bond - 110 |Ib cover)

Detection Automatic paper size detection, tray-empty detection, double-

sheet detection

Paper feed technology Vacuum feed, air separation
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Paper Modules

Features Paper Logic, tray linking, paper level indication, on-the-fly loading,
tab sheet processing, optional JIS B5 tool
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Media Specifications

Media Specifications

Media Types
Meds e
Transparencies Only paperbacked and printed one-sided
Tabs Yes
Self adhesives Yes
Textured paper Yes
Die cuts Yes
NCR paper On media recommended by the manufacturer
Pre-printed paper According to the manufacturer's guidelines for pre-printed media
Recycled paper On media recommended by the manufacturer

Media Weights

m Internal paper module External paper module

Plain paper 60 - 200 g/m2 (16 Ib bond -74 60 - 200 g/m2 (16 |Ib bond - 74 Ib
Ib cover) cover)

Plain paper recommended 50 - 300 g/m2 (14 1b bond - 110 50 -300 g/m?(14 1b bond- 110 Ib

by the manufacturer Ib cover) cover)
Offset media 80 - 200 g/m2 (20 Ib bond - 74 80 - 200 g/m2 (20 Ib bond - 74 Ib
Ib cover) cover)
Offset media recommen- 60 - 300 g/m2 (16 Ib bond - 110 60 - 300 g/m2 (16 Ib bond - 110 |b
ded by the manufacturer Ib cover) cover)
Coated media No* 120 - 200 g/m2(32 Ib bond - 74 Ib
cover)
Coated media recommen-  No* 80 - 300 g/m2 (20 Ib bond - 110 Ib
ded by the manufacturer cover)
NOTE

* Some coated media can be used when you install the separation enhancer.
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Printing, Copying and Scanning

Printing, Copying and Scanning

Printing
Job management DocBox, lists of [Scheduled jobs], [Waiting jobs] and [Printed jobs]
Print resolution PCL: 600 x 600 dpi
Adobe® PostScript® 3™: 1200x1200 dpi, 600x2400 dpi
Engine resolution 600x2400 dpi
Maximum printable area PCL: adjustable
Adobe® PostScript® 3™: 3 mm from side, maximum 308 mm x
484 mm (12.1" x 19")
Screen frequency PCL: 106 Ipi maximum
Adobe® PostScript® 3™: 200 Ipi maximum
Gray levels PCL: 125
Adobe® PostScript® 3™: 200
Features RIP at rated printer speed, pre-RIP, print-while-RIP-while-spool
(streaming), printing multiple sizes, hotfolders/automated work-
flows, optional transaction printing
Copying
Copy resolution 600x1200 dpi
Exposure control Auto / Manual (9-step scale), [Text], [Mixed], [Photo], [High detail]
Zoom 25-400%; automatic
Screen frequency 200 Ipi
Gray levels 200
Features Automatic quality optimization for text/photo, light/dark setting,
cover insertion, [Combined copy job], automatic rotation, booklet
printing, multiple images per sheet, margin shift, margin erase,
image position, automatic paper selection, tab copying, combina-
tion of different original sizes.
Scanning

Resolution 75, 100, 150, 200, 300 (default), 600 dpi

Pull scan Not available

Color scanning Optional license

Destination Scan to email, Scan to FTP, Scan to USB, Scan to DocBox, Scan to
SMB
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Printing, Copying and Scanning

File format PDF (single and multiple page), PDF/A, TIFF, JPEG/sRBG (colour
scanning)
Features Thumbnail preview (DocBox), scan profiles, status overview, gray

level scanning, scan once print many, scan-in-warmup, scan-
while-print, subset-scanning, multi-tasking user interface, RGB col-
or scanning
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PRISMAsync Controller

Specification

Description

Processor

Memory

Hard disk

Network connectivity

Network protocols

Operating system

Page Description Languag-
es

USB printing

Security

Features

Hardware options

PRISMAsync Controller

PRISMAsync, embedded, with optional removable hard disk. Web-
based configuration with Settings Editor.

2 GHz

2GB

Minimum 160 GB
10/100/1000 Base-T

TCP/IP (LPR/LPD, socket), SMB static/auto IP (via DHCP)
SNMP v1-v3 (printer MIB, private MIB, job monitoring MIB)
IPv4 & IPv6

Microsoft® Windows 7®

PostScript® 3, PDF 1.7, PCL 6, XPS, IPDS

PDF, PS, PCL, XPS via USB connection on operator panel

Common Criteria EAL2+, E-shredding, HTTPs, Firewall, PIN for
DocBox, User authentication to SDS, removable hard disk, IPv6

Print while RIP, streaming, multi-job processing, pre-RIP, no cycle-
down between jobs, multi-tasking (scan/copy/print), Remote meter
reading, Remote Diagnostics, remote software upgrade

Generic USB mouse support, Section 508 kit (video, attention sig-
nal), copy control device interface for accounting, operator atten-
tion light, removable hard disk, Remote Monitor
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Printer Driver Support

Printer Driver Support

prmorir e

PS3 UPD - Microsoft Windows Server 32 & 64-bit support
2003/2008/2008 R2

PS3 UPD - Microsoft Windows Client XP/Vista/ 32 & 64-bit support
Windows7

PS3 PPD - legacy Microsoft Windows & Mac/
Linux-CUPS/Other

PS3 - Macintosh (Mac OS 10.4/10.5/10.6) Intel & PowerPC
PCL6 UPD - Microsoft Windows Server 32 & 64-bit support
2003/2008/2008 R2

PCL6 UPD - Microsoft Windows Client XP/ 32 & 64-bit support

Vista/Windows 7

PCL6 GPD - legacy Microsoft Windows & Mac/
Linux-CUPS/Other

Microsoft XPS UPD - Microsoft Windows Client 32 & 64-bit support
Vista/Windows 7

SAP Device Type (SAP R/3 4.6 and higher) Implementation & support via C&SS

NOTE
All UPD drivers are Microsoft® certified
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Printer Driver Support
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